NetObjects TopPage = ===5=

User’s Guide




References in this publication to IBM products, programs, or services do not imply that IBM
intends to make these available in all countries in which IBM operates. Any reference to an
IBM product, program, or service is not intended to state or imply that only that IBM product,
program, or service may be used. Any functionally equivalent product, program, or service
that does not infringe any of the intellectual property rights of IBM may be used instead of the
IBM product, program, or service. The evaluation and verification of the operation in
conjunction with other products, except those expressly designated by IBM, are the responsibility
of the user.

IBM may have patents or pending patent applications covering subject matter in this document.
The furnishing of this document does not give you any license to these patents. You can send
inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, North Castle Drive,
Armonk, NY 10504-1785, U.S.A.

Trademarks

® TopPage is a trademark of IBM Corp.
® NetObjects is a registered trademark of NetObjects, Inc.

® Microsoft, Windows, Windows 95, Windows 98 and Windows NT are registered trademarks
of Microsoft Corporation.

o Intel is a registered trademark of Intel, Inc.

® Netscape and Netscape Navigator are registered trademarks of Netscape Communications
Corporation.

o All other trademarks are the property of their respective owners.

First Edition (July 1999)

(C) Copyright International Business Machines Corporation 1999.
All rights reserved

This User's Guide is subject to change for improvement and other purposes.

Note to U.S. Government Users—Documentation related to restricted rights—Use, duplication,
or disclosure is subject to restrictions set forth in GSA ADP Schedule Contract with IBM Corp.



Welcome

Thank you for purchasing TopPage. TopPage is an application
that allows you to create your Web pages.

You probably already know that you must use a special language
called HTML (Hypertext Markup Language) to create Web
pages. HTML tags consists of alphabetic letters and symbols.
Does that mean that a lack of special knowledge of HTML will
prevent you from creating Web pages?

The answer is No. Even if you do not know what HTML is at alll,
TopPage enables you to create your own Web pages. If you
have used a word processor, you can utilize TopPage right away,
because the operations of this application are similar to those of
a word processor.

TopPage includes convenient materials and accessory tools. If
you want to create Web pages quickly, you can use the materials
and templates attached to TopPage. If you want to create your
own original materials, you can use the accessory tools called
WebArt Designer and Web Animator.

TopPage offers both advanced functions and easy operation at
the same time. Create your own Web pages with TopPage!
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About this guide

This User's Guide explains how to use TopPage. This book is for beginners who
know at least the basic Windows operations.

(I)Note ]

Windows and items shown in this guide and those displayed on your monitor might be
different. It depends on your system.

Screen shots of a Web browser shown in this guide are taken from Microsoft Internet
Explorer 4.0 and Netscape Navigator 4.0. Information on the Internet — that is, Web
pages or Web sites — are subject to change without notice.

How this guide is organized

Each chapter and appendix contains the following information:

Chapter 1. Web pages and TopPage

This chapter introduces TopPage, explains what Web pages are, and explains which
chapter or section of this User's Guide you should read to do what you want to do.

Reading this chapter helps you to expand your imagination in creating your original
Web pages.

Chapter 2. Installing and starting TopPage

This chapter explains the system requirements, how to start and end TopPage, and
how to view online help when problems occur.

. 4
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Creating Web pages

@/ice:

Chapter 3. Tutorial: Creating your Web pages in an hour
You can create your Web pages in an hour using the templates and materials
TopPage offers. Follow the instructions in this chapter to become accustomed to
TopPage.

@m You can use templates and materials only if you have installed sample im-
ages, sample data, and templates.

Qrmediate:

Chapter 4. Basic knowledge
This chapter explains the basic knowledge and operations of TopPage. You will learn
such terms as site, Web page, and attribute.

Chapter 5. Editing text
Chapter 6. Creating tables
Chapter 7. Inserting images
Chapter 8. Setting links
Chapter 10. Creating materials
These chapters explain essential tasks for creating Web pages.

@anced:

Chapter 9. Designing Web pages using style sheets
A style sheet is a very recent technology that is likely to become essential for Web
page creation. You can use it to design your Web pages.

Chapter 11. Advanced techniques
This chapter explains such advanced techniques as the frame function, images
maps, dynamic HTML, and so on.

. 4



Uploading

Chapter 12. Uploading Web pages

This chapter explains how to upload your Web pages to your provider's server to
make them accessible on the Internet.

Other information

Chapter 13. Other functions
Appendix

Glossary

Index

TopPage User’s Guide



Chapters you should read
You do not need to read this guide from the beginning to the end. You should read
chapters 1, 2, 3, 4, and 5 in order and then go on to the chapters you are interested in.
Vocabulary

This guide explains difficult vocabulary where it first appears and in the “Glossary”.

Mouse operations

The following list shows typical mouse operations:

Symbol Meaning

Point Put the mouse pointer on the target object.

Click Point to the target object and press the left mouse button
once.

Double-click Point to the target object and press the left mouse button
twice.

Drag Move the mouse pointer while pressing the left mouse button.

Drag and drop | Move the mouse pointer while pressing the left mouse button.
Then release the mouse button at the target point.

Abbreviations

This guide uses the following abbreviations:

[ Abbreviation Formal Meaning ]
Windows Microsoft(R) Windows(R) 95, Windows 98, or Windows NT(R)
4.0




“u

Chapter

1

Web pages and
TopPage

This chapter introduces TopPage, explains what Web pages
are, and explains which chapter or section of this User’s Guide
you should read to do what you want to do. Reading this
chapter helps you to expand your imagination in creating your
original Web pages.

I.l_

*xx What are Web pages? ..........cccooeieienni. 1-2
*xx Sample Web pages ..........coceevvieininnnnnns 1-4
*** Web pages on the Internet ................... 1-10

Note: The stars (* to *%%) indicate the importance of the task. The most important tasks are marked by *%*. 1-1



What are Web pages?

You probably have seen Web pages using a Web browser. See the following sample

Web page to examine the structure of a general Web page.

1-2

This is a sample Web page.

To highlight the title,
sometimes images
are used.

title

If you click a link,
another page appears.

URL is the address
of a Web page.

D Pastial suppost of HTML 40

b QOffering and custonization of dynamie HTML

P Support of style sheets

process ing functions)

P Creating animation GIFs

“Shop  [WCogoct [Search [WPrivacy [WTegal |

Lust bioaied £ 1995.0181

image with a link

URL

i d

Tables are often used
for page layout.

Web pages can contain
GIF images or JPEG

\ [0 vy o

images.

AN

If you click an image
with a link, another
page appears.

Web browser

An application for view-
ing Web pages.
Netscape Navigator and
Microsoft Internet Ex-
plorer are well-known
Web browsers.

TopPage User’s Guide

URL

An address of a Web
page. It usually begins
with http://iwww.... Be-
cause each URL is
unique, you can access
the target URL from any-
where in the world.

link

A function to jump. If
you click text or an im-
age to which a link is
set, you jump to another
page or another place in
the same page.

e



A Web page is an HTML file
®

If you use Netscape Navigator, select Document source from the View menu. If you use
Microsoft Internet Explorer, select Source from the View menu. HTML language such as the
following sample appears.

If you open the preceding Web
page with a text editor instead of

a Web browser, you see this

. |
HTML source file. & somple.htm - Notepad =
File Edt Seach Help

<*DOCTYPE HTHL PUBLIC "-//W3C//DTD HTHL 4.8//EN">
[<HTHL>
[<HEAD>
[<HETA name="GEMERATOR" content="TopPage U4.8.2 for Windouws">
<TITLE>TopPage Sample Web Page</TITLE>
[</HEAD>
<BODY bgcolor="#FFFFFF" text="#800000" 1link="#29679e" ulink="#33660C" alink="#33
[<CENTER>
IKTABLE width="6008">
<TBODY>
. <TR>
|nd|CateS a table, <TD colspan="3" align="right"><IME src="navi.GIF'"' width="233" height="18"
</TR>

\’—/

|»

5

<TR>
<TD colspan="3"><IHG src="title.JPG" width="680" height="160" border="8">¢

</TR> —
<TR>
<TD><B>Menu</B></TD>
<TD colspan="2"><B>Headlines</B></TD>
</TR>
Indicates an image. RN
<FONT size="2"><IMG src="goldarrow.gif" alt="'=" border="8">&nbsp; <A href=
<IHG src="goldarrou.gif" alt="=" border="0">&nbsp; <A href="/toppage/featu
——@®<IHG src="goldarrow.gif" nbsp; <A href="http://prodinf
<IHG src="goldarrow.gif" nbsp; <A href="http://prodinf
<IHG src="goldarrow.gif" nbsp; <A href="/toppage/servi
<IHE src="goldarrow.gif" alt="=" border=""0">&nbsp <A href="/toppage/prodi
</FONT></TD>
<TD rowspan="2" width="300" valign="top" align="left">
@ <P><FONT size="2"><IMG src="goldarrow.gif" alt="#*"|border="8">&nbsp; <A hr
(WYSIWYG), &quot;HTHL Source,&quot; and &quot;Preview.&quot;

1 | A

Indicates a link.

A

Indicate a paragraph.

“To create a Web page” is actually “to prepare a file written in HTML.” Because HTML is a
computer language that consists of many tags, we are not familiar with HTML in our everyday
lives.

Now we come to TopPage. Without any knowledge of HTML, you can create Web pages or a
Web site easily with TopPage as if you create documents with a word processor. HTML tags
need not concern you, because the required tags are automatically embedded into the docu-
ment.

Chapter 1. Web pages and TopPage

1
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Sample Web pages

SR Using templates and materials

Novice _ | .
Chapter 3, “Tutorial: Creating your Web pages in an hour”

If this is the first time for you to create a Web page or to use TopPage, use the tem-
plates and materials TopPage supplies. Chapter 3 of this guide describes how to
create Web pages in an hour.

Templates
® @

Templates for Web pages consist of an optimum combination of materials. You can replace
these materials with others if you like.

( If you combine these materials, )

This framework for your Web
page is automatically generated.

\
.

Chef's Suggestion
BT EEr S e

\
.

1-4 TopPage User’s Guide



Materials
@ @

TopPage offers various materials. See the following examples.

Background images

Title images

Welcome to

My .

Home ¢, ~
Page'%‘& ,

Header and footer
%%i § FRd SR iS4 RE S LR 0 S8 REd
R i Eihicisad-t ST SE &4

Chapter 1. Web pages and TopPage 1-5



Sample Web pages _ _
i Learning about basics

Intermediate Chapter 4, “Basic knowledge”
Chapter 5, “Editing text”
Chapter 6, “Creating tables”
Chapter 7, “Inserting images”
Chapter 8, “Setting links”
Chapter 10, “Creating materials”

Once you have created a framework using templates or materials, enrich the content

of your Web pages so that they are brimming with your own creativity.

Content is crucial to Web pages

Content is the crucial element in Web pages. Express on your Web pages something you
have long thought, something you want other people to know, or ideas that no one else has hit

upon. TopPage will be your partner.

e N
See this example.

The author of this Web
page used the Garden- o
ing template to make a

Floral Arrangements

quality of our praducts, Owr top-selling foral arrangernents are;

enriched its content. - R ————
\\§ J @_.Fws e
‘ ¥ (310, 315, 520, £25, 830 plus delivery charge

|Order Code: F1

page 5-2

framework and then A 50 ot s s it ‘ “Entering text” on

z }‘_- | One Dozel! Tulips
“Inserting an image” .7.', ;;%ga;%;m:;;vj;:::;e “Creating a table” on
Q1) | Order Code: F2

on page 7-2 page 6-2

 Three pansy pots
‘ ¥ |10 phus delvery charge
Order Code: F3

&

Inserting a horizontal -Add't' Fer? . “Inserting a heading”
» _ itional Services@
rule” on page 5-15 on page 5-13
« Potted green plants
‘ » Frutbaskets
» Balloen bouguet ‘
“Creating a list” on « Chrfstmas centerprece -
page 5-17

\ Mail To place vour order. elick here .—‘ Settlng alink on text
- on page 8-2

1-6 TopPage User’s Guide



Types of headings Types of lists
@ ® O @

The following six types of
headings are available. The following three types of lists are available.

“Inserting a heading” on “Creating a list” on page 5-17

page 5-13
4 ) Bulleted list
1 1. Flower Basket
Head lng 1 s Flower Basket 2 DOne Dozen Tu]jps
s One Dozen Tulips
Heading 2 Ordered list
— \
. Flower Basket
Heading 4 Five sizes available.
F10, §15, $20, $23, $30 plus delivery charge
Heading 5 Cne Dozen Tulips
Arrangement in a vase.
Heading 6 $15 phus delivery charge
- 4 - J
Creating your original materials
® @

Example of lettered buttons

You can create lettered buttons and
decorate photos with frames using the
WebArt Designer accessory tool.

Chapter 10, “Creating materials”

Example of
photos with
HEINES

Chapter 1. Web pages and TopPage 1-7
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Using the latest technology

Chapter 9, “Designing Web pages using style sheets”
Chapter 11, “Advanced techniques”

Sample Web pages

Advanced

TopPage is compatible with such recent technologies as style sheets, dynamic HTML,
and so on.

(I)Note ]

Web pages using the latest technology can be viewed only
on Web browsers that are compatible with that technology.

Sample Web page that uses various techniques
® L

Dividing a window, embedding sound or a Java applet, or inserting an access counter makes
your Web page impressive.

See this example. The author of this Web page used
the Gardening template to make a framework,
enriched its content, and then used various tech-
nigues to make the Web page impressive.

“Customizing a Java
applet” on page 11-28

‘ 38 Progran Files\ TopPape\gubie\gastenhirome:him - Wictasol Infesnot Explores

|| B Bt e Bo Fawes Heb
LT e e—r———E——r—— B

“Dividing a Web
browser window (1)” .

N A s

on page 11-3

“Setting multiple links
on a single image” on
page 11-11

“Receiving readers’
responses” on page

The ABC Flarist effecs cnlne
cocdeeing of Biourgaets;
amangements, baskets, and
CHRIEIHETES.

BRI RIRI BN AL

wedding gewic35

el o

For Your Dream Weddmg

11-2

il The iEC

“Editing a script .

program” on page
11-24

N “Embedding a plug-in
' object” on page 11-26

L/

1-8 TopPage User’s Guide



Forms Dynamic HTML

(questionnaires, order forms, and so on)
® © @

You can make questionnaires or order =
forms using the form function. |

“Creating a form” on page 11-17

=
* Basketball and Related Products
Name
Basketshoes
Address * Basketball
ciy + Apparel
* Team Uniform Order

€M C Mrs. © Ms

s S—

—— TopPage offers sample dynamic HTML.
R “Using dynamic HTML” on page 11-33

G T [ [T Conmiter 7

Style sheets
o L

L The following two Web pages look different,
The combination of HTML and style sheets but both of them use the same HTML file.

can make your Web.pa.ges beautiful. The first page does not use a style sheet,
Chapter 9, “Designing Web pages whereas the second one uses a style sheet
using style sheets” to change layout, color, and font.
This is an example of the same
TopPage Web page using a style sheet.
Style Sheet 1
Style Sheet 2
Style Sheet 1
Style Sheet 3 -
Style Sheet 4 H
Style Sheet 3 Style Sheet 3
o List-1 |
o List-2
- Lt Style Sheet 4

Style Sheet §

SList-1

IS SList-2
This is an example of a Web page 2

that does not use a style sheet.

Chapter 1. Web pages and TopPage 1-9
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Web pages on the Internet

Chapter 12, “Uploading Web pages”

Even if you have created wonderful Web pages, no one can view them as long as
they are stored in your computer. If you want someone to view your Web pages, you
have to transfer all the files composing your Web pages to an Internet Service
Provider. Web pages on the Internet are accessible from anywhere in the world.

e \

1 TopPoge - indan.him - ADC Florist
Dl Edt Mew Fomat jrost Table Flame Sie Jool Window Heb

S == P e R = e R T

TopPage offers a function for
transferring all the files making up
your Web site at once.

J
o e e Y,

|31 ABC Flarist - Microsoft Intermet Explorer (o]

Fie Edi Vew Go Favoites Help

Addiess [ hitp prodinfojapan bm oo ip/toppage/garden hinl

Arrangements

( fé B
4 R 2 i
q o Wedding
If your Web site is successfully Servicet AR
transferred to a provider’s server,
itis on the Internet. A Web SRR B SRR LRI S
browser enables other people to
view your Web site. =
(S J & [T (120 ot 7
provider server
An agent that provides a connection to A computer that stores many Web sites
the Internet. Many providers offer a on the Internet.

service for registering Web sites.

1-10  TopPage User’s Guide



Installing and Chapter
starting TopPage 2

After you install TopPage, you can start it. This chapter
explains the system requirements, how to install, start, and
end TopPage, and how to view online help when problems
occur.

*%  System requirements .........c.ccceeeieiennnnn. 2-2
*%% Installing TopPage ........cccoeevivnvininennnn.. 2-3
*%% Starting and ending TopPage .................. 2-7
*** Referring to the online help ................. 2-10

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 2-1



To run TopPage, you need the following:

2-2

~

Operating system

Microsoft Windows 95, Windows 98, or Windows NT 4.0 (Intel
version)

Computer Personal computer with Pentium(R) Processor
Memory 16 MB or more (32 MB or more is recommended)
Hard disk For the minimum configuration, 30 MB or more of free hard disk

space

For the standard configuration, 120 MB or more of free hard disk
space

(The required free space depends on both the file system of your
computer and the type of configuration you select. The maxi-
mum configuration might require 150 MB or more of free hard
disk space.)

Other hardware

-

A CD-ROM drive to install the program

TopPage User’s Guide




Installing TopPage

This section explains how to install TopPage on the hard disk of your computer.

OLIID

If you are using Windows
NT, login to the system as
administrator to install
TopPage.

OLIID

If your computer has
AutoPlay disabled, follow
these instructions:

1. Click the Start button on
the task bar.

2. Select Run.

3. Type “D:\setup.exe”
(where D: represents your
CD-ROM drive), and click
OK. The Opening window
appears.

@ Switch on your computer. (Start Windows, if neces-

sary.)

@ Close any open applications.

€@ Insert the TopPage CD into your computer’s CD-
ROM drive.

@ If your computer has AutoPlay enabled, the Open-
ing window appears:

€ IBM NetObjects TopPage

Installation
Tutorial

User's Guide
PerfectPhoto free trial
CD Contents

@ Click Installation in the Opening window. The
Setup window appears:

IBM NetObjects TopPage Setup

‘Welcome to the IBM MetDbjects TopPage Setup
program. This program wil install [BM NetObjects
TopPage on your computer

Itis strongly recommended that you exit all “Windows programs
befare running this Setup program.

Click Cancel to quit Setup and then close any programs wou
have running. Click Mewxt to continue with the Setup program.

WWARMNIMG: This program iz protected by copyright law and
intemational reaties.

Unauthorized reproduction or distribution of this program, or any
portion of it, may result in severe civil and criminal penalties, and
will be prozecuted to the maximum extent possible under law,

) Cancel

Chapter 2. Starting TopPage 2-3
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@ Click Next in the Setup window. The License
Agreement window appears.

@ Click Yes if you agree with the license agreement to
proceed with installation. The following window
appears:

Choose Destination Location

@ Verify the default destination folder name. If you
want to change the folder name, click Browse to
specify another folder.

€l Click Next. The following window appears:

Setup Type




(1)Note ]

If you select Compact ,
template and sample data
are not installed.

The install program provides you with three installa-
tion options - Typical, Compact, and Custom.

Select one of them, and click Next. (Select Typical
if you want to install all modules including online
manual and tutorial.)

If you select Typical or Compact , TopPage files are
copied into your hard disk. Skip to Step 13.

If you select Custom , the following window ap-

pears:

Select Components

Sample Images

Sample Data

Select the components you want to install, and click
Next. The following window appears:

Start Copying Files

Chapter 2. Starting TopPage
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@ Verify your current installation settings. Click Next
to copy TopPage files into your hard disk.

& After all files are copied, the product registration
tool appears. Follow the instructions described on
the tool to register your software.

After product registration, the following window
appears.

@ The Setup Complete dialog comes up. Click the
Finish button on the dialog.

@ Verify that TopPage program group is within the
Programs under the task bar’s Start menu.

@ (@ Click Exit to exit the Opening window.

cts TopPage: =0

To add components after in-
stallation, run the installa-
tion program again, select
Custom Setup type’ and se- Before ].nstallation
lect components to be Installation
added.

PerfectPhoto free trial
CD Contents

2-6 TopPage User's Guide



When installation is complete, the TopPage startup menu is added to the Programs
menu in the Windows Start menu.

Starting TopPage

Click the Start button in the Windows task bar.

@ In the Programs menu, click IBM NetObjects
TopPage to display the TopPage submenu.

Bz 1BM NetDbjs

€@l Click TopPage to display the TopPage main win-
dow and the Welcome to TopPage dialog box.

=EEE]

Chapter 2. Starting TopPage 2-7
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If it is the first time for you to
create a Web page, you
might not understand what
the Welcome to TopPage
dialog box means. If so,
click the Cancel button to
close the dialog box and fol-
low the instructions de-
scribed in this guide (Chap-
ter 3 first).

TopPage User’s Guide

@ If you want to start with the Welcome to TopPage
dialog box, click either the Create a Site, Open an
Existing Site , or Edit Without Using the Site tab.
Then select an item in the displayed panel, and
click the OK button. If you do not want to use that
dialog box, click the Cancel button.

“Using the Welcome dialog box” on page 4-14

Ending TopPage

To end TopPage, select Exit from the File menu. If you
have edited something on an opened Web page, mes-
sages to save it and its contents appears.

“Saving a Web page” on page 4-9



About the TopPage main window

You can manage Web sites and Web pages on the left side of the window, and you can
open and edit pages on the right side of it.

(1)Notes ]

Tool bar

You can call frequently used functions from the buttons on the tool bar. e If a site is not yet opened,
Menu bar the contents of the Link
You can call all the TopPage functions from the menu items on the menu and File tabs are not dis-
bar. played.

g Site oo Widow Help
E Dwﬂ\&\%eao\ [l H_Em\ ea\&%lo\

e |f you have not installed
Microsoft Internet Explorer
P m"%@%{‘!/@%VA 3.0 or higher into your
o computer, the Preview
S tab is not displayed.

e \When you open a page
that includes frames, the
Frame HTML Source and
No Frame tabs are dis-
played.

bl
& Nomsl

I— Preview tab
The Preview pane, displayed when you click the Preview tab, enables you
to check how a Web page you are currently editing looks on a Web browser.
HTML Source tab

Edit Web pages on the HTML Source pane, displayed when you click the
HTML Source tab, only when you want to edit HTML source directly.
Normal tab

The Normal pane, displayed when you click the Normal tab, is the normal
editor of TopPage.

L Contents tab

The Contents pane, displayed when you click the Contents tab, enables you to select and insert
materials into a Web page that is opened on the right side of the window.

File tab

The File pane, displayed when you click the File tab, shows a list of folders and files within a site
folder. In this view, files are divided into those to be transferred and those still unused.
—Link tab

The Link pane, displayed when you click the Link tab, enables you to view the link hierarchy from
the top page of a site.

Chapter 2. Starting TopPage 2-9



Referring to the online help

If you want detailed information not provided in this guide, refer to the online help, as

described in this section.

O

You can also press the F1
key to display the online
help for a dialog box.

2-10  TopPage User’s Guide

Referring to the online help for dialog boxes

To learn the meanings of individual items within a dialog
box or to learn how to specify items to obtain the result
you want, click the Help button on the dialog box and

read the explanation displayed.

Attribute

Tag IDocument Properties

Document Info IBackgloudeTekl Color | Meta Info | Others |

[

Document Title: |F\oral Arrangements

Base URL |

Defaul Target: |

0K Cancel

Viewing the topics of the online help

To display the topics of the online help (which means the
Index tab of the Help Topics dialog box), select Help

Topics from the Help menu.



Tutorial: Creating yc Chapter
\Web pages in an ho 3

You can create your Web pages in an hour using the tem-
plates and materials TopPage offers. Follow the instructions
in this chapter to become accustomed to TopPage.

This chapter explains how to create Web pages at your
computer, view its link hierarchy, and view them on a Web
browser:

(I)Note ]

Before doing the tasks in this chapter, install Templates to
use templates and Sample Images and Sample Data to use
materials.

Before doing the tasks in this chapter

1. Start TopPage.
“Starting and ending TopPage” on page 2-7

To effectively acquire the knowledge and skills for creating
a Web site, read the following sections in order:

*** Creating a framework of Web pages ......... 3-2
*** Viewing the link hierarchy of Web pages....3-9
*** Viewing Web pages on a Web browser .... 3-13

Chef's Suggestion '

*%% Enriching the content ......................... 3-15

1 N N I N -
[E1ome I = ¥

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 3-1



The easiest way for you to create a framework of Web
‘ pages is to use templates for Web pages that consist of
an optimum combination of materials. You can replace

( Creating a framework of Web pages )

(Viewing the link hierarchy of Web pages)

L 4

(Viewing Web pages on a Web browser) Start TopPage and click the Cancel button on the
‘ Welcome to TopPage dialog.

“Starting and ending TopPage” on page 2-7

materials if you like.

( Enriching the content )

@ Select New from the File memu.

TopPage nmu

ERIEEIEEIE
EE[ e s = e [EE e S 2%

The following dialog box appears:
Mew X

Page I Frame | Appl\cat\unl Multiple: F'agesl

Business 1
Business 2

Business 3

Business 4

Business §

Business B

Business 7

Business 8

Calendar 1339
Calendar 13933 January
Gradation 1

Gradation 2

Gradation 3

Order Form

Personal 1

Personal 2 |

Blank page

aK I Cancel Help
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Pl Note

If you have not installed
Templates , the dialog box
of the wizard does not ap-
pear.

@ Vocabulary

wizard

A user interface that en-
ables you to do tasks step
by step. You just need to
select something or answer
the question and then click
the Next button. Wizards
are often used in the Win-
dows world, because they
enable you to do tasks ac-
curately. On each dialog
box of a wizard, click the
Next button to advance to
the next step, or click the
Back button to return to the
previous step. Click the
Cancel button to cancel the
operation. On the last dia-
log box, click the Finish
button to activate what you
selected or entered.

€@ Click the Multiple Pages tab, and then click the OK
button to start the wizard for creating a framework

of a Web site.

Hew

Page | Frame | Application

‘our favarite \Web pages
can be created easily,
selecting genre or image
paits. ou can create Top
page and subpages linked
by the tap page.

Click DK button below. start
the wizard

QK I Cancel | Help I

The following is the first dialog box of the wizard.

-~ Sel

Hobby & Interest
Life Style
Nalure

School
Seience

Spoits

Testure Series
Tavin Business

~Theme

Casual

Farmal?

Gorgeous =l

ek [ mes | cancel Help

Chapter 3. Tutorial: Creating your Web pages in an hour 3-3



(¢)Tip

If you want to select some-
thing experimentally, click
Town on the Select Genre
list, and then click Restau-
rant in the Theme list.

(¢ Tip ]

If you select the No text
check box ( [+ ) at the bot-
tom of the Select Banner
Image list, text such as
“WELCOME TO MY HOME
PAGE" disappears. Then, if
you later clear the No text
check box ( "), the text
reappears.

TopPage User’s Guide

@ Select one item in the Select Genre list, and then
select one item in the Theme list.

Create Mutiple Pages - 1/5

[~ Select Genre
Conceptual Series

<ot [ hets | tancdl | Hew |

You can view the design for the selected theme on
the right side of the dialog box. This design is a

template that consists of optimal materials for the
theme.

@ Click the Next button to go to the next step. The
following dialog box appears:

Create Mutiple Pages - 2/5

~Select Background

Bl Diagonal Shipe =
Blue Green Stipe
Blue Grid
Blue Note Pad | |
Blue Paper
Blue Stipe

Cat Paws
Circuit Board Edges
ok

:Cream Vellow Wl

—Select Banner Image
Business People 5

Butterlly Title
Camers

Cat
Cl

Circuit Board Circle:
.......

™ HoText

cBack | Mew> | Cancel Help
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@ On this dialog box, you can replace a background
image or a banner image with a different one.

If you want to replace materials, select a back-
ground image in the Select Background list, select
a banner image in the Select Banner Image list,
and click the Next button.

If you do not want to replace materials, just click the
Next button. The following dialog box appears:

Create Mutiple Pages - 3/5

(- Sielec Header/Eooter

Cark, Slips |
Dog Biscuits

Dynamic

Ethric

Femirine _I
Gold

Gorgeous

Green Blue Eaves & Step

Green Flovs

- Select lcon Image

Biiliant =
Butterlly

Cand Suit

Cat J
Cireuit Seope

Clouds [White)

Color Bl

Color Notebook

cBack [ mews | concel | Hep |

On this dialog box, you can replace header and
footer images or icon images with different ones.

If you want to replace materials, select a header
and footer image in the Select Header/Footer list,
select an icon image in the Select Icon Image list,
and click the Next button. The following dialog box
appears.

If you do not want to replace materials, just click the
Next button.

3-5




@ V o c a b u I a ry Create Mutiple Pages - 4/5

top page

Normally the first page of a
Web site. However, in this
wizard, what is referred to
as the top page is actually Subpage Thle 10 Be Al o Repaced
an ordinary Web pagethat | L. . | | T4/
has been designed in a top- e—
page style, and you can use

it as an ordinary Web page. ciook [ | tomeel | |

@ Vocabulary @ Enter the title of the top page in Title under Top

Page Settings , and enter your e-mail address in E-
mail Address .

PorouCuUEIRd
PR S |
T v

subpage

A Web page linked from the
top page. €l Enter the title of a subpage in Subpage Title to Be

Added or Replaced .
. .
@ £ ] Click Subpage 1, and then click Replace to replace

The e-mail address entered in the title of the subpage.
E-mail Address becomes the

transmission destination for @ Replace Subpage 2 and Subpage 3 with your

mail. If you do not have an e- preferred titles in the same manner.

mail address, leave E-mail Creste Mutiple Pages - 475 ; o ent
Address blank and clear the TPt comething experl
Include E-mail Address in [ores St susuTTT TSNS

mentally, enter

Subpages check box. e (@i “Chef's Suggestion”
[ Gubpage Seftings for the tltle
Title

To add a subpage, enter a tme Subpage Title to Be Added of Freplaced

for the subpage in Subpage T e

Title to Be Added or Re- % Inclade Exps Addesein Sbsages

placed, and click the Add but-

ton. To delete one of the e [T | [ | [

subpages, select the title of the
subpage in Titles , and click
the Delete button.

If you want to create subpages experimentally,
enter the following three subpage titles:
“Appetizer,” “Entree,” and “Dessert. ”

3-6 TopPage User's Guide



@ @ Click the Next button to display a dialog box for

confirming the settings. The following dialog box

If you substituted materials
and want to record the set-
ting as a new template, click
the Register button, enter
any text in Theme, and
click the OK button. The
next time you start the wiz-
ard, you can conveniently

appears:

Create Mutiple Pages - 5/9

Create pages using the settings below,

Top Page

Subpages
3 pages Bedister

Specify Target Folder

C\Hy Documents\sitetop

[Fersgeon Ll Ll L

select the recorded setting
as a template.

cBack | Fnsn | Camcel | Help |

& A default folder is already specified in Specify
Target Folder . To change this folder, click the

@ Browse button to display the Specify Folder dialog

To create a folder using the box.
Specify Folder dialog box,
double-click the existing
folder, click the Create

@ See the tip on the left and create a folder for saving
Web page related files.

Folder button, enter a Specify Folder 7]x]
folder name, and then click Folder
the OK button. L ERp

ok

Cancel |
7| | Create Folder

For example, to create a
folder named “sitetop” im-
mediately under the C
drive, select c: under Drive,
double-click c:\ under DE — 5
Folder, then click the Cre- '

ate Folder button. When
the Create Folder dialog
box appears, enter “sitetop”
and click the OK button.
From now on you can se-
lect a sitetop folder in the
Folder list.

Chapter 3. Tutorial: Creating your Web pages in an hour 3-7



(1)Note

To select a folder in the
Specify Folder dialog box,
double-click the folder
name. You cannot select a
folder with a single-click.

(¢ Tip ]

If you used one of tem-
plates, the HTML file name
for the top page is
index.htm. (index.htmis a
file name often used for the

top page. )

3-8 TopPage User’s Guide

(3 Double-click the folder name and click the OK
button to close the Specify Folder dialog box. The
name of the folder you selected is automatically
specified in Specify Target Folder.

(@ Click the Finish button. The top page appears on
the right side of the TopPage main window. The
HTML file name and page title are displayed on the
title bar of the main window.

0.2k £ Yew Fomn a1 7ome S Tl Sew
D=@3[3zas = [~EEa=ER]0]
7 == EHEE|B | s S sS85 B0

= -
JUUUUUUUUUUY
:
ly:‘uz:d 3 - 1
e
@DW
Hu b
M
o o
)

Now you created a framework for your Web site.
Continue to the next page to view the link hierarchy
of your Web site.




(C,eaﬁng a framework of Web pages) A typical Web site permits jumping from the top page to
‘ subpages, which is referred to as linking. TopPage
enables you to view the link hierarchy. You must register
your Web pages as a site, however.

(Viewing the link hierarchy of Web pages)

L 4

(Viewing Web pages on a Web browser)

¥

( Enriching the content ) Select Site Wizard from the Site menu to start the
wizard for making a site.

@ @ Select Create a Site, and enter any site name.

Details about a site are ex-
plained in Chapter 4.

€@ Click the Next button to display a dialog box for
specifying a file name of the top page.

W
—l—l-é

g g

o EEEEEE
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The “sitetop” folder selected
within the following figure
was created in the previous
section of this guide, using
the Specify Folder dialog
box.

3-10  TopPage User’s Guide

@ Click the upper Select button to display a dialog
box for specifying the file name.

@ Select the folder you saved the Web pages in Look
in. Click index.htm to enter “index.htm” for the file
name.

HTHL files [* bl htrn." shtml.* shtm]

@ Click the Open button. The file name of the top
page and the folder name of the site are entered
automatically.

@ Click the Next button to display a dialog box for
specifying the destination server.



(¢)Tip

You can specify the destina-
tion server later.

“Registering the desti-

nation server” on page 12-2

Setup Destination Server

@ Click the Next button without any specification

because you can specify the destination server
later.

€1 On the next dialog box, Operation after Setting

Completion , select Open the Site after Closing
Settings , and click the Finish button. The “Do you
want to close all open documents?” message
appears.

Click the No button. The wizard ends and the link
hierarchy appears on the right side of the main
window:

Chapter 3. Tutorial: Creating your Web pages in an hour 3-11
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Can you see the link hierarchy of your Web site? If
you created a Web site using one of templates, the
Web site makes the following hierarchy:

index.htm (top page)

it
th-
i
n?m‘:

Muit]  Hons

subl.htm (subpage 1) sub2.htm (subpage 2) sub3.htm (subpage 3)

You have now created your Web pages as a site.
You can check the link hierarchy or file organiza-
tion at any time. Continue to the next page to view
your Web site on a Web browser.




( Creating a framework of Web pages )

L 4

(Viewing the link hierarchy of Web pages)

L 4

(Viewing Web pages on a Web browser)

¥

( Enriching the content )

(1)Note

You can use this function
only if you have installed
Netscape Navigator in your
computer.

(¢ Tip ]

If you have changed any-
thing on the Web page, a
dialog box for confirming
whether to save the change
appears before the Web
browser starts. Click the
Yes button on the dialog
box.

(I)Note ]

You can view pages using
style sheets or dynamic
HTML only if you have in-
stalled Netscape Navigator
4. 0 or higher.

Viewing a Web page on Netscape Navigator

To view a Web page on Netscape Navigator, the Web
browser of the Netscape Communications Corporation,
click &1 while the Web page is displayed. Then
Netscape Navigator starts.

Hmm

Chapter 3. Tutorial: Creating your Web pages in an hour

<] € wihats Reaed
3 velon P riosd (4 ©
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The appearance of a Web page in TopPage and in a Web
browser (an application for viewing Web pages) differ to
some extent. You can check how your Web page looks
on two types of Web browsers, while you are editing it
with TopPage.

3-13




(1)Note

You can use this function
only if you have installed
Internet Explorer in your

computer.

O U

If you have changed any-
thing on the Web page, a
dialog box for confirming
whether to save the change
appears before the Web
browser starts. Click the
Yes button on the dialog
box.

(I)Note ]

You can view pages using
style sheets or dynamic
HTML only if you have in-
stalled Internet Explorer 4.
0 or higher.

3-14  TopPage User’s Guide

Viewing a Web page on Internet Explorer

To view a Web page on Internet Explorer, the Web
browser of the Microsoft Corporation, click &/ while the
Web page is dlsplayed Internet Explorer starts.

Chel's ictosot Internet
B Edi View Go Favoites Heb

s saass.a

Seach _Favoiies _Hioy

Chef's Suggestion

[&700ne I [ [ T=J My Computer

]
7

(¢)Tip______________________________]

Tip How to use the Preview tab

You edit Web pages normally with the Normal tab. Click the
Preview tab to check how the part displayed in the Normal
tab looks in Internet Explorer. (You can use the Preview tab
only if you have installed Internet Explorer 3. O or higher. )

izl

R EE B




( Creating a framework of Web pages )

L 4

(Viewing the link hierarchy of Web pages)

L 4

(Viewing Web pages on a Web browser)

A 4

( Enriching the content )

@ Vocabulary

drag and drop

Pointing to the target object,
pressing the left mouse but-
ton, moving the mouse
pointer to the target loca-
tion, and then releasing the
mouse button.

Enrich the content of your Web pages by entering text,
pasting the images, and so on. From now on you will be
creating real Web pages abounding with your own cre-
ativity.

Opening a Web page to be edited
Open a Web page you are going to edit.

@ If a Web page is currently open, click the X button
in the upper right corner of the Web page window
(not the main window) to close it. If multiple pages
are currently open, close them all.

=181 x|

@ Select a page (for example, the subl.htm file in the

following figure) on the Link pane, and drag and
drop it to the right side of the main window.

T ow S0 Toi top
DS E[5]%E e == EEm =)
HE IEEErru|x s o |FREEE%]5%
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The Web page opens. The HTML file name and
page title are displayed on the title bar of the main
window.

SEESEEEEEC R 7|

Entering text

@ After opening a Web page, enter any text that enriches

your Web site.

Details about the procedure . . .
for entering or editing text is @ Enter any text. (See the following example in which

explained in Chapter 5. subl.htm is edited. )
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@ Delete unnecessary text and images using the
Delete or Backspace key. (See the following
example in which subl.htm is edited. )

I EI)

4 [k Ed1 View Fomel fmel Table Flame She loa e beb JNETE|
EECIER R =R
[ SdEE-=(s=z F==BI1U|A«0 | @E20[50RN

Appetizer

L

Closing a Web page

Close a Web page you have finished editing.

@ Click the X button in the upper right corner of the
Web page. Then the dialog box for confirming
whether to save the change appears.

@ Click the Yes button.

Now you have learned the foundation for creating
a Web site. If you want to learn a lot more, go on
to Chapter 4.

Chapter 3. Tutorial: Creating your Web pages in an hour 3-17



] Chapter
Basic knowledge 4

This chapter explains the basic knowledge and operations of
TopPage. You will learn such terms as site, Web page, and
attribute.

Before doing the tasks in this chapter
1. Start TopPage.

“Starting and ending TopPage” on page 2-7

*xx Sites and Web pages ........oooveveiiiiinnnn. 4-2
*kk Creating asite ....coevvieiiiiiiiiiiie e 4-4
**x Creatinga Web page .......cccoeveieiiieiinenenne. 4-7
*xx Saving aWeb page ........oveieiniiiiiiiene. 4-9
*** Opening a site and a Web page ................. 4-11
***x Using the Welcome dialog box .................. 4-14
*** Using attributes and the right mouse button......... 4-16

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 4-1



Sites and Web pages

Basically site refers to the place on a Web server where a Web page or Web pages
are. TopPage also uses the term site for the place on your computer where your Web

page or Web pages are.

(1)Note ]

Place the top page immedi-
ately under the main folder,
even if you create
subfolders like the illustra-
tion on the right.

@ Vocabulary

top page

The first page (home page)
of a Web site.

4-2 TopPage User's Guide

Sites are folders, and Web pages are HTML files

TopPage frequently uses the terms site and Web page.
A site means a group of Web pages combined with links,
whereas a Web page means an individual Web page.

One site has multiple pages. The relationship between a
site and a Web page is similar to the relationship be-
tween a folder and a file in the Windows world. In fact,
on the Web server, sites are managed as folders and
Web pages as files. Conceptually, a TopPage site
performs the same operation on your computer as the
site on the server. Under this concept, you can assume
any folder on your computer to be a site folder, and you
can place multiple Web pages in it.

A Web page is an HTML file. Because an HTML file is a
text file, you can open it with a word processor or text
editor. Images and sounds embedded within the Web
page are other files. See the following illustration. Nor-
mally you collect all files that organize a Web site within a
single folder, as shown in the illustration on the left. For a
big Web site, however, you can create subfolders accord-
ing to file types, as shown in the illustration on the right.

Site folder

Site folder

Web pages (HTML files)

Images

Sounds

Subfolder for Subfolder Subfolder
Web pages for images for sounds

Subfolders
Normally you collect all files that You can create subfolders

organize a Web site within one folder according to file types



O

You can edit Web pages
without creating a site. The
purpose of creating a site is
to view the link hierarchy
and to make it easy to
transfer all the files that or-
ganize your Web site to the
Web server.

Flow for creating Web pages

When using TopPage, Web pages are generally created
in the following order.

@ Create a new site.
“Creating a site” on page 4-4
“Viewing the link hierarchy of Web pages” on
page 3-9

@ Create several Web pages within a site and insert
text and images within each Web page. At this
stage, you work on the site on your computer.

€l Upload the site to the Web server. At this stage,
the site on the Web server matches the site on your
computer.

The creation of Web pages thus begins by creating a
virtual site in your computer and ends with the upload of
the site.

The site is also useful for updating your Web site or Web
pages. The structure and update information of the site
is always saved in your computer, so beginning with your
second upload, just the updated files are transferred to
the server.

Your computer Web server

Chapter 4. Basic knowledge
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Creating a site

You can create a site in any of the following three ways:
e Creating a site and a blank top page simultaneously
e Creating a site and multiple Web pages simultaneously using templates
e Creating a site from existing or previously created Web pages
This section focuses on the first way. For the second and third ways, see the second

Tip in this section.

O

You can edit Web pages
without creating a site. The
purpose of creating a site is
to view the link hierarchy
and to make it easy to
transfer all the files that or-
ganize your Web site to the
Web server. @ “Sites and
Web pages” on page 4-2

o) Tips

« To create a site and mul-
tiple Web pages simulta-
neously using templates,
select Create a Site with
Multiple Pages using
Template .

« To create a site from exist-
ing or previously created
Web pages, select Create
Site from Existing
Pages.

« To make a frame-using
page the top page, select
Create Site from Exist-
ing Pages , and then se-
lect a frame-using page
file as the top page file.
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@ Start TopPage. The Welcome to TopPage dialog
box appears. “Starting and ending TopPage” on
page 2-7, “Using the Welcome dialog box” on page
4-14

@ On the Create a Site tab, select Create a Site with
a Blank Top Page , select the Open the Site to
Create at Start up radio button, and then click the
OK button.

welcome to TopPage

Craate a Site | Dpen an Existing Site | Edt Without Using the Site |

Create a site and a blank top page.

e
£~ Creale 3 Site with Muliple Pages
(e e

% " Create Site from Existing Pages
I~ Open the Site to Create at Start up @ What Is a Site 7

0k | el | Heb |

€@ On the Select an Operation dialog box, Create a
Site is already selected. Enter the site name under
it, and click the Next button.



BB EEEE

@ Click the Select button.

@ @ The following dialog box appears. Select a site

folder in Look in and enter the file name for the top

't_if] reco?’""e”g?g that %0“ page in File name . (Ordinarily, you enter

either select a folder wit “index.html” or “index.htm.” However, if there is a
nothing in it or create a new . . :

folder by clicking | and guide to file names from the provider who has the
assigning a folder name. Web server, follow that guide.)

Chapter 4. Basic knowledge 4-5



Open
Look jn: | 3 mysite

File name:—findss bim Open |
Files of type: [HTML fles [~ btml:* bt shirl:* shitm) =l Cancel

@ Click the Open button. The file name of the top
page you selected appears under the Select but-
ton.

Set Site ltems

- Site Setting:

C-\mysiteindes him

if you want o create
subfolders for each file '

type, click the Detail Set-
tings button.

The setfings in this page
are required.

O

To change the site settings,

Detal Setings |

select Site Wizard from the chack | P | cwes | He |

Site menu, select Change

the Existing Site Settings Click the Finish button to open a new site and top
and a site name, and then page. The link hierarchy is displayed on the left

elEkin O e side of the main window and a blank top page is

displayed on the right side.

O

@ Select Document Properties from the Edit menu,

To delete a site, select De- and then specify the title and background color for
lete Site from the Site the top page. "Creating a Web page” on page
menu, select a site name, 4-7

and then click the OK but-

ton. The site registration is @ Edit the top page. Chaoter 5 (and later chap-
canceled. (Folders and ters) P pag P ( p

files are not deleted.)
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This section explains how to create a blank Web page from scratch. This operation
enables you to create Web pages without templates; in other words, you do not have
to install templates to do this operation. After creating a blank Web page, specify the
page title and background color.

@ Related HTML tags

<IDOCTYPE HTML PUBLIC ““>
<HTML></HTML>
<HEAD></HEAD>
<TITLE></TITLE>
<BODY BGCOLOR= ></BODY>

O

Another approach to creat-
ing a Web page is to select
New from the File menu.
This requires templates to
be installed, however.

“Creating a framework of
Web pages” on page 3-2

OUIE——

The title you enter here is
also the title for Favorites
or Bookmarks of Web
browsers.

@ Click the E icon to create a blank Web page.

=loix|

e
7l

@ Select Document Properties  from the Edit menu
to display a dialog box for the page settings.

€@ Click the Document Info tab, and then enter any
title in Document Title .

Attiibute
Tag, IDUcument Fioperties j
Document Info IBackglnundﬁTexl En\nrl Meta Infnl Dthersl
Document Tite: |F\oral Arangements]
Base LIRL |
Default Target: | j
ok I Cancel Help

Chapter 4. Basic knowledge
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fs)Tip
“Saving a Web page” on

page 4-9 explains how to
save an edited page.

4-8 TopPage User’s Guide

@ Click the Background/Text Color tab, and then
click the colored button to the right of Background
to display the following pull-down menu:

x|

Document Properties

Text
Lirk.
Wisited Link
Active Link

@ Click any color (or click the Others button to select
a different color), and then click the OK button. The
background color is set.

Attiibute X

Document Properties

@ Click the OK button. Then the background color
changes and the page title is displayed on the title
bar of the main window.



Save a new or edited Web page in either of the following ways:
e Saving while editing
e Saving with a different file name
e Saving when closing the Web page

@11_ Saving while editing

If you save a new Web
page in this way, the dialog Click E to save a Web page you are editing with the

box for assigning a file same file name.

name appears. Specify the

LSS G S Saving with a different file name
Save button.

@ Select Save As from the File menu to display the
dialog box for assigning a file name.

@ Specify the file name in File Name, and click the
Save button.

Fiegame:  [sub hinf

Save astupe: [HTML flles (~hml~ by shimlshim) =] ancel

I
&
3
&

o

i

€@ If you inserted any objects, such as images, on the
Web page while editing, the following dialog box
appears:

ination: [C:\mpsite’, Browse.

W Copy Files to the Folder

Cancel Help

@ Confirm the target location, and click the OK button.
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(1)Note ]

If you save a new Web
page in this way, a dialog
box for assigning the file
name appears. Specify the
file name, and click the
Save button.
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Saving when closing the Web page

When you close a Web page after having edited it, the
dialog box for confirming whether to save the changes
appears.

@ Click the ] icon in the upper right corner of the
Web page. If there are any changes after you
saved the Web page before, the following dialog
box for appears:

& Save changes to subl. htm?

No | Cancel |

To save the
changes, click
the Yes button.

To close the Web  To continue

page without editing the page,
saving, click the click the Cancel
No button. button.

@ If you inserted any objects, such as images, on the
Web page while editing it, a dialog box for confirm-
ing the target location appears. Check the target
location, and click the OK button.



You can open a site and Web page you have already created. First, open the site,
and then open the target page. (You can open the target page without opening the

site.)

(¢) Tips

« “Creating a site” on page
4-4 explains how to create
a site.

« “Creating a Web page” on
page 4-7 explains how to
create a Web page.

OUI——

The names of all sites you
have created are displayed
in the Open Site dialog
box.

OUI——

To open another site, select
Close Site from the Site
menu to close the currently
opened site, and then se-
lect Open Site from the
Site menu to open another
site.

Opening a site

@ Select Open Site from the Site menu to display the
following dialog box:

Open Site

0k | cencel | Hep |

@ Select the target site, and then click the OK button.

The site opens. (The following figure shows an
example of the left side of the main window when a
site opens.)

Fiz View Site Too Help

j'
[Hy site
E&F My Sie
= [3) Top Pagel/inde htm)

l-[3] subl.him

(3 subzhtm

[3] subZhtm
Files Linked by indez: Hm |
LIRL [ Tite
[3] sub? htm Floral Anangeme.
[3] sub2 htm ‘wWedding Service
[3 sub3 him Order Form
mamu
s Fomress— Link tab
Wy fone Enables you to view the link hierarchy
lowr_i3.gif Flawer
ame,m?g.r Mail lcan from the tOp page.
arde_.gif Green Flower Sti
ardle_bg it Flle tab

Enables you to view the subfolders and
files stored in the site folder.
| |
:m! Fiie | | Contehis = Contents tab
I I Enables you to insert materials.
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o) Tip ]
.htm and .html

Both “.htm” and “.html” are
extensions affixed to HTML
files. “.html” is used in the
UNIX operating system that
most Web servers install,
whereas “.htm” is often
used in the Windows world
to reduce file name exten-
sions to three letters. Both
have the same meaning,
but note that some servers
permit only “.html.”

(1)Note ]

The Preview tab is dis-
played only if you installed
Internet Explorer 3.0 or
higher.

TopPage User’s Guide

Opening a Web page

You can open an HTML file stored on your computer as
follows. (There are several other methods for opening a
Web page. See the Tip on the end of this section.)

Click the ﬂ icon to display the following dialog box:

Open 2] x

=& & =

Look i | (3 mysie

@ sub3.him

| 1waveTest

File pame: [index him

Open I
=l Cancel

Files of lupe: IHTML files [ htrnl:* ke shitml* shtm]

@ Specify a Look in and File name, and then click
the Open button. Then the page opens.

!lr!u:v

13 b

[Fles Lrked by o i

aaaaaaaaaa

aaaaaaa
-

Preview tab
The Preview pane, displayed when you click the
Preview tab, enables you to check how a Web
page you are currently editing looks on a Web
browser.
HTML Source tab
You should edit Web pages on the HTML Source
pane, displayed when you click the HTML Source
tab, only when edit HTML source directly.

Normal tab
The Normal pane, displayed when you click the Normal
tab, is the normal editor of TopPage.



You can open not only a single Web page but also
multiple Web pages.

SRR

Floral Arrangements

OLIEEEER O Ll

Automatic correction of Other methods for opening a Web page

SN EN EIES Here are some other methods for opening a Web page.

Normally there are no syn- They will help you open the target Web pages quickly.
tax errors (HTML mistakes) « Drag and drop an HTML file from Windows Explorer onto
in Web pages edited in the right side of the TopPage main window.

TopPage. However, if you
edit an HTML source di-
rectly, there might be syntax
errors due to entry mis-

« To open recently edited pages (up to 7 pages), select the
File menu, and then select the target file name on the
pull-down menu.

takes. TopPage is de- « If you have opened a site, you can use the right mouse
signed to correct syntax er- button to click the target HTML file (*.htm or *.html) in the
rors automatically when a Link or File pane, and then select the Edit menu. Or
Web page is opened. drag and drop the target HTML file onto the right side of

the main window.
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You can do the tasks explained in this chapter easily by using the Welcome to
TopPage dialog box that appears when you start TopPage.

4-14
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Either of the following methods displays the Wel-
come to TopPage dialog box.

e Start TopPage. "Starting and ending
TopPage” on page 2-7

e |f TopPage has already started, close the
opened site and Web pages, and then select
Open Opening Dialog from the File menu. (If
any site or Web page is opened, you cannot
select this menu.)

@ Click either of the following three tabs, select a
task, and then click the OK button to begin the task.

e Create a Site tab

Create a Site | Open an Existing Site I Edit Without Using the Site |
Cieate a site and a blank top page.
Creates a site and a blank
top page simultaneously.
“Creating a site” on

page 4-4

age

Create a Site with Mulipls Pages
from & Templats

EERs
%  Create Site from Existing Pages —|

r Creates a site and multiple
Web pages simulta-
neously using templates.

Registers Web pages you

™ Open the Site to Create at Start up @ What Iz a Site ? previOuSly created as a

site.
0K | Cacel | Hew |




e Open an Existing Site tab

'Welcome to TopPage

Opens one of sites you have created.

e Edit Without Using the Site tab

'Welcome to TopPage

Creates a Web page at
any place regardless of
sites.

Creates a framework of a
Web page or Web site
using templates regard-
less of sites.

Opens the recently edited
HTML files.
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Using attributes and the right mouse button

Knowledge of attributes and clicking using the right mouse button makes TopPage
operations easy.

@ Vocabulary

4-16

element

One of the fundamental
units that compose a Web
page. For example,
paragraphs, horizontal
rules, tables, and images
are elements.

TopPage User’s Guide

What are attributes?

Each element inserted on a Web page contains
attributes. For example, a table contains such attributes
as width and color, whereas an image contains such
attributes as width and height. Attributes are used mainly
for changing appearance.

When you construct a table, you first create the table
itself and then you change its width or color. When you
insert an image, you first insert the generic image, and
then you change its width or height. Thus, when you
work with elements in TopPage, you first create or insert
elements, and then you change their attributes.

Your method for changing attributes is the same for all
elements. When you think “l want to change something
about this element,” you need to change its attributes as
follows:

@ Click the element using the right mouse button to
display a pop-up menu.

Delete Columin
Delete Table
Shaw Table Frame

Release Link

Edit Image.
Edit Image Map(1]...

ment Froperties...

Extended Attributes..
Atributes



LI
What is a nested element ?

If an element contains
another element, the one
inside is called a nested
element. For example, if a
table contains an image,
the image is a nested
element.

O L

To know how to specify the
value of each attribute, click
the Help button on the
Attribute dialog box.

@ Click the Attributes menu to display the Attribute
dialog box.

€& Check the element name displayed in the Tag list box
on the Attribute dialog box. It might not be the target
element name; it might be a nested element instead.
To display attributes of the target element, select the
target element name from the Tag list box.

Atribute

Height

| ™ Show Border width: |0 3: pivels ‘

Image
T~ Uss Server-Sids Image Map
CSIM Name:

Extended. |

Cancel Help

@ Change the values of the attributes as you like.

@ Click the OK button to make the changes take
effect.

Clicking using the right mouse button

In the preceding description, if you click an element using
the right mouse button, menus other than Attributes
appear. Most applications that run under Windows
enable you to click using the right mouse button to do
various tasks. TopPage enables you to click using the
right mouse button not only on elements but also on files
and folders. If you want to do a certain task with an
element, a file, or a folder, try clicking it using the right
mouse button.
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Chapter

Editing text 5

This chapter explains how to edit text after opening the target
Web page. It also explains how to make easy-to-read Web
pages by using such elements as headings, horizontal rules,
and lists.

Before doing the tasks in this chapter

1. Start TopPage.
“Starting and ending TopPage” on page 2-7

2. Open a Web page to be edited.
“Opening a site and a Web page” on page 4-11

J
*okok Entering text......ooevvieiiiiiiiiiinenes 5-2

Rl *  Changing the appearance of text....... 5-5
ﬁmwi?‘"w * Aligning text.......o.oooiiiiiiiines 5-8
@m;ww *** Deleting, moving, or copying text ..... 5-9
14— *  Finding text....cccoveuiiiiiiiiieen. 5-11
@ﬂ"ﬂ ** Inserting a heading ..................... 5-13
iy J I Inserting a horizontal rule.............. 5-15
e | *  Creatingalist .........cceeeeeeeeennennn, 5-17

*  Inserting atextfile ...................... 5-20

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 5-1



Because originally HTML is a text-based language for the Internet, entering text is the
basic technique for editing a Web page.

@ Related HTML tags

<P></P>
<BR>

(¢)Tip

To delete the preceding
character, press the Back-
space key. To delete the
next character, press the
Delete key.
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Entering text

@ Click where you want to start entering text, to
position the cursor there.

Floral Arrangements
|

@ Enter text using the keyboard.

Floral Arrangements

At ABC Flotist, we are proud of our customer service and the quality of our
products. Our top-selling floral atrangements arel

Making a line break

Press the Enter key to make a line break. Aline break is
indicated by d .

(o) Tip
To hide the d marks, select Options from the Tool menu to

display the Options dialog box. Then click the Appearance
tab, and clear the Show Newlines check box.

To make a new paragraph (rather than a line break) when
you press the Enter key, select the Create a Paragraph by
Pressing the Enter Key check box on the General panel of
the Option dialog box.



OUI—

The @ button in the upper
left of the Special Charac-
ters dialog box is for
nonbreaking space. Using
the Space key on the key-
board, you can enter only
one space. However, by
clicking this nonbreaking
space button multiple times,
you can enter more than
one space.

Entering special characters

To enter special characters that are not on your key-

board, such as a trademark and copyright symbols:

@ Position the cursor on the location where you want

to insert a special character.

@ Select Special Characters from the Insert menu to
display the following dialog box:

Special Characters

£

=3

e

- | ®

ol o|--

o | | | | [

S I O =2 Pl L 22

ele o | | |es | || 1 |-

v o | | o | 5 | -
el TN 2N I = = P
ot (o | o | % | i | =

e e e et o e | |2 |-

€l Click the character to insert it.

el

Floral Arrangements

At ABC Floist, we are proud of our customer service and the quality of our
products. Out top-selling floral arrangements are

Chapter 5. Editing text
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Inserting the date and time

To insert today's date and time:

Position the cursor on the location where you want
to insert the date and time.

@ Select Date and Time from the Insert menu to
display the following dialog box:

Date and Time

Monday, January 04, 1933

tonday, January 04, 1933 12:43:53 PM

€@ Select the formats for date and time, and click the
OK button to insert the date and time.

Floral Arrangements
Monday, Tatmaty 04, 1099 12:49:53 PMI

At ABC Florist, we are prowd of our customer service and the gquality of our
products. Our top-selling floral arrangements are:




This section explains how to select text (a character string) and change its size, color,

or face. It also explains how to make the text bold, italic, or underlined.

@ Related HTML tags

<FONT SIZE= COLOR=
FACE=></FONT>

<B></B>
<|></I>
<U></U>

fo)Tip

To select the target text with
the keyboard, rather than
the mouse, press and hold
the Shift key and press one
of arrow keys.

Selecting the target text

To select the target text, drag it.

Floral Arrangements

A N=ORalaletyl e ate proud of our customer service and the quality of our
products. Our top-selling floral arrangements are:

Changing the text size

To change the text size:
@ Select the target text.

@ Click theﬂicon to enlarge the text, or click the
ﬂ icon to reduce it.

Floral Arrangements

FAFNTORALSSE vwe are proud of our customer service and the quality of our
products. Our top-selling floral arrangements are

Chapter 5. Editing text
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fo)Tie

If the color you want to use
is not available, click the
Others button to select a
color.

fo)Tie

To change the color of text,
you can also use the color
pallet. After selecting the
target text, click the =i icon
to display the color pallet,
and double-click any color
on the pallet.
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Changing the text color or face

To change the text color or face:
Select the target text.
@ Click the n icon to display the following dialog

box.

Fonts Attributes

€ To change the color of the text, click the

icon to the right of Color, and then click any color

from the pull-down menu.




(1)Note

The selectable fonts vary,
depending on the computer
you are using.

(1)Note ]

If the font specified here is
not available when some-
one views your Web site
with his or her computer, a
substitute font is used.

(¢)Tip ]

To undo the preceding op-
eration, select the same
text again and click the
same button. The text re-
turns to its original state.

@ To change the face, select a font name in Face.

Fonts Attributes | X|
Size: Iﬁ
Calar: - IW
e Lucida Cansol -
ucida Console -
_|pzhorm ke |
—_  \Courier New

Times Mew Roman
Arial Black
Comic Sans M5

Impact i

@ Click the OK button to make the changes effective.

Making text bold, italic, or underlined

To make text bold, italic, or underlined:

@ Select the target text.

@ Click any of the following three buttons.

( Button Explanation

Example

ﬂ Makes the text bold.

Floral Arrangements

ﬂ Makes the text italic.

Floral Arrangements

g Underlines the text.

Floval Arranzetments
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By default, the entered text is aligned to the left. You can change this default, how-
ever, and align any paragraph to the right or center.

@ Related HTML tags

<P ALIGN=></P>

TopPage User’s Guide

Position the cursor on the target paragraph.

@ Click the % icon to center the paragraph, or the
% icon to align it to the right.

Flower Basket«

Five sizes available. o

$10,$15, $20, $25, $30 plus delivery charged
Order Code: F1

Flower Basketd
Five sizes available o

$10, $15, $20, $235, $30 plus delivery charged
Order Code: F1

Flower Basket«

Five sizes available o

$10, $13, $20, $25, 930 plus delivery charged
Order Code: F1

The original text is aligned to the left, like the first
paragraph. You can realign it to the center, like the
second paragraph, or to the right, like the third
paragraph.



You can delete, move, or copy text just as you do with other word processors or text

editors for Windows.

OUI—

To delete a blank para-
graph, press the Back-
space key.

(¢ Tip ]

If you cut the text in this
way, the text is temporarily
saved in the clipboard.

o) Tip
What is the clipboard?

The clipboard is where the
content that has been "cut"
or "copied" is temporarily
saved. Because almost ev-
ery Windows application
has the "cut," "copy," and
"paste" functions, you can
copy text from other word
processors or text editors
and paste it to TopPage.

The next time you cut or
copy text, the content in the
clipboard is replaced with
the new content.

Deleting text

To delete unnecessary text:

@ Select the target text.

@ Click theﬂicon. Or press the Delete key to

delete the text.

Moving text

To move text, cut and paste it.

@ Select the target text.

@ Click the ¢  icon to cut the text.

€@ Position the cursor on the location where you want

to insert the text.

@ Click the E icon to insert the text at the cursor

location.

Chapter 5. Editing text
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(¢)Tip

You can undo the previous
operations.

If you made a mistake, click

the icon. This cancels
the immediately preceding
operation.

You can undo up to 10 pre-
vious operations. To redo
the operation, click the
icon.
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Copying text
To copy text to the clipboard and paste it into another
location:
@ Select the target text.
@ Click the icon to copy the text to the clipboard.

€@ Position the cursor on the location where you want
to insert the text.

@ Click the H icon to insert the text in the cursor
location.



To find specific text in the Web page you are currently editing or in all the Web pages

within the site:

OUI—

To distinguish between up-
per and lower case, select
the Match Case check box.
To search text preceding
the cursor position, select
the Find Backward check
box.

@ Select Find from the Edit menu to display the Find
dialog box.

@ Select the range to be searched from the Search
Scope list box. (If you want to search text in the
Web page you are editing, select In Page. Or if you
want to search text in all the Web pages within a
site, select the site name.)

€&l Enter the text to be searched in the Find What

field.

The following figure is the entry example when
searching for text in the Web page you are editing:

Search Scope: Iln Page -
Find What: ~ [ioral | Clase |

I™ Match Case
™ Find Backward

The following figure is the entry example when
searching for text in all the Web pages within a site:

Find x|
Search Scope: | My Site -
Find What: [fioral =l Close

I~ Match Case
™ Find Backward
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(¢)Tip

To replace the text with dif-
ferent text, select Replace
from the Edit menu.

5-12
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@ Click the Find Next button. If you selected In
Page, the searched text is highlighted. If you
selected a site name, a list of the names of HTML
files that contain the searched text is displayed on
the Find Result dialog box. Double-click an HTML
file name to open the Web page and search again
within that page.

The following figure is an example of search results,
when In Page has been selected:

The following figure is an example of search results,
when a site name has been selected:

C:\mysitesub3 him
Coimysitetindzs bim
Cimysitetsubl him




Inserting a heading

You can add headings to help those who visit your Web site for the first time find their
target content easily. This section explains how to insert headings, which are actually
a type of paragraph, and how to change the type of a paragraph.

OLEEETAINEESS | | Types of paragraphs

<P></p> When you enter text into the editor of TopPage, a paragraph
<H1></H1> of Normal type is automatically created. You can change
<H2></H2> the paragraph into a heading or other type of paragraph.
<H3></H3> The following types of paragraphs are available.

<H4></H4> p N
<H5></H5> p;ﬁ%ﬁ;;&s Explanation Display example
<H6></H6> Normal This is the normal £ ABC Florist, we ars proud of our

parag raph. If nothing is customner service and the quality of our

<ADDRESS></ADDRESS> Specified, thIS type Of Z;:.ducts Our top-selling floral arrangetments
<BLOCKQUOTE></BLOCKQUOTE> paragraph is created.
<PRE></PRE> Heading There are six levels of Floral Arrangements

headings: Heading 1 to
Heading 6 . Heading 1 is
the highest level, and
heading 6 is the lowest.
On a Web browser,
heading text is often
displayed in bold font and
its size typically becomes
bigger as the heading level
increases.

Address This is a paragraph for MNew Fark, 10504, TL5A
entering addresses. On a

Web browser, the text is
often displayed in italics.

Block quote Thisis a paragraph for At ABC Flerist, we are proud of
entel’ing quOted State- our customer service and the
ments. On a Web quality of our products. Our top-

. ing foral —
browser, the paragraph is seling florel axsangements are

often indented.

Text in this format is
displayed with fixed-space
fonts. Youcantypetwoor || . | o | i« | o |
more continuous spaces " "
just as you can when you
are working with Notepad,
one of the Windows
accessory tools.

Preformatted | 123 | 456 | 789 | 123 |
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fo)Tip

To insert another type of
paragraph, select
Paragraph and then any
paragraph name from the
Insert menu.

fo)Tip

You can select another type
of paragraph, such as
Address or Block Quote ,
from the list box.
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Inserting a heading

To add a new heading:

@ Click where you want to insert a heading. Select
Paragraph and then Heading 1 from the Insert
menu to create a blank paragraph for entering the

heading text.

T - K
1 Ste Tool Window Heb =8|

IEEREE &% (o]
S|EEE|B I/ U|ArA|EEEREL[BE]

@ Enter the heading text.

ne Sie Too Window Hep. =18l x|
IEEE == a5
=EEE|BIuls o |BEDHELBE]

Floral Arrangements ‘

Making any type of paragraph into a heading

Click the target paragraph and select a heading level
(Heading 1 to Heading 6 ) from the list box on the upper
left of the main window. The paragraph becomes the
selected type of heading.

Headinig 1 'I

Mormal

Heading 2
Heading 3
Heading 4
Heading 5
Heading &
Address
Block Quote
Preformatted




Horizontal rules are frequently used for delimiting text.

@ Related HTML tags

<HR>

fo)Tie

To delete a horizontal rule,
click it and press the Delete
key. Or click it using the
right mouse button, and
select Delete from the
displayed pop-up menu.

Inserting a horizontal rule

@ Position the cursor on the location where you want
to insert a horizontal rule.

@ Click the = icon to insert the horizontal rule.

At ABC Florist, we are proud of our customer service and the gquality of our products.
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(¢ Tip ]

If you want to change some
attributes for practice, do
the following:

« Select Center as
Alignment .

o Select 85 % as Width .
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Changing attributes of a horizontal rule

You can change the attributes of a horizontal rule, such
as its boldness and width as follows:

@ Click the horizontal rule using the right mouse
button, and select Attributes from the pop-up menu
to display the Attribute dialog box.

@ Change any item.

Attribute x|

Harizortal Rule

€l Click the OK button to change the appearance of
the horizontal rule.

At ABC Florist, we are proud of our customer service and the quality of our products




Lengthy text is difficult to read. Use lists for easy-to-read and good-looking text.

@ Related HTML tags Types of lists
<UL><LI></UL> p N
<OL><LI></OL> List type Explanation Display example
Bulleted | A bullet precedes e Floral Arrangements
list each list item. o Flower Basket
o One Dozen Tulips
o Additonal Services
o Potted green plants
o Fruit baskets
Ordered | A number (1, 2, 3, 1. Fleral Arrangements
S R TEETT 1. Flower Baslet
list 1, i, iii, and so op.) 2 One Dozen Tulips
precedes each list | o sdditional Services
item. 1. Potted green plants
2. Fruit baskets
Definition | Each item is Floral Amrangements
) ) Flower Baslet, One Dozen Tulips
list followed by its Additional Services
def|n|t|on Fotted green plants, Frutt baskets

Chapter 5. Editing text
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(¢ Tips ]

To indent (nest) a list item
after entering multiple list
items, position the cursor
on the list item you want to
indent and click the £ |icon.
You can indent items by
one level only. You cannot
indent the first item in the
list.

To remove an indentation,
click the &/ icon.

(¢ Tips ]

To divide a list into two lists,
position the cursor where
the list is to be divided and
press the Enter key twice.

To join two contiguous lists,
press the Delete key
between them.

TopPage User’s Guide

Bulleted list

Create a field for each list item of the bulleted list, and
then enter any text in it, as follows:

@ Click the = icon to create a field for a list item.

Additional Servicess

@ Type the text for the first item. To go to the next
item, press the Enter key. To make a line break,
press and hold the Shift key and then press the
Enter key.

Additional Servicesa

o Fruit basketd]

Ordered list

Create a field for each list item of the ordered list, and
then enter any text in it, as follows:

@ Click the J icon to create a field for a list item.

Additional Servicesa

i




@ @ Type the text for the first item. To go to the next

item, press the Enter key. To make a line break,

To change an item number, press and hold the Shift key and then press the
click the target item using Enter key.

the right mouse button, click

the Attributes menu, click Additional Servicesa

the Item tab, and type a

new number for the item in L. Fruit basketd

the Number field.

Definition list

A definition list is a list of items with their definitions.

@ Select List and then Definition List from the Insert
menu to create a field for a list item.

Additional Services«

@ Type the text for the first item, and press the Enter
key to create a field for the definition.

Additional Servicesa

Fruit haskets

€@ Type the text for the definition of the first item. To
go to the next item, press the Enter key. To make a
line break, press and hold the Shift key and then
press the Enter key.

Additional Servicesa

Fruit baskets
oranges, apples, pears, grapefruit, bananas and other fruits of the seasnnl
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Inserting a text file

To insert a text file (*.txt) at the location where you positioned the cursor:

@ @ Select File from the Insert menu to display the

_ _ Open dialog box.
To insert an HTML file

(*-htm or *.html) instead of a @ Select Text files from the Files of type list box,
text file, select HTML files specify the name of the target text file, and click the

from the Files of type list . . . .
% I 7 (€ elsle e Open button to display the following dialog box:

and select Insert an HTML InsertiGik
Document or Insert an  Specify How ta Insert File
HTML Document with ¢ Create One Prefomatted Text Black
Related Files in the Insert
File dlalog box. € Divide the Text into Mormal Paragraphs
" Convert Comma Separated Data to a Table
TO insert a CSV flle (*'CSV) " Convert Tab Separated Data to a Table
as a table, select CSV files B s T B

from the Files of type list
box in the Open dialog box,
and select Convert

1 gt at WML Decurientwith H elated Files

Comma Separated Data | EEl b |
to a Table in the Insert File
dialog box. €@ To insert the content of the text file at the cursor

position, select one of the following insertion
methods, and click the OK button. (Normally, select
Preserve Line Breaks or Divide the Text into
Normal Paragraphs .)

« Create One Preformatted Text Block , making
one paragraph of preformatted text.

« Preserve Line Breaks , leaving the line breaks
in the text file.

» Divide the Text into Normal Paragraphs ,
eliminating line breaks and creating a new
paragraph at a blank line of the inserted text.
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Chapter

6

Creating tables

An attractive layout is possible through the skillful use of
tables. Naturally, you can use tables to arrange data. In Web

pages, you can also use tables to lay out images and text in
absolute positions.

Before doing the tasks in this chapter

1. Start TopPage.

“Starting and ending TopPage” on page 2-7

2. Open a Web page to be edited.
“Opening a site and a Web page” on page 4-11

J

EEoEasm B — %%k Creatingatable............ooooviiian.n. 6-2

SRR B *  Changing the size and position of a table........ 6-6
Floral Arrangements

P ot ol *  Changing the table attributes.............. 6-8

Basket
avaiable
$:

*  Changing the cell attributes ............. 6-12

E e:

Ny |One Dozen Tulips

A |Arrangement in a vase.
815 plus delivery charge
|Order Code: F2

ansy pots

Thre
;510 plus delivery charge
Code: F3

|Order

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***.
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You can create a new table, even using spreadsheet software to manage the data.
You can add or delete columns and rows later.

@ Related HTML tags

<TABLE></TABLE>
<TR></TR>
<TD></TD>

(¢)Tip ]

To delete an unnecessary
table, click the table using
the right mouse button, and
select Delete Table .

OUIEE——

Another way to create a
table is dragging the ﬂ
icon downward diagonally
to the right. Atable array
appears, as shown in the
following figure:

The small squares indicate
cells. After dragging to
adjust the number of cells,
release the mouse button to
create a blank table with
the specified array.
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Creating a table

To create a blank table and fill it with text:

@ Position the cursor at the location where you want
to create a table, and click the % icon to display
the Insert Table dialog box.

@ Enter the number of rows in the Rows field and the
number of columns in the Columns field:

Insert Table X|

Columrs: |2 _Ij I’E

Cancel
Bows: 2 _Ij Iﬁ —I
Help

€@l Click the OK button to create a blank table:

§

@1 Position the cursor in a cell and type the data for
that cell. Move to the next cell and type its data,
and so on:

Five sizes avallable d

$10, $15, $20, $25, $30 plus delivery charged
Order Code: F1

‘ One Dozen Tulipsd

’7 Flower Baskets

Arrangement in a vase.d
$15 plus delivery charged
Ozrder Code: F2|

e



Creating a table by inserting spreadsheet data

@‘I_ You can insert a spreadsheet file or spreadsheet data

created by a spreadsheet application into TopPage in
When you create a table one of the following ways. The spreadsheet file must be
from CSV format data, cells in either the CSV (comma-separated values) format or

that include numerals only the tab-separated format
are automatically aligned to '

the right, whereas other e After selecting the data in the editor of a
cells are aligned to the lett. spreadsheet application, drag and drop the
selected data into the editor of TopPage.

or:

e Copy the data in the editor of a spreadsheet
application and paste it into the editor of TopPage
by clicking the target position using the right mouse
button and then clicking Paste.

or:

e |If there is a spreadsheet file in the CSV format or
tab-separated format, select File from the Insert
menu, open the file using the displayed dialog box,
and select Convert Comma Separated Data to a
Table or Convert Tab Separated Data to a Table
on the displayed Insert File dialog box.
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fo)Tip

You can add a column or
row to the top, bottom, left,
or right of the clicked cell.

(¢)Tip

You can also add a column
to the right of the selected
cell by clicking the & icon.
You can also add a row
under the selected cell by
clicking the & icon.

(¢ Tip ]

To add multiple rows or
columns at a time, select
Specify and Add from the
pop-up menu, enter the
number of rows or columns
to be added in the dialog
box, and then click either
the Above , Below, Left, or
Right button.

TopPage User’s Guide

Adding a column or row

To add a column or row to the table:

Click a cell.

Flower Basketd
Five sizes available o
$10, $13, $20, $25, 530 plus delivery charged
Order Code: F1

One Dozen Tulips«
5 |Amrangement in a vase.d

$15 plus delivery charged
Order Code: F2 -

Three pansy potsd
L0 plus delivery charged
Order Code: F3

@ To add a column, press the % icon on the Table
toolbar for 2 or more seconds. To add a row, press
the @ icon for 2 or more seconds until the following
pop-up menu appears:

el lE=R NN
Inzert Above the Cel

Inzert Below the Cell
Specify and Add...

€@ To add a column or row, select any menu except
Specify and Add .

Flower Basketd
Five sizes available.d
$10, 515, 20, 525, $30 plus delivery charged
Order Code:F1

One Dozen Tulipsd
o fittangement in a vase.d

$15 plus delivery charged
Order Code: F2|




PI)Note

When a column or row is
deleted, the content of the
cells is also erased. To
avoid erasing the content of
the cells, select Option
from the Tool menu and
clear the Delete the Table
and the Contents check
box on the General tab of
the Option dialog box.
Then when you delete a
column or row, its content
moves to the preceding
column or row.

Deleting a row or column

To delete an unnecessary column or row:

@ Click any cell that the unnecessary column or row
includes.

@ Click the icon to delete the column. Click the
&l icon to delete the row.
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You can specify the table size either in pixels or in percentage. You can also place
the table in the center of the screen for a symmetrical layout.

@ Related HTML tags

<TABLE WIDTH= HEIGHT= >
<CENTER></CENTER>

@ Vocabulary

pixel

A small square colored dot
that is frequently used as a
unit defining the display
resolution or the image
size. In HTML, a pixel is a
unit defining the size of
each element.

fo)Tip

To change the size of a
certain cell, click the target
cell and drag one of the
eight black square marks
on its perimeter.
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Specifying the table size in pixels

To specifying the table size in pixels, just drag the table.

@ Click outside the table border to select the entire
table.

Flower Basketd
Five sizes available. o

$10, 515, $20, $25, 530 plus delivery charged
Order Code: F1

One Dozen Tulipsd
"3 |Atrangement in & vase. m
$13 phas delivery charges
Order Code: F2

Three pansy pots+
$10 phas delivery charges
Order Code: F3

I

@ Drag one of the eight black square marks on the
perimeter of the table to change the table size.
When you release the mouse button, the new size
is defined.

[Flower Basketd

Five sizes available o
$10, $135, $20, $235, $30
iplus delivery charged
(Order Code: F1

One Dozen
Tulips«
\Atrangement in a vase.d"
$15 plus delivery
charged

Order Code: F2

3

‘Three pansy pots+
3 (310 plus delivery
charged

(Order Code: F3




Specifying the table size in percentages

If you do not want to define the absolute table size--for
example, because you want to change the table size
according to the screen size of a Web browser--specify
the size in percentages (%).

@ Click the table using the right mouse button and
select Attributes from the pop-up menu to display
the Attribute dialog box.

@ Click the Table tab.

€@ Type a percentage (0 to 100) in the left box of Table
Width , then select % in the right box.

@ Click the OK button to change the table size.

Placing a table in the center

To place the table in the center of the screen for a
symmetrical layout:

@ Click outside the table border to select the entire
table.

@ Click the % icon to place the table in the center.

Flower Basketd
Five sizes available o
$10, $15, $20, $25, $30

plus delivery charged
Order Code: F1

One Dozen
Tulipsd

" 2 |Artangement in avase.d’
$15 plus delivery
charged

Order Code: F2

Three pansy pots+
510 plus delivery
charged

Order Code: F3

5
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After creating a table, you can change its appearance by changing the attributes of
the entire table. For example, you can:

Add color to the table.

Hide the table borders.

Add a title to the table.

Increase the cell padding.

Paste wallpaper into the background of the table.

@ @ Click the target table using the right mouse button,

and select Attributes from the pop-up menu to

<TABLE CELLPADDING= display the Attribute dialog box.

BORDER= BGCOLOR=

BACKGROUND= > @ Click the Table tab. Using the Table panel dis-

<CAPTION ALIGN= > played, you can change an attribute for the entire
table.

TopPage User’s Guide



O Increasing the cell padding

Specify the size of the white space between borders and
content in Cell Padding . If nothing is specified, the
default is 1. (The following figure is an example of the

changed appearance.)

Flower Basketd
1 Five sizes available o

Order Code: Fl

$10, $135, $20, $25, $30 plus delivery charged

One Dozen Tulipsd
2 Atrangement it a vase o

$15 plus delivery charged
Order Code: F2

Three pansy pots«
3 | $10plus delivery charged
Order Code: F3

(@ Hiding the table borders

If you use a table for layout, you might want to hide its
borders. To do so, clear the Show Border check box.
Though borders become dotted lines in the editor of
TopPage, they are hidden in the screen of Web
browsers. (The following figure is an example of the

changed appearance.)

___________________________

:: ::Flowcr Basket+
1) Five sizes available d

rsI0, $15, $20, $25, $30 plus delivery cha.rgeﬂ

" ! Order Code: F1

___________________________

\110ne Dozen Tulips 4

Y
Vi datrangement in a vage.d

e 1815 plus delivery charged
-' IOrder Code: F2

Ir| -------------------------

" 1 Three pansy pots+

.3 1610 plus delivery charged
N 'Order Code: F3

Chapter 6. Creating tables
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@ Adding a title to a table

To add a title to a table, select Top of the Table or
Bottom of the Table in the Attribute dialog box. After
clicking the OK button, enter any title in the blank field
displayed. (The following figure is an example of the
changed appearance.)

Five sizes avalable o
$10, $15, $20, $23, $30 plus delivery charge

Flower Basket«
Order Code: F1

(@ Adding color to a table

To add color to the entire table, click the colored button to
the right of Color in the Attribute dialog box and select
any color from the pop-up menu displayed. (The
following figure is an example of the changed
appearance.)

Flower Basketd
Five sizes available o
$10, $15, $20, $25, $30 plus delivery charged
Order Code: F1

One Dozen Tulipsd

Atrangement it a vase. o
$15 plus delivery charged
Order Code: F2

[

Three pansy potsd
$10 plus delivery charged
Osder Code: F3

[




fo)Tie

Sample wallpapers exist in
the \Program Files\IBM
NetObject TopPage\Sample
\image\wallppr\ folder.

@ Pasting wallpaper into the background of a table

Click the Browse button in the Attribute dialog box to
select and paste a wallpaper image as the background
for the table. (The following figure is an example of the
changed appearance.)

Flower Basketd

Five sizes available o

$10, $15, $20, $25, $30 plus delivery charged
Order Code: F1

One Dozen Tulipsd

Arrangement it a vase. o

$15 plus delivery charged
Order Code: F2

Three pansy pots4d
$10 plus delivery charged
Order Code: F3

[

€@ Click the OK button to make the changes take
effect.

Chapter 6. Creating tables

6-11



After creating a table, you can change its appearance by changing the attributes of
individual cells. For example, you can:

e Change a data cell into a header cell.

e Align text in a cell to the right.

e Merge cells horizontally or vertically.

e Add color to a cell.
If you want to change the attributes of multiple cells at a time, select multiple cells
before the following operation.

@ @ Click the target cell using the right mouse button

and select Attributes from the pop-up menu to

<TD ALIGN=COLSPAN= display the Attribute dialog box.
ROWSPAN=BGCOLOR=> ) ) _
TH<rTh> @ Click the Cell tab. Using the Cell panel displayed,

you can change the attribute for the selected cell.
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OUI—

You can also join cells
horizontally by clicking the
left cell to be joined, and
then clicking the | icon.

@ Changing a data cell into a header cell

There are two types of cells: data cells and header cells.
Cells are ordinarily data cells. Header cells are typically

bold and displayed in the center. Select Header Cell to

change a data cell to a header cell. (The following figure
is an example of the changed appearance.)

_}
Floral Aﬂangements“

Flower
1 Five sizes
$10, $15, %
Order Ct

One D¢

@ Aligning text in a cell to the right

If you want to align text (usually numbers) to the right,

select Right from the Horizontal Alignment  box. (The

following figure is an example of the changed ﬂ
appearance.)

Floral Arrangements

Flower
o | Wive sizes
$10, 15,4
Order Ct

One D¢

@ Joining cells horizontally

To join cells horizontally, type 2 or a higher number (for
the number of cells to be joined) in Columns under Join
Cells in the Attribute dialog box for the cells to be joined
in a rightward direction from the selected cell. To cancel
the joining, delete the number in Columns . (The follow-
ing figure is an example of the changed appearance.)

=
Floral Arrangements| |

Flower Basketd

Five sizes available d

$10, $15, $20, $25, §30 plus delivery charge d
Order Code: F1

One Dozen Tulipsd
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O U

You can also join cells
vertically by clicking the top
cell to be joined, and then
clicking the 2| icon.

O U

Another way to change the
cell color is to select a cell
or cells, click the &l icon to
display the color pallet, and
then double-click on any
color on the pallet.

O

To change the attributes for
the entire row that include
the selected cell, click the
Row tab and specify each
item.

TopPage User’s Guide

@ Joining cells vertically

To join cells vertically, type 2 or a higher number (for the
number of cells to be joined) in Rows under Join Cells

in the Attribute dialog box for the cells to be joined in a
downward direction from the selected cell. To cancel the
joining, delete the number in Rows. (The following figure
is an example of the changed appearance.)

Floral Arrangements

Flower Basketd

Five sizes available o

$10, $15, $20, $25, $30 plus delivery charged
Order Code: F1

One Dozen Tulipsd

w123 M prangement in a vase.d
$15 plus delivery charged
Order Code: F2

Three pansy potsd
$10 plus delivery charged
Order Code: F3

3 Adding color to a cell

To add color to the selected cell, click the colored button
to the right of Color in the Attribute dialog box, and
select any color from the pop-up menu displayed. (The
following figure is an example of the changed
appearance.)

=
Floral Arrangements |

Flower Basketd

1 [Fiwe sizes available.d

$10, 135, $20, $25, $30 plus delivery charged
Order Code: F1

QOne Dozen Tulipsd

€@ Select the Apply to the Entire Column  check box
to change the attributes to all the cells in the same
column.

@ Click the OK button to make the changes take
effect.



] ] Chapter
Inserting 1mages 7

For your Web pages, you will use image files in the JPEG or
GIF format. The JPEG format image permits the use of colors
more than the GIF format image, so it is suitable for
photographic data.

This chapter explains how to insert images into a Web page,
how to change the image attributes, how to edit an image, and
S0 on.

Before doing the tasks in this chapter

1. Start TopPage.
“Starting and ending TopPage” on page 2-7

2. Open a Web page to be edited.
“Opening a site and a Web page” on page 4-11

J

*xx Inserting an image .......cocveveveieneienennnnns 7-2
*  Changing the size of the displayed image ... 7-6
*%* Deleting, moving, or copying an image ..... 7-7

CRIBL AL RIBLRARL RIS
Floral Arrangements

At ABC Florist, we are proud of our customer service and the
‘qality of our products. Our top-seling floral arangements are.

L iy rre— *  Laying out text around an image............... 7-9
N/ |One Dozen Tulips . - -

f e, **  Adding an explanation to an image ........ 7-13
@ R *  Editingan image ........cccccceeeevneeennnnnn. 7-15
[

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 7-1



The insertion of an image is the first step in handling images in TopPage.

@ Related HTML tags

<IMG SRC= >

(¢ Tip ]

You can insert an image file
of a format other than GIF
or JPEG into the edit field
of TopPage. The file is au-
tomatically converted to the
GIF or JPEG format image
file.

Appendix C, “Image file
formats”

(1)Note ]
When the Eg mark
appears

This mark appears if an
image is not inserted cor-
rectly. Check the file name
or folder.

O U

While you are dragging the
image on the edit field, the
cursor that indicates the
inserting point is displayed.
When you drop an image, it
is inserted at the cursor
position.
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Inserting an image with a drag-and-drop operation

You can view all the images

in a certain folder to select

the target image before inserting it with a drag-and-drop

operation.

@ Click the Contents tab to open the Contents pane.

@ Select the target folder in the upper side of the
Contents pane to view the image files in it.

£ Resl |

|

AN
AY

Hlask_i3git Hask_rl g =

i
@

flask_tpit flowr_i1 git

| Fie s
BODY Uniiled

To select materials attached to
TopPage quickly, select Image in the
top box of the Contents pane.

€@ Click the target image, drag it, and drop it into the
Normal pane of the Web page you are editing.
The image is inserted into the position where it was

dropped.

Floral Arrangements

Flower Basketd
Five sizes available. d

charged
Order Code: F1

10, $15,$20, $25, $30 plus delivery

One Dozen Tulips+




Inserting an image by specifying a file name

If you know the file name of the target image, this method
might be easier.

Position the cursor at the location where you want
to insert an image.

@ Click the al| icon to display the Open dialog box.

€l Select the target image file, and click the Open
button to insert the image.

flowr_il. gif
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(¢)Tip

Paintis one of Windows ac-
cessory tools that
handles images. To start
Paint, click the Start menu
of Windows, Program ,
Accessories , and then
Paint. To select the whole
image displayed on the
editor of Paint, select
Select All from the Edit
menu. (In addition to this
method, there are other
methods for selecting an
image or the part of an
image.)

fo)Tip

Images pasted through the
clipboard are automatically
converted into the GIF or
JPEG format.
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Inserting an image through the clipboard

You can paste an image onto the cursor position by
copying image data from another application into the
clipboard and then selecting Paste from the Edit menu of
TopPage. The following example describes how to paste
data from Paint onto the TopPage edit field.

@ Display an image on Paint, select the part of an
image you want to copy, and then select Copy from
the Edit menu to copy the image into the clipboard.

(]

opies o 2

@ Select Paste from the Edit menu of TopPage to
paste the image onto the Web page you are editing.



(1)Note

Before doing this task,
check that the TWAIN
driver is correctly installed
and you connected the
TWAIN device to the
computer.

You should read the guide
included with the TWAIN
device for information on
the operation of the TWAIN
driver.

O U

Images imported from a
TWAIN device are
automatically converted into
the GIF or JPEG format.

If you have a TWAIN 32-bit compatible digital camera or

Importing an image from a TWAIN device

scanner, you can import images directly.

a

Position the cursor at the location where you want

to insert an image.

Click the | icon to display the Open dialog box.

Click the Cancel button to close the Open dialog
box and to display the Image dialog box.

Select Open from a TWAIN Compliant Device

and click the OK button to display the dialog box for

selecting a TWAIN device.

Select the name of your TWAIN device (or the
name of its TWAIN driver you have installed), and

click the Open Image button to display the window

for the TWAIN driver.

Using the function of the TWAIN driver, import the
target image. When the importing is complete, a

dialog box for specifying the file name is displayed.

Specify a file name and click the Save button to
insert the image at the cursor position.

Chapter 7. Inserting images
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After inserting an image, you can change its displayed size.

(1)Note

This task changes only the
appearance of the image; it
does not change the actual
image size.

“Editing an image” on
page 7-15

@ Related HTML tags

<IMG SRC= WIDTH= HEIGHT= >

Pl Note

If you drag one of the black
square marks in the four
corners, the vertical-
horizontal ratio of the image
does not change. However,
if you drag one of the black
square marks not on the
corners, the ratio changes.

OUIE——

To return the image to its
original size, click it using
the right mouse button,
select Attributes from the
pop-up menu to display the
Attribute dialog box, click
the Set Size button, and
click the OK button.

To clear the specification of
the image size, click Clear
in the Attribute dialog box.
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Click anywhere on the target image to select it.

Floral Arrangements

Flower Basketd
Five sizes available o
510, $15, $20, $25, $30 pl
charged

Order Code: F1

| [Mna Taran Taline

@ Drag one of eight black square marks around the
image to change its displayed size. When you
release the mouse button, the size is determined.

- Floral Arrangements

Flower Basketd
Five sizes available o
410, $15, $20, $25, $304
delivery charged
Order Code: F1

One Dozen Toho




This section explains how to delete an unnecessary image, how to move an image to
another position, and how to copy an image or to paste the same image repeatedly.

Deleting an image

To delete an unnecessary image, click it using the right
mouse button, and select Delete from the pop-up menu.

Moving an image

To move an image:
@ Click the target image to select it.

@ Click the center (any part other than eight black
square marks) of the image.

€ Drag the image. When you release the mouse
button, the new position is fixed.

Chapter 7. Inserting images
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Copying an image

To copy an image or to paste the same image
repeatedly:

@ Click the target image to select it.

@ Click the center (any part other than eight black
square marks) of the image.

@ Press and hold the Ctrl key and drop the image.
When you release the mouse button to paste the
dragged image, the image is copied in the new
position. Keep holding the Ctrl key and click for
each copy you want.

F10 plus deltvery charged
Order Code: F3




Ordinarily, you can lay out only a single line of text beside an image. However, you
can change this setting and lay out several lines of text beside an image to make it
into a natural layout. Then you should probably increase the spacing of the image to

improve its appearance.

@ Related HTML tags

<IMG SRC= ALIGN= >

Typing text beside an image

When you type text beside an image, you see that only a
single line of text is laid out beside the image. The other
lines are below the image.

é“ For Vour Dream Weddingd

We specialize in wedding services. Our designers and bridal
consultants will make wour special day a beauwtifisl and
metmorable expetience.

Flowing text around an image

To flow text to the left or right of an image:

@ Click the target image using the right mouse button,
and select Attributes from the pop-up menu to
display the Attribute dialog box.
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@ Select the Left or Right check box next to Text,
and click the OK button.

Attribute

If you selected the Left check box, text flows on the
right side of the image.

| For Your Dream Weddingd

B " fife spectalize in wedding services. Our designers and
W pridal consultants will make your special day a heautiful
Bnd memarable experience.

If you selected the Right check box, text flows on
the left side of the image.

For Your Dream Weddings

We specialize in wedding services. Cur designers and
bridal consultants will make wour special day a beautifal
and memorable expetience.
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You can also flow text be-
tween two images. In this
case, to end text flow in the
middle of the text, select
Move Vertically Down

Until Both Margins Are
Clear on the Line Break
dialog box.

€@ To end text flow in the middle of the text, press and
hold the Ctrl key and press the Enter key at the
point where you want to end the flow.

@ If you selected the Left check box, select Move
Vertically Down to a Clear Left Margin  on the
Line Break dialog box. If you selected the Right
check box, select Move Vertically Down to a
Clear Right Margin .

Line Break

@ Press the OK button. The text flow ends at the
point you specified.

&F ot Your Dream Weddingd
L

dJ

We specialize in wedding services. Our designers and bridal
consultants will makce wour special day a beautiful and memorable
expetience.
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Increasing space around an image

Adding the suitable space around the image gives it a
neat appearance.

@ Click the target image using the right mouse button
and select Attributes from the pop-up menu to
display the Attribute dialog box.

@ Type the number of pixels in the fields beside
Horizontal and Vertical of Spacing . (Horizontal
means to the left and right of an image and vertical
means to the top and bottom of an image). The
larger the numerical value, the greater the spacing.

€@ Click the OK button to increase the space around
the image.

ot Vout Dream Weddingd
e specialize in wedding
zetvices. Dur designers and bridal
onsultants will make your
epecial day a beautifl and
retnorable expetience.
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Adding an explanation to an image

Inserting images beautifies your Web pages, but the images cannot be displayed by
visitors to your Web site who are not set up to display GIF or JPEG images. An
explanation added to an image enables those who cannot view it to understand its
content. Itis good etiquette to add an explanation to each of your images.

(W) Related HTML tags ] Adding an explanation to each image

<IMG SRC=ALT= > There is no limit to the number of characters you can use

for the explanation, which is called alternate text.

@ @ Click the target image using the right mouse button,

and select Attributes from the pop-up menu to

e display the Attribute dialog box.

needed in instances such

e @ Enter the explanation for the image in Alternate

« If a Web browser that Text and click the OK button. (The appearance of
does not support the the image does not change, but an explanation of

iewing of i i d. . .
wewmg ° .|mages.|s Hse the image is added to the HTML source.)
« If reading images is not

set, to speed up the line.

« If a visually handicapped

person is visiting your site. Checking that explanations are added to all images

To check whether the explanations for all the images
used on the Web page being edited have been entered
correctly:

@ Select URL Editor from the Tool menu to open the
URL Editor, which checks alternate text added to
your images and links.

@ Click the Image button to display all the images
used on the Web page being edited. The alternate
text for each image is displayed in Text. If there is
an image with no alternate text, the message ** No
Alternate Text **" is displayed in Text.

€@ Click an image with no alternate text. The file name
of the image appears in the URL field.

Chapter 7. Inserting images 7-13



(1)Note

Remember to add alternate
text to images with links,
because Web browsers that
do not display images
enable readers to jump
using the alternate text.

To check the alternate text
only for linked images,
select the Linked Image
button instead of the Image
button in the URL Editor.
“Setting a link on an im-
age” on page 8-8
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@ Type the explanation of the image in a field beside
Alternate Text .

URL Editor - C:\My Documents\garden\flows_i3.gif

floral basket
tulips

@ Click the Update button to update the information.
Click the OK button to close the URL Editor.



While editing a Web page, you can resize images and do simple retouching, which is

called editing.

(1)Note ]

If you resize an image
through editing, not only
does the appearance
change, but the actual
image file changes, too.
Therefore, before resizing,
copy the target image file if
necessary.

o) Tip
To create new images, use
WebArt Designer.

Chapter 10, “Creating
materials”

Here editing includes any of the following:
e Converting an image file from GIF to JPEG format,

or from JPEG to GIF

Trimming an image

Rotating an image

Rishlemgithe size of an image file to match it to th-

Adjusting the image quality or reducing the numbe
of color

Making an image display progressively from a lowe
resolution to a higher resolutio
For the GIF format image only, changing one o

colors used in the image into transparency, to blen
the image into the backgroun

For the JPEG format image only, adding specia
effects such as sharpening the image or addin
sepia colo

Click the target image using the right mouse butto
and select Edit Image from the pop-up menu t
display the following dialog box

Chapter 7. Inserting images 7-15




@ Click the Help button to display the online help.

€@ Read the online help and edit the image.
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Chapter

Setting links 3

Using the link function, a visitor to your site can jump to a
specific Web page simply by clicking text or an image with a
link. This chapter explains how to set a link to text or an
image, how to change a link destination, and so on.

Before doing the tasks in this chapter

1. Start TopPage.
“Starting and ending TopPage” on page 2-7
2. Open a Web page to be edited.

“Opening a site and a Web page” on page 4-11
[ J

*** Setting a link on text ............... 8-2
*  Setting a link on an image ........ 8-8
*  Changing a link destination....... 8-9
*  Checking the link status .......... 8-10

ABC Florist

LIRS RIRU IR IR

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 8-1



8-2

There are four types of links according to the link destination. A link might enable you

to jump to:

e Another Web page at your site

e Another place on the same Web page

e Another Web page on the Internet

e A file other than HTML such as an image file, sound file, program file, and so on
This section explains how to set each type of link in the selected text.

@ Related HTML tags

<A HREF= NAME= ></A>

TopPage User’s Guide

Setting a link to another Web page at your site

You can set a link to another page, for example, to jump
from the top page to any of the subpages of your site.

@ Select the text that you want to link from.

Floral Arrangements

@ Click the @ icon to display the Attribute dialog box
for a link.

@ Click the To File tab.

@ Click the Browse button, select an HTML file as the
link destination in the displayed dialog box, and
click the Open button to specify the selected file
name in the File Name box.

Attribute
Tag IL\nk j
TaFiie | To URL | ToLabel| E-Mai | AddLabel| ToUnsaved L4 | ¥
 File Name
Jsubt b
Browse. .
i Tanget
Extended..
oK I Cancel Help




OUI———

To make a Web page dis-
played in the edit field the
link destination, drag the
icon beside the Normal
tab of the destination Web
page and drop it onto an-
other Web page (to include
the link source). The title of
the link destination Web
page is set as the link
source text.

@ Check the specified HTML file name (*.htm or

*.html), and click the OK button to set a link to the

selected text.

Floral Arrangements

Chapter 8. Setting links
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Setting a link to another place on the same
Web page

You can add a label to a specific text on a Web page and
make it the link destination. This method is useful if you
want to place a summary of the Web page at the begin-
ning of the page and then enable a visitor to jump to a
lower part of the page.

@ Select text for the link destination.

The ABC Flotist offers online ordeting of bouguets,
attahgements, baskets, and centerpieces.

Floral Arrangements

@ Click the icon to display the Attribute dialog box
for a link.

€@ Click the Add Label tab, and type a label name.

Attiibute x|

o ———
e als]

l—
—

—




@ Click the OK button to assign the label to the
selected text. A dotted underline is added to the
labeled text.

The ABC Florist offers online ordeting of boucguets,
arrangements, baskets, and centerpieces.

@ Select text for the link source.

[Floral Arrangements

The ABC Florist offers online ordeting of bouguets,
arrangements, baskets, and centerpieces.

@ Click the icon again to display the Attribute
dialog box for a link.

Click the To Label tab, and select the previously
specified label name from the Label list box.

Attiibute

Chapter 8. Setting links 8-5
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O

To set a link to specific text
on another Web page at the
same site, click the Browse
button on the To Label tab,
select the link destination
file, and select the label
name.

TopPage User’s Guide

@ Click the OK button to set a link to the labeled text.

Floral Arrangements

The ABC Florist offers online ordering of bouguets,
atrangements, baskets, and centerpieces.

Setting a link to another Web page on the Internet

Here, the term “Web page on the Internet” means a URL
beginning with “http: ” or “ftp:.”

@ Select text for the link source and click the icon
to display the Attribute dialog box for a link.

@ Click the To URL tab.

€@ Select http: or ftp:, and then enter the target URL.

Attribute

@ Click the OK button to set the link.



Setting a link to a file other than an HTML file

To set a link to a non-HTML file such as an image file, a
sound file, or a program file, type the destination file
name on the To File tab in the same way as described in
“Setting a link to another Web page at your site” on page
8-2. If you set a link to a program file, the program can
be downloaded when the link source is clicked on a Web
browser.

Chapter 8. Setting links 8-7
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The previous “Setting a link on text” section explains how to set a link on text. You
can set a link on an image in the same way. Then a visitor to your Web site can jump
to the link destination by clicking the image.

@ Related HTML tags

<A HREF= NAME= ></A>

TopPage User’s Guide

@ Click the image that you want to link from.

[Floral Arrangernents

@ Click the icon to display the Attribute dialog box
for a link.

Attribute

—

—

—

|| T

€@ Set the link destination as described in the “Setting
a link on text” section on page 8-2.



Changing a link destination

After you have set a link, you can use the URL box on the toolbar to change a link
destination or to cancel the link.

LI Changing a link destination

To change a link destination
using the Attribute dialog
box that you used for set- @ Click the link-source text or image to display the link

ting a new link, click the e
link-source text or image destination in the URL box on the toolbar.

To change a link destination:

using the right mouse but- AL [T e = T 5|

ton, and select Attributes

from the pop-up menu. Se- @ Delete the old link destination and type the new
lect Link from the Tag list one.

box to display the link at-

tributes including a link des- R feeznn ER =

tination.

€@ Press the Enter key to set the new link destination.

LI
The URL box is not only for
changing or canceling link
destinations, but also for
setting new links. To use
the URL box to set a new
link, select the link-source
text or image, and enter the
link destination directly into
the URL box.

Canceling a link

@ To cancel a link, click the link-source text or image using

. the right mouse button, and select Release Link from the
Another way of canceling a

link is to click the link- POp-up menu.
source text or image, and
either clear the URL box on
the toolbar or select Re-
lease Link from the Edit
menu.

Chapter 8. Setting links 8-9



You can use the Link tab of the Site Manager to check that the links for each page
are correctly set. If you find a mistake, you can open the page and correct it.

8-10
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Click the Link tab of the Site Manager. Then in the
upper half of the Link pane, check the hierarchical
link structure with the top page as the apex.

@ Click the target page to display a list of link destina-
tions. The [3 mark indicates that there is a file for
the link destination. The @ mark indicates that
there is no file (the link is incorrectly set), so open
the corresponding page and correct it.

File  iew Site Tool Help

D E| & & Bl | s
[ EEEE R
My Site EE
% My Site:
= @ Top Page[/index. htrm]
B[] subThtm
- [3] sub2 htm
- [3] sub3 htm
Files Linked by index. htm j
URL | Title
@ subl.htm Floral Arrangeme.
@ sub2 htm Wedding Service
@ sub3.htm Order Form
B4 mailte:
j garde_hr.gif Green Flower Stri
j Flowr_il. gif Flowser
j Flowr_i2. gif Flowser
j garde_t.aif Flowers
j Flovur_i3 gif Flower
j garde_ml.gif b ail lcon
j garde_fr.gif Green Flower Stri
j garde_bag.aif [Backaround]
N |
Link File: I Contents
| |




The following marks might be displayed in the Link pane.

] )
Mark Meaning

Indicates a link to an HTML file.

Indicates a link to a frame page.

Indicates a link to a label.

Indicates a label.

Indicates an image.

Indicates a client side image map.

Indicates a link from an image map.

Indicates a link to a page on a Web server.

Indicates a Java applet.

Indicates plug-in object.

Indicates a link containing an e-mail address.

Indicates a link to an FTP server.

Indicates a link to a CGI program.

Indicates a link to a CSS file.

= ¢ F B Eeé e P FE B E BB E

-
.
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DeSigning Web Pal Chapter
using style sheets 9

A style sheet is a very recent technology that is likely to
become essential for Web page creation. You can use it to
design your Web pages.

Before doing the tasks in this chapter

1. Start TopPage.
“Starting and ending TopPage” on page 2-7

*xx What is a style sheet? ...............cceenni.
Style Sheet 1

Style Sheet 2

Style Sheet 3

Style Sheet 4

Style Sheet 5

*  Usingtemplates ......cccooeveviiiiiinnininennn..
*%** Advanced style-sheet techniques

SList-1
SList-2
SList-3

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***.

9-2
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TopPage supports CSS (Cascading Style Sheet), now the standard style sheet. A
style sheet makes it easy for you to change the appearance of your Web pages at will
and to unify the appearance of the entire site. Appendix D, “Cascading style

sheets”

TopPage User’s Guide

Valuable technology for Web designers

Style sheets are useful technology for those who design
Web pages, because style sheets make it possible for
you to achieve elaborate designs like those in magazines
right on your Web pages. See the following two figures.
Though they use the same HTML file, one uses style
sheet and the other does not.

A Web page that does not use style sheet:

TopPage
Style Sheet 1
Style Sheet 2
Style Sheet 3
Style Sheet 4
Style Sheet 5
o List-1

o List-2
o List-3

On this Web page, HTML describes

the document structure as follows:

® Displaying “TopPage” in the
heading paragraph.

® Displaying “Style Sheet 1,” “Style
Sheet 2,” and so on, in other
paragraphs.

® Adding the items “List-1" and “List-
2" in a bulleted list.

A Web page that uses style sheet:

Style Sheet 1

Style Sheet 2

Style Sheet 3

Style Sheet 4

Style Sheet 5

SList-1
SList-2
SList-3

This Web page uses the same HTML

as the preceding page, but is

designed as follows using style

sheets:

® Adding color to the background of
the heading paragraph.

® Specifying the position of each
paragraph with absolute coordi-
nates.

® Using notes as bullets of a list.



Essential technology in the future?

It is still possible to design Web pages in HTML without
the use of style sheets. However, it is likely that in the
future, the HTML tags that control the appearance will be
abolished and that only style sheets will control the
appearance of Web pages. Thus, style sheet technology
is likely to be essential for anyone who creates Web
pages.

The advantages of style sheets are the following:

e Because the document structure which is repre-
sented by HTML and the design which is repre-
sented by a style sheet are separate, you can
change just the document structure or just the
design.

e You can unify the design of the entire site.

You do not have to sacrifice the HTML for the sake
of the design.

The last point is important. Tables are often used for
layout, but because the actual purpose of a table is to
present comparative data precisely and concisely, using
a table for merely a layout design is an inappropriate use
of HTML. The size and thickness of text is also often
changed with the FONT tag when headings should have
been used, which is another inappropriate use of HTML.
With a style sheet, however, you can lay out text, graph-
ics, and images in the positions you prefer without using
tables, and you can freely change the designs of head-
ings. With a style sheet, you can enhance design while
using HTML correctly.

Chapter 9. Designing Web pages using style sheets
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Flow of Web page creation using a style sheet

Despite the promise of style sheets for the future, only a
few Web browsers can currently display them. Be aware
of the following:

e The only compatible Web browsers are Netscape
Navigator 4.0, Microsoft Internet Explorer 3.0, and
their later versions.

e Even using compatible Web browsers, sometimes
you cannot display style sheets correctly.

e The same style sheet might appear differently
depending on the Web browser used.

We thus recommend that you create Web pages that can
be displayed correctly even without the use of a style
sheet, according to the following flow.

Create your Web pages without using a style sheet.
@ Change the appearance using a style sheet.

€@ Check the appearance of your Web pages both on
a style-sheet-compatible Web browser and on a
noncompatible Web browser.



TopPage offers Web page templates that use style sheets. If this is the first time for
you to use a style sheet, it is recommended that you choose a template and adapt it.

New

Page | Frame Appication | Muliple Pages |

@ Select New from the File menu to display the New
dialog box.

Click the Application tab to display the Applica-
tion panel, which contains Web page templates
using the latest technology. Templates whose
names begin with <S> use style sheet technology,
and those whose names begin with <D> use dy-
namic HTML technology.

Select one that begins with <S>, and click the OK
button.

<D>Basketball a
<D Curmy

<0 Dolphin Y orld
<D>Honeybee Garden

<D»0val Racing

<D>Pizza House

<D»Plane

<D>Roll Scieen

<D»Satelite

que
< ogue (Blug]
<5»Catalogue [Pink|
<5>Film Library
<5>Flawer [Green]
«5>Flower [Pink]

<5 Laptop Computer |

Style sheet: You can easily create
thig graphical header, using
"barder attribute of style sheet

Ok I Cancel

Help

Chapter 9. Designing Web pages using style sheets
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The corresponding Web page opens in the editor.

97
SN

< \\I

! Bluw Diamond Ring#l
1 vfulticolor Jade Bracelstel

@ At first glance, you might not be able to clearly
distinguish whether a style is defined in the opened
page. If you wish to confirm, click the HTML
Source tab and look at the description between
<STYLE> and </STYLE> at the top of the HTML
source, which defines the style.

<Nt
LIFONT/TD> -
< | >

& Nommal HTML Source Preview

@ Click the Normal tab again, and edit the Web page,
just as you would any other Web page.




Advanced style-sheet techniques

If you are acquainted with the concepts of HTML tags and style sheets, you can
design your Web pages more freely by using classes and IDs; by embedding styles
directly into each tag; or by using an external style file. This section introduces an
example that use classes to change the color of a paragraph and the color of text in
the paragraph.

@ Vocabulary @ Click the g icon to create a new Web page.

class @ Type any text.
A definition of Web page Use style sheets.
style. You can assign one

class to multiple HTML

tags, so you do not have to €@ Click anywhere on the text using the right mouse

define the same style sev- button, and select Extended Attributes from the

eral Tlmes. _Y0Lt1hcan, for ex- pop-up menu to display the “Extended Attributes”

ample, assign the same :

class both to a table and to dialog box.

2 @ Type “color” in the Class field, and click the Edit (2)
button to display the dialog box for setting the style.

| D Style Definition

A definition of Web page e ——

style. You can embed one [ [

ID to only one HTML tag, so [ e =

you must define the same e Fort Atile

style several times. Be- e L L :

cause you can use classes - S I I

for more general purpose | Iy 104

than IDs, it is recommended { haBlyzz O

that you use classes rather -

than IDs. [ ok | concel | Hep |

LI
You can type any text you
like in the Class field.

Chapter 9. Designing Web pages using style sheets 9-7
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Using the Style Definition
dialog box, you can define
such styles as fonts, lay-
outs, and colors. Define
them as you like.

9-8 TopPage User’s Guide

@ Click the Color and Background

tab and select

the text color from the Color list box and the para-
graph color from the Background Color list box.

@ Click the OK button to return to the Extended

Attributes dialog box.

Click the OK button to change the paragraph and

text colors.

[Jse style sheets
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You can define classes and
IDs from the Style Sheet
Manager. Click Help under
Show current style status
and read the displayed help
topic.

@ Click the m icon to display the Style Sheet Man-
ager, which enables you to view all the styles
defined for the Web page being edited. In the
following example, a class named “color” is defined.

Style List{current t document t]
MET

A
colar : white
backaround color : black.

€l Click Show current style status  to view the style
for each HTML tag in the Web page being edited.

et Style Status

Ad
color : white
backaround color : black,

Chapter 9. Designing Web pages using style sheets
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Creating materials 10

Use WebArt Designer, a TopPage image-processing acces-
sory tool, to create three types of images: logos, buttons, and
photo frames. Use the Web Animator accessory tool to create
animation in the animation GIF image format.

Before doing the tasks in this chapter

1. Start WebArt Designer.

“Starting and ending WebArt Designer” on page
10-2

*%% Starting and ending WebArt Designer ...... 10-2

*** Using sample materials ...................... 10-4
** Creating a lettered button .................... 10-8
**  Decorating a photo with a frame ........... 10-15
**  Creating an animation GIF .................. 10-20

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 10-1



The WebArt Designer tool enables you to readily create three types of images: logos,
buttons, and photo frames. Moreover, by combining them with the images you have,

you can create images full of variety.

O L

The type of materials cre-
ated by WebArt Designer
are “images.” You can
paste them into your Web
pages, just as you do other
images.

“Inserting an image” on
page 7-2

O

The online help explains
details about WebArt De-
signer. If you encounter
problems or want to learn
advanced techniques, se-
lect Help Topics from the
Help menu, and read the
displayed topic.

10-2  TopPage User’s Guide

Starting WebArt Designer

To start WebArt Designer, do one of the following:
e Select the Windows Start menu, Programs ,
IBM NetObjects TopPage , and then WebArt

Designer .
[l (Sitcoessories
Favorites ¥ [Hinteinet Explorer »

5 Dacuments

¥ [ Netscape Communicator »

i Settings » [H0nine Services + (Documents 4
&) Find » [HRedl b File Transfer
S Help [ stantlp » &% TopPage

FRun 5} 5 Prompt
4%, Loa DIf Harumii

Bt User Registration

e Select WebArt Designer from the TopPage

Tool menu.

WebArt Designer’s main window appears:

e o o S et
LI ] - =T R = T R
—

l




Ending WebArt Designer

To end WebArt Designer, select Exit from the File menu.
If you have changed anything on the open image, a

message prompts you whether you want to save the
image.

WebArt Designer

/1N

3y we | cend |

To save the To exit without ~ To cancel the exit and

changes, click  saving, click continue using WebArt

the Yes button. the No button. Designer, click the
Cancel button.

Chapter 10. Creating materials ~ 10-3



The simplest way to create your own materials is to select one of sample materials
that is suitable for your Web pages and change its text or color using WebArt De-
signer.

@ Click the Other tab at the lower left of the WebArt

Designer main window.
If panes (or tabs) on the left

side are not displayed, click @ Select Webart from the box at the upper left of the
the (5| icon to display Other pane to display sample materials in the lower

them. half of the pane.

iz, Untitled - WehArt Designer

T_ File Edit View 0Object Tool Help
NEEpEesE]o0]

. =
The Other pane n the I*Sample M aterials ﬂﬁﬂ ;I
WebArt Designer main win- E-{E_Emple [ |
dow is the same as the &l ko
Contents pane in the e st -
TopPage main window.

-] sound
- webart:
o template

KX

Al Files

b_help. mif

b_info.mif

{iiie'i'

download. rif

([

Wbt Mol s ﬂ

Logo I Buttnnl Flamel Background  QOther
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@ Vocabulary

objects

Elements that make up an
image. You can handle the
following objects using
WebArt Designer:

e L ogo

e Button

e Photo frame
o Clip art

e Image (all the image ele-
ments other than the pre-
ceding objects)

The logo, button, photo

frame, and clip art objects

are WebArt Designer origi-
nal objects. If you click one
of them in the WebArt De-
signer edit field, eight white
square marks appear
around it. You can change
the text, shape, or color of
the object by clicking it us-
ing the right mouse button
and selecting Edit Object
from the pop-up menu.

On the other hand, if you
click an image object in the
edit field, eight black square
marks appear around it.
You cannot change the text,
shape, or color for an image
object, but you can paint
over it using the Paint Tool ,
which you can display by
clicking the ﬂ icon.

€@ Select your preferred image, drag it, and drop it
onto the edit field on the right side.

e €4 o et 100 b
Dl 3 2esioo = EES0H| MoEBaw e» o

uuuuu

aaaaa

mmmmm

P, s 1 ——

The following figure, for example, shows how the
image is pasted onto the edit field. This sample
image is composed of two objects: a logo and a
button.

Flo 4 Vi b Teo fieb
Dsd ds@cl o= |2e TF%00|40EBa= ">

mmmmm

mmmmm
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@ Click the upper of the two images (a logo) lined up
on the right to select it, and then click it using the
right mouse button, and select Edit Object .

A dialog box for editing the logo is displayed.

@ Enter your preferable words for Text on the Text
panel:

[ Edit Logo Object
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Just as for logos, if you click
the button using the right
mouse button, and then se-
lect Edit Objects , a dialog
box for editing the color and
shape of the button is dis-
played.

o) Tip ]
If you have done the wrong
operation, Click the ﬂ icon

to cancel the immediately
preceding operation.

Click the ﬂ icon to
reexecute the canceled op-
eration.

The result is immediately reflected in the edit field.

AT

@ You can use the Edit Logo Object dialog box to
freely change such things as the font or color of the
text, outline, and text effects. After editing the logo,
click the X button in the dialog box to close it.

o) Tip
If you change the text or color, save the object in a file.

“Saving a lettered button” on page 10-12

After having saved objects into a file, you can insert the file
into your Web pages, just as you do with other image files.

@ “Inserting an image” on page 7-2
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You can create a lettered button by selecting a button, creating a logo, and combining

them using WebArt Designer.

OUI——

Another way to create a
button is to click the J
icon to start the wizard for
creating a button.

OUI——

If you want to choose a
buttonlike image you have,
select Paste File from the
Edit menu, select a file in
the displayed dialog box,
and click the Open button.
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Selecting a button

To select one of the sophisticated sample buttons in the
Button pane:

Click the Button tab.

@ Select a button, drag it, and drop it onto the edit
field to the right.

Flo et Yiow Dhoct 1o top
DU szesiE - =TRSO A0 EEE = (= e
——

The following figure shows how a button is pasted
onto the edit field:

EEIFER=EIEEEEE RIS




Creating a logo

To create a logo using the Logo pane:
@ Click the Logo tab.
@ Type text in the Text field.

w7, Untitled - WebArt Designer

Y | |

€l Select one of samples in the Logo pane, drag it,
and drop it onto the edit field to the right.
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Another way to create a
logo is to click the E icon
to start the wizard for creat-
ing a logo.

)T

To delete an unnecessary
object, click an object and
then click the €| button.
Another way is to click an
object using the right
mouse button and then se-
lect Delete from the pop-up
menu.
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The following figure shows how a logo (text with an
effect you selected) is pasted onto the edit field:

=[5

@ To change the logo size, drag one of the logo’s
white square marks other than that at the upper
right corner. To rotate the logo, drag the white
square mark at the upper right corner.

O n m}

E-:I




Pl Note

If you select or create a but-
ton after having created a
logo, combining the two
hides the logo, because the
latest-created object lies on
top of the other objects. To
correct this, you must rear-
range the sequence of ob-
jects lined up on the right
area of the window with a
drag-and-drop operation.

Combining a button and a logo

To combine a button you have selected and a logo you
have created:

@ Click the logo to select it. (The appearance of the
eight white square marks around it indicates that it
is selected.)

@ Drag the center (an area other than the white
square marks) of the logo and position it on the top
of the button to make up a lettered button.

B £ yow Dt Tat B
DeddageH oo 2= OE20H| 40EH B 6 =4 >

P, s 1.
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o) Tip ]

After having saved objects
into a file, you can insert the
file into your Web pages,
just as you do with other im-
age files.

@ “Inserting an image” on
page 7-2
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Saving a lettered button

To select objects and save them in one file:

@ Select Select All from the Edit menu to select all
objects on the edit field. The selected objects are
surrounded by thick borders.

@ Select Save Wizard from the File menu to start the
wizard for saving.

Save Wizard (Select Type)

€@ Select Object only , and click the Next button.



@ Select GIF, and click the Next button.

Save Wizard (Select File Farmat)

Select image fils format

& GiE [Though i s imited to 256 calars to handle, yau can reduce file
size for images. It is rcommended that you save images that

ot need many colors such as llustistions
@ Vocabula ry ‘o1 can specily transparency for part of image

€ JPEG  [tis in geneial use on the Intemet because of its smallfis sis
land incanspicucus mage dearadation. It is 1scommendsd that
ou save full-colar images such as photos taken with a digial

dithering

‘ou cannot specify transparency.

One of methods for reduc- e ot o o e 5
ing colors. Dithering shows fﬁ%}iﬁ'ﬁﬂiﬂl@!&?ﬂim.,m, o S——
colors that are not actually

in the color palette, as
though they were, by ad-
justing the colors of adja-
cent pixe|3_ <Back [ Wew> |  Camcel | Help |

@ Select 256 colors , select Yes from the Dither box,

@ and select the Finish button.

If yOU C"Ck the ﬁl icon and <Original Image> <Converted Image>

click an image in the edit I I
field, an area with the same
color as the point you
clicked becomes transpar-
ent and the Transparent

check box is automatically S —
selected. Normally, this A
technique is used for mak- gy e e || i
ing the background color of ook [0 cokes 2=
the image transparent to Diher [ = I Intetece
merge it with the back-

ground color of the Web <Back [ Fon | | Cewsl | Heb
page being edited.

If you select the Interlace
check box, the image reso-
lution gradually increases
when it is displayed on a
Web browser. This tech-
nique is useful for large im-
ages.
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@ On the displayed dialog box, select the site folder,
specify a file name, and click the Save button to
save the objects in a GIF format image file.

(¢)Tip______________________________]

This section explains how to save objects in a file, but you
can also copy the image data from WebArt Designer and
paste it into TopPage without creating a file. To copy the im-
age data, select objects in the edit field of WebArt Designer
and select Copy from the Edit menu of WebArt Designer to
store the data in the clipboard.

To paste the data stored in the clipboard onto TopPage, po-
sition the cursor on a Web page you are editing and select
Paste from the Edit menu of TopPage.



You can decorate a photo you took with your digital camera with a frame and show it
to visitors to your Web site. In addition to adding a frame, you can retouch your digital

photo or apply an effect to it.

(1)Note ]
Before doing the following
operation, you must have
imported the image file of a
digital photo into your com-
puter or other media such
as a floppy disk, MO disk,
and so on.

OUI—

You can paste image files in
such formats as GIF, JPEG,
BMP, TIFF, FlashPix, and
Photo CD onto the edit field
of WebArt Designer.

Appendix C, “Image file
formats”

Pasting a digital photo
To paste the image file of a digital photo onto the WebArt
Designer’s edit field, do the following.
@ Select Paste File from the Edit menu.

@ On the displayed dialog box, select an image file in
your computer or other media, and click the Open
button to paste the image.

e Dz wod| a0EREaw (@ :xe
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o) Tip ]
Because a photo taken with
a digital camera might be
dark-colored or fuzzy, it is
recommended that you se-
lect the bright and high con-
trast image in the upper
right.
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Retouching a digital photo

A photo taken with a digital camera might be dark-
colored or fuzzy. You can retouch the brightness and
contrast of the photo as follows:

Click the ﬂ icon to display a dialog box for re-
touching the brightness and contrast. The image
you selected is displayed in the center of nine of the
same image but with slightly changed brightness
and contrast:

Low Contrast High Contriast | Preview

ok | Cacel | Resst | Heb |

@ Click the image that you think is best.

If you select the Preview check box, the image in
the edit field changes according to your selection.

@ If the image is satisfactory, click the OK button.

If you want to redo, click the Reset button to return
to the original state and obtain the optimum state by
dragging the Level slider or by reselecting the
image. After you click the best image, click the OK
button to change the brightness and contrast.



OUI——

If you want to retain the
naturalness of the digital
photo, you do not need to
apply an effect.

Applying an effect to a digital photo

Effects change your digital photo dramatically. To apply
an effect to your photo, do the following:

@ Click the @ icon to display the Effect Palette for
selecting one of the effects.

@ Click the Preview button to view how the selected
image changes if each effect is applied to it.

Effect Palette
Effect |Phulu | Colar Tone | Color Temperaue |
& =
. (‘ d
|
Flat Sharp
>
9
Unshaip Mask Border
-3 P
- 1 4
Wortex Bubble
-
{1 —
¢ H
Raindrop tosaic
%
]

Thumbinail 5ize: |4E %48 hd

Prewview I Fapnl | [ titrrs: I Close | Help |
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€@ Double-click an effect button to apply it to the
selected image in the edit field. The following figure
shows an example when the Emboss button is
double-clicked.

@ Click the Close button to apply the effect.

If you want to redo, click the - icon to return to the
original state, double-click another effect, and click
the Close button.



Adding a photo frame
@ To add one of the sample photo frames to your digital

photo, do the following:
You can also create a photo

frame using the wizard that @ Click the Frame tab at the lower left of the main
starts when you click the window to display sample photo frames provided by
@ T WebArt Designer.

Select a frame, drag it, and drop it onto the photo
image in the edit field.

Flo 3 Vi b Teo fieb
DA iaachH -~ e H0Fso0|[a0EBas= "o

@ @ If you want to change the frame size, drag one of

eight white square marks to change the size as you
with & frame in a file. see please. If you want to replace it with another frame,
“Saving a lettered bdtton" click the frame using the right mouse button, select
on page 10-12 and do the Edit Object from the pop-up menu, and select

same operation. You can another frame in the displayed dialog box.
paste the file onto the edit
field of TopPage, as you do
with other images.

To save the photo image
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An animation GIF is an animated GIF image, which is a combination of multiple
images. Viewed on your Web browser, it appears to move. You can insert an anima-
tion GIF image into your Web page, just as you do with other GIF images.

QLI
The online help of Web Ani-
mator explains details
about the tool. To display
the help topics, select Help

Topics from the Help
menu.
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Starting Web Animator

Start Web Animator, an accessory for creating animation
GIFs, in one of the following ways:
e Select the Windows Start menu, Programs ,
TopPage, and Web Animator .
e Select Web Animator from the WebArt De-
signer Tool menu.
The following is the Web Animator main window, with the
Startup dialog box:

....... =1olx]
Hel

File. Help
DSE|ES]4Eee E|- s |5E#EE|EEE |
I

nnnnnnn

aaaaaaaaaaaaaaa

e




OUI———

To start the animation wiz-
ard, you can also click the
@ icon on the toolbar of
the main window.

OUI——

The Startup dialog box also
contains the following but-
tons.

e (1] abutton for creating
animation from scratch.
Clicking this button is the
same as selecting New
from the File menu.

e |, a button for opening
an image file you have.

e 7|, a button for opening
an image file from among
the sample materials. To
use this function, you
must install TopPage'’s
sample materials.

Using the animation wizard

If you already have several images to combine into an
animation, using the animation wizard is the easiest way
to create an animation GIF.

@ Start Web Animator, and click the <= | button in the
Startup dialog box to start the animation wizard.

Startup

@ | Animation Wizard
D | New

™ Don't show this dislog nest time.

E Open
@’Fx Open Sample File

e B3

@ To add an image to the list, click the Add Image
File button on the File dialog box, select an image
file in the displayed dialog box, and click the Open

button.

Repeat this operation to add several images to the
list. (Note that in the animation to be created,
images are displayed in order from the top.)

T2 1| DeleteImage Fie

News> | Concel |

Hep |
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€@l Click the Next button to display the dialog box for
positioning frames. (Here, a frame means a single
image in the collection that makes up the anima-
tion.)

@ Change the position, if necessary, and click the
Next button to display the next dialog box:

Repeat and Delay Time

@ You can specify the number of repetitions and the
delay time for each frame. If necessary, change
them and click the Next button.



)T

You can open image files in
such formats as GIF, JPEG,
BMP, TIFF, FlashPix, and
Photo CD.

Appendix C, “Image file
formats”

@ To see a preview of the animation, click the H

icon.

Click the Finish button to finish the wizard.

All the frames that make up the animation are
displayed on the main window.

@l Select Save As from the File menu.

€1 On the displayed dialog box, select a folder, specify
a file name for the animation GIF (*.gif), and click
the Save button to save the animation GIF image in
a file.

Chapter 10. Creating materials ~ 10-23



OUI——

The following types of ani-
mation effects are available.
e Wipe

e Mosaic wipe
e Scroll

e Blend

o Blur

e \ortex

o Tile

e Mosaic

e Noise

e Scatter

e Pinch

e Center focus
e Zoom

e Gray scale

e Bilevel

® Sepia

e Half tone

e Motion Blur
e Wind

e Rotate
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Applying an animation effect

You can create animation from a single image, by apply-
ing an animation effect to the image.

@ Start Web Animator and click the @ icon on the
Startup dialog box to display the Open dialog box.

DOpen 7| x|

Lock i | 3 big =& @ = = =
draw00. git @drawuu?.g\l @'drawm J.aif @dlaw[ﬂﬁ a
draw0z. git @drawUUE.g\l @'drawm 4.aff @dlawUZU a
chawliI3, gif | draw003 gt B draw015.qf B drawiz1 o
chawli4. gif |5 dran010.git B draw016.gf B drawizz g
chawO05, gif B dhaw011 gt B chaw 7. gif 5 dhawinza g
drawlll gt B dhawi 2 gif B chaw018.gf (5 dawinzd o

B
Fiepame: | [ |
Files of pe: [ GIF Fies (" gi] | Cancel

@ Select an image file, and click the Open button.

The following example shows how the image is
opened:

3 draw02_gif

B

Altibute

L &l

@ Click 1: Image using the right mouse button, and
select Add Animation Effect from the pop-up
menu. The following dialog box is displayed:



(=15
ak

~ Effect

E - I T e
3, “wipe (T op -> Bottom] Time: = =
| Humber of Frames: {9 _I::' Help

Select one of the effects from a box under Effect
Settings and, if necessary, change the values for
Time or Number of Frames . Click theﬂ icon to
preview the effect.

Click the OK button to add frames, the number of
which is the same as you specified in Number of
Frames. (Until you click the OK button, you can
reselect an effect any number of times.) If the
added frames are too many to check all, drag the
scroll bar at the bottom of the window.

Select Save As from the File menu.

Select a folder, specify a file name for the animation
GIF file, and click the Save button to save the
animation you created in a GIF file (*.gif). You can
insert the file into the editor of TopPage, just as you
do with other GIF image files.
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Chapter

Advanced techniq 11

This chapter explains such advanced techniques as the frame
function, images maps, dynamic HTML, and so on.

Before doing the tasks in this chapter

1. Start TopPage.
“Starting and ending TopPage” on page 2-7
2. Open a Web page to be edited.

“Opening a site and a Web page” on page 4-11
[ J

Receiving readers’ responses ............... 11-2
Dividing a Web browser window (1)........ 11-3
Dividing a Web browser window (2)........ 11-8
Setting multiple links on a single image ....11-11
Inserting an access counter................. 11-15
Creatingaform ..o, 11-17
Editing a script program ............c..c....... 11-24
Embedding a plug-in object................. 11-26
Customizing a Java applet .................. 11-28
Using dynamic HTML .........ccoveienennnne. 11-33

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 11-1



Receiving readers' responses

If you want those who read your Web pages to write their impressions or to inquire for
detailed information, embed your e-mail address in your Web page, using the link
function.

@ Related HTML tags @ Select text or an image, which will be a link source,

and click the @ icon.
<A HREF="MAILTO:"></A>

Please send us your comiment or gquestion

@ Click the E-Mail tab, type your e-mail address in the
To box, and click the OK button. (You can also
type the subject in the Subject box.)

Attiibute
Tag IL\nk j
TaFil| ToURL| ToLabel EMai | AddLabel| TaUnsaved T4 |

o
[hpbmailip.ibm. com |
— Subject

Extended..

oK I Cancel | Help |

An e-mail address is embedded as a link
destination. If someone clicks the link source on a
Web browser, his or her e-mail application starts, in
which your e-mail address is automatically typed.

Please send us your comment or question.
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Dividing a Web browser window (1)

Use the frame function to divide a Web browser window into several sections. This
section explains how to create and save a Web page that uses the frame function.

@ Related HTML tags

<FRAMESET COLS= ROWS=
></FRAMESET>

<FRAME SRC= >
<NOFRAMES></NOFRAMES>

@ Vocabulary

frame function

A function to divide a Web
browser window into
several sections.

() Tip

To divide an existing Web
page without using a
template, open the page
you want to divide, select
Split Frame from the
Frame menu, and then
select Split Vertically or
Split Horizontally . The
page is then divided into
two sections and the
original page is allocated to
the left or top section.

Using templates for the frame function

TopPage offers templates for the frame function. Select
one of them, and in each section open Web pages you
have already created. If you have not installed
templates, refer to the Tip in this page to divide an

existing Web page.

@ Create Web pages you want to assign to each
section. If you want to divide a window into two

sections, you need two pages; if you want to divide

it into three sections, you need three pages.

@ Select New from the File menu to display a dialog

box for creating a new Web page.

and click the OK button.

Hew

Page Frame |Appl\catmn| Multiple F'agesl

€@ Click the Frame tab, select a method for dividing,

Split 2h [Type &)
Split 2h [Type B

Split 2v [Type B)
Split 3 (Type &)
Split 3 (Type B]
Spiit 3 (Twpe C)
Split 3 (Type D)
Split 3h

Split 3w

Split 4 [Type )
Spiit 4 (Twpe B)
Split 4 (Type C)
Split 4 [

Split 4 (Type E]
Split 4 (Type F)

Right=507%, Left=507%

Ok I Cancel

Help
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(1)Note ]

If you have not installed
templates, you cannot use
the Frame panel.

fo)Tip

To divide one of sections,
click it, select Split Frame
from the Frame menu, and
then select Split Vertically
or Split Horizontally . The
section is then divided into
two, and the original section
is allocated to the left or top
section.

(¢ Tip ]

If you click a section using
the right mouse button and
select Frame Attributes
from the pop-up menu, a
dialog box for changing the
frame attributes is
displayed.
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A Web page divided into sections is displayed.

B newpage1_htm - Untitled P ] 3

# Nomal [HTML Source | Preview | Frame HTML Source | NoFrame | T eoov

@ To open in a section a Web page you have already
created, click a section using the right mouse
button, and select Open in Frame from the pop-up
menu to display a dialog box for selecting an HTML
file.

@ Select a Web page you have already created, and
click the Open button to open the page within the
selected section.

@ In the same way, open another Web page within
another section.

B index_htm - ABC Florist

SRR LB A e

The ABC Flotist offers online ordeting of
‘bouquels, arrangements, baskets, and
centerpisces.

Floral

R R AR L

<
# Nownal [HTHL Source | Preview ] Frame HTML




(¢)Tip ]

To specify the section size
in pixels, click the target
section using the right
mouse button, select
Frame Attributes from the
pop-up menu, enter the
pixel value (for example,
100) in the Size box on the
Frame Attributes panel,
and select the Specify with
pixels check box.

If you want to fix the size of
one of two sections and
make the other section
displayed in the rest of the
window, first, fix the size of
one section as just
described. Next, click the
other section using the right
mouse button, select
“Frame Attributes” from the
pop-up menu, and select
Specify with  * from the left
box of Size on the Frame
Attributes panel.

Changing the size of each section

Dragging a frame border changes the relative size (in
percentage) of each section.

If you drag a frame border....

B index_htm - ABC Florist

S B AR e
The ABC Florist offers online orderiig of

bowguets, atrangements, baskets,
centerpieces

Floral
Arrangaments

Lo

St ot s e

4
# Nomal [HTML Source | Preview ] Frame HTML Source | No Frame | T boov

\ 4

The ratio of each section changes.

B3 index htm - ABC Florist =10[x]

St R AN e, m’ﬁ% K@’i@‘%@*ﬁ
Pl

The ABC Floist offers online
ordering of bouguets,
amangements, baskets, and
centerpieces

Floral

R IR AR
4| | »

| |
& Nomnal [HTML Source | Freview | Fiame HTML Souce | NoFrame | BODY
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fo)Tip

If you divide the top page,
set links in the No Frame

pane so that readers can

jump from the top page to
subpages.
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Editing the No Frame pane

Some Web browsers do not support the frame function,
so you should leave a message in the No Frame pane.

@ Click the No Frame tab, which is displayed while
you are editing your Web page that uses the frame

function.
framepagel.htm - Untitled = = =] ES

Heed browser which supports frames to see this page

& Momal | HTML Suulcel F'reviewl Frame HTML Source Mo Frame r

@ Type text for guiding visitors.

If someone views your Web page on a Web
browser that does not support the frame function,
he or she reads the message that you leave here.

[ framepagel_htm - Untitled * O] ]

This page uses the frame function. Because your Web Browser
does not support the frame function, you can see only this

message. To jump to another page that does not use the frame
funetion, click here |

@ Momal | HTML Sourcel Previewl Frame HTML Source  Na Frame r




(¢)Tip ]

Saving Web pages one
by one

If you want to save only a
frame-using page, select
Save Frame from the
Frame menu.

If you want to save other
Web pages that are
allocated to each section,
click the target section, and
click the || icon.

Saving the Web pages

You can save a frame-using page and the other pages
that are allocated to the sections all at once.

@ Select Save All from the File menu to save all the
Web pages at once.

@ |If there is a Web page that does not have a file
name, the following dialog box appears. Specify a
file name and click the Save button. (At this time,
the page to be saved is displayed in reverse video.)

SaveIAs 2]
Save e | (2 stetop = @I gl =

File name: — [trame.him

Save I
=l Cancel L,

Save as type: | HTHL files [*html;* htm:*. shtml.* shtm]

@ If you have pasted images or other files into the

page to be saved, the following dialog box appears:

[[Fiie Name
g gf

| Copping|
os

fl gl
- Change Selected
File Mame:  [map g .
e
[ Copy Files to the Folder

@ Confirm the save location and click the OK button.
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The previous section explains the basic operation for the frame function, including
creating and saving a page with frame. This section explains advanced operation for

the frame function.

@ Related HTML tags

<FRAME SRC= NAME=
MARGINWIDTH=
MARGINHEIGHT= SCROLLING=
NORESIZE>

TopPage User’s Guide

Increasing the margin of each section

Assigning an appropriate margin for each section gives it

a good appearance.

Click the target section using the right mouse
button, and select Frame Attributes from the pop-

up menu.

‘The ABC Flotist offers
online gof

~ Home

eeeee

ABC Florist

fl ;l_l I
& _Nomal [HTML Souce | Preview ] Frame HTML Source | No Frame

@ In the dialog box for

Attribute

changing the frame attributes,
select Use Horizontal Margin and Use Vertical
Margin , and specify their values in pixels.

Tag IFlame
Frame Attributes | Border Attrbutes |

URL

i

Ilndex.hlm

FErame Marne:

Browse... |

Ilighl
[~ Size

| Specity with

I~ Mo Resize on Browser

=l 3

—hargin

¥ Usz Harizontal Margin 1

¥ Use Vertical Margin

100 _|::‘

=

Scroll Bar

[ o |

Help

Cancel |




@ Vocabulary

target

One of the link attributes.
This indicates where the
link destination page is to
be displayed.

(¢ Tip ]

For example, specify the
name “left” for the left
section and “right” for the
right section, which is easy
to remember.

€@ Click the OK button.

You cannot see the result in the editor, but you can
see the result when displaying the frame-using
page on a Web browser.

Changing the link target

Suppose you divide the window into left and right
sections, and you set a link on the text on the left section,
the link destination page is normally displayed

in the same left side section. However, if you use the
target attribute, you can display the link destination page
on the right section.

@ To specify a name for the section where you want
to display the link destination page, click the section
using the right mouse button, select Frame
Attributes from the pop-up menu, and type a name
next to Frame Name.
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(¢ Tip ]

To display the link
destination page on the full
window, select Full
Window in the Target box
of the Attribute dialog box
for a link. The link
destination page is then
displayed on the full Web
browser window.

(¢ Tip ]

To remove a target
specification, delete the
frame name in the Target
box on the URL toolbar. To
change a target
specification, type another
frame name.
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@ Set a link into text or an image for the link source.

When you open the Attribute dialog box for a link,
select a frame name that you specified from the
Target box. @) Chapter 8, “Setting links”

Attribute
Tag  |[Link [ |
TaFile | To URL | ToLabel| E-Mail | AddLabel]
r— File Hams
Isulﬂ _htm
i~ Target
Ilight vI

ok I Cancel | Help |

€@ Click text or an image for the link source to check
that the frame name of the target section is
displayed in the Target box of the URL toolbar.

B n

] 4 ABC Florist

o FulEes e izt S
7 Nomel [ATHL Soes] Frevn] Fane HTWL Souce] NoFiame =
URL [o a1 |

If you click a link on a Web browser, the link
destination page is displayed in the specified
section.



The section “Setting a link on an image” on page 8-8 explains how to set a single link
on an image. This section explains how to divide a image into several areas and set
links on them. An image that have multiple links is called an image map or a clickable

map.
@ Related HTML tags

<MAP NAME= ></MAP>

<AREAALT= COORDS= HREF=
SHAPE= >

(1)Note ]

This section introduces the
simple flow for the image
map creation. If you want
to learn more about image
maps, click an image using
the right mouse button,
select Edit Image Map
from the pop-up menu, and
click the Help button. A
help topic is then displayed,
where you can read a
detailed explanation.

Opening the Image Map Editor

To open an editor to create an image map:

@ Click the target image using the right mouse button,
and select Edit Image Map from the pop-up menu

to open the Image Map Editor.

\liih Image Map Editor =] ES

Itap: map Delete Map. |

Image:  [C:\sitetopsmap. gif

slojoix @ csm =l [

Floral

Cancel Help
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fo)Tip

To create a circular area,
click the @] icon and drag
the image.

To create a polygonal area,
click the ] icon, click the
image multiple times to
make the angular points of
the polygon, and double-
click the last angular point
to finish.
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Setting links on multiple areas

You can create areas whose shapes are rectangular,
circular or polygonal and then set links to them.

@ Click the g icon in the Image Map Editor.

@ Drag on the image displayed in the editor, from the
upper left corner to the lower right corner, to create
a rectangular area. When you release the mouse
button, the area is determined, and the Attribute
dialog box for a link is displayed.

= Tmage W Edor
Map:  [map Delete Map...
Image:  [C:\sitetop\map. o
oo EXE Y= v
M —]
O — |
0 [T6F3]| To URL | ToLsbel| EMai|
i [etpim
- Home o
K| col
 Horme
ok || 1o

€@ Specify the link destination (refer to “Setting a link
on text” on page 8-2), and click the OK button to
add the area to the image map.

@ Click the down-arrow button in the Image Map
Editor to display a list of the specified areas.



(1)Note

Alternate text is necessary
for those who use Web
browsers that cannot
display images to jump to
the link destination. Be
sure to enter alternate text
for each area.

OUI—

To change a link
destination, click an area in
the image displayed in the
Image Map Editor , click
the [#|icon to display the
Attribute dialog box for a
link, and change the
destination.

fo) Tip

To cancel a link, click an
area in the image displayed
in the Image Map Editor,
and click the x]icon to
delete the area and to
cancel a link.

@ Type a comment for the area next to Alternate
Text.

\ish Image Map Editor

s |

I o] ol S 5 T
.

Floral Arangements|

[ox ]_corcal |

@ Repeat the preceding steps to create multiple areas
that have links to the different destinations.

i Image Map Editor

s |

{5 o] ol g S 5 TR
-
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(1)Note ]

You do not have to specify
a URL for the Default area.
However, you must specify
URLs for the other areas;
otherwise, you cannot save
an image map.

@ Vocabulary

client side image map

An image map that is
processed on the client (Web
browser) side. Because HTML
tags for this image map are
embedded in an HTML file,
you can easily use and
manage this image map.

@ Vocabulary

Server side image map

An image map that is
processed on the server (your
provider's server) side. To use
this image map, you must
create an image map file in
addition to an HTML file.
There are two types of server
side image maps; NCSA and
CERN, depending on the
application that the server
uses. To save an image map
in one of these formats, select
NCSA or CERN from the
upper right box in the Image
Map Editor.
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Saving an image map

You can save an image map (the entire image including
areas you created) in one of the following formats: client
side image map (CSIM) or server side image map
(NCSA or CERN). To save an image map in the CSIM
format, which is easy to manage:

@ Select CSIM from the upper right box in the Image
Map Editor.

@ Check that a map name (a file name for the image
map, which you can change if necessary) is
specified in the Map box.

\liih Image Map Editor

N [=] B

Itap: map Delete Map. |

Image:  [C:\sitetopsmap. gif

I s | )

oral
l;;an; gments

i

Shape | Target | URL ‘ Alternate Text ;I

Rectangle right subZ htm ‘Wedding Services —

Rectangle right sub3. htrn Order Form J J
Home

Fectangle right index. hitm =

e .

q | »|‘| [
Altemate Text IHnma

Cancel Help

@ Click the OK button to save the image map.



Inserting an access counter

If your provider offers a CGI program for an access counter, you can display the
number of times your Web page has been visited.

@ @ Open a Web page (typically, the top page) where

you want to insert an access counter.

< => . .
MG SRC @ Position the cursor on the location where you want

YNote ) to insert an access counter. Click the ﬂ icon to
@ display the Open dialog box.

Before doing this task, @ Click the Cancel button to display the Image dialog
check that your provider box

offers the access counter
service as well as guidelines | @§ Read the guideline provided by the provider and
Vet e e 0 e L find the text <IMG src="...">. Type the text en-

file. The guideline might "o oo .
state, for example: Specify closed by " " of <IMG src="..."> in the Image dialog

<IMAGE src="/cgi-bin/ box. For example, if the guideline states:

counter.cgi?id=hpb&n=1"> Specify <IMAGE

inthe HTML source. src="/cgi-bin/counter.cgi?id=hpb&n=1"> in the

('I_'he text surrqunded by HTML source

differs depending on the

providers.) If there is no typ{% ) o

such guideline, or if anything /cgi-bin/counter.cgi?id=hpb&n=1

is unclear, ask your provider. ——
Ichi-binz’counter.cgi?id=hpb&n=1 | Browse... |

@ V oca b u I a I‘y ' Open from Eile I Open from a T'AIN Compliant

Device
. . ™ Show Bordsr
CGl program, written in

Perl or C language _ tereel_| _ te |
A program written for @ Click the OK button to insert the access counter. In

exchanging data between a
client and a server. ltis
often used when a server
receives information—for
example, questionnaires or
orders—entered in a Web
browser, and then
processes it.

the editor, the mark is displayed.
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@ After you upload your Web page that contains the
access counter to the provider's server, you can
actually view the counter as shown in the following
figure. (The image that contains the number is the
access counter. You cannot view it until you upload
your Web page to the provider's server.)

You are visitor number _




Forms include such things as questionnaires and order forms. Visitors to your Web

site can fill in the blanks and enter responses to multiple choices within the form. This

section discusses how to create a form for a questionnaire.

@ Related HTML tags

<FORM></FORM>
<INPUT TYPE= >
<TEXTAREA>
<SELECT></SELECT>

Pl Note

Before doing this task,
check that your provider
permits the use of forms
and CGl programs. [f it
does not, you cannot use
forms even if you create
them.

You can check that your
form operates correctly only
after you upload your Web
page that contains your
form to your provider's
server.

(1)Note

TopPage does not provide
a function for creating CGil
programs. It is recommend
that you use CGI programs
offered by your provider.

Creating an area for your form

First, you must create an area only for your form in your
Web page. To create the area, position the cursor on the

location where you want to create your form. Select

Form and Input Fields from the Insert menu, and then

select Form to create an area for your form. (The form
area is indicated by a dotted line, but the line is not

displayed on Web browsers. If you insert anything in the

area, the area expands.)

Questionnaire

Chapter 11. Advanced techniques
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Using a table for layout

To create a table within the form area to lay out input
fields:

@ Click inside the form area, and click the icon.

@ In the Insert Table dialog box, type the number of
rows and columns, and click the OK button to
create a table inside the form area.

€@ If you want to use the table only for the layout, you
do not need the table border. Click the table using
the right mouse button, and select Hide Table
Frame from the pop-up menu.

Questionnaire




(¢)Tip
Other input fields

Frequently used input fields
are on the toolbar, but you
can insert all the input fields
from the menu. By select-
ing Push Button in Form
and Input Fields from the
Insert menu, you can insert
input fields other than those
described in the preceding
table. They are:

e Image Button (a button
with an image)

e Button (a button for
general purposes)

e Extended Button (a
button generated by the
selection of its range,
displayable only on
Internet Explorer 4.0 or
later.)

Types of input fields

Before inserting input fields, become acquainted with the
types of input fields.

this area.

Type of Explanation Toolbar Example
input icon
field
Check Visitors can click to e W blue
box select or clear this = I red
check box on their Web W white
M yellow
browsers.
Radio Visitors can choose " - @ right  left
button one radio button from Ll
those of the same
group.
Submit | Visitors can click this Submit |
button button to upload the
information they
entered to the CGI
program on your
provider's server.
Reset Visitors can click this
Feset |
button button to return the
information they
entered to the initially
set value.
Option Visitors can select one :
Iltem—1 v|
menu of multiple choices. s
List box | Visitors can select one e apples =
of multiple choices. =l grapes
Dranges;l
Text Visitors can type one B Ifruitbasket
field line of text in this field. :
Text Visitors can type E
area multiple lines of text in

Thank you for —
vour invitation.
Jid|
J
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(¢ Tip ]

If the Attribute dialog box
is not displayed, select
Options from the Tool
menu, click the General
tab, and select the Open
Attribute Dialog after Cre-
ating an Object check box.

(¢ Tip ]

To change attributes for
input fields later, click the
field using the right mouse
button, and select
Attributes from the pop-up
menu.
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Inserting input fields

To insert input fields in a table for layout:

@ Position the cursor on the location where you want to
insert an input field. Click one of input field icons on
the toolbar to display the Attribute dialog box for the
input field. “Types of input fields” on page 11-19

@ Type the input field name under Name. To specify
other items, click the Help button on the dialog box
to display the help topic that explains how to specify
items.

(I)Note ]

The input field name that you must enter under Name is

used as an identification code in the CGI program. If you
use your provider's CGI program, type the name that the
provider prescribes.

€@l Repeat the preceding steps to complete the ques-
tionnaire.

@ Position the cursor on the bottom of the question-
naire, and click the EEl| icon to display the Attribute
dialog box for a submit button.



@ Enter “Submit” under Label, and click the OK
button to create a submit button.

Attribute %]
11

@ Position the cursor to the right side of the created
submit button, and click the icon to display the
Attribute dialog box for a reset button.

Enter “Reset” under Label, and click the OK button
to create a reset button.

Attribute x|
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The following example shows how a form appears
in the editor:

B form.him - Unlitled *

Questionnaire

[ p—

T

The following example shows how the same form
appears when viewed on a Web browser:

A C:\sitetop\form htm - Microsoft Intemet Explorer

Questionnaire

C aYes
€ b No

© a. Very Interesting
€ b Interesting

© c.Fair

€ d. Not so interesting
© e Bad

cromes[

1. Did you know about this web site?

3. How did you like the web site?
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(1)Note

This User's Guide does not
provide details about
specifying these items,
because the specification
varies depending on the
providers.

You can check that your
form operates correctly only
after you upload your Web
page that contains your
form to your provider's
server.

Specifying a CGI program

If your provider permits the use of forms, it provides

guidelines for specifying the CGI program name, form

attributes, and so on. (If it does not, ask your provider.)

@ Click inside the form using the right mouse button,

and select Attributes from the pop-up menu to

display the Attribute dialog box for a form.

Attribute

Tag IForm

Farm | Hidden Fields |

B

Fomn Handler

Aclion:

Method,
Encoding Type:

Target:

i+ Get

 Post

|
|

Extended..

0K

[ cocd |[CHE

@ Specify the items according to the provider's guide-
lines. If you do not understand the meaning of any
item, click the Help button to display the help topic.

@ Click the OK button.
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Editing a script program

You can create a script program, using the script editor TopPage offers. You can then

insert it into your Web page.

@ Related HTML tags

<SCRIPT LANGUAGE= ></
SCRIPT>

@ Vocabulary

script

A program written in the
script language, JavaScript
or VBScript (Visual Basic
Script). You can write this
program directly into your
HTML file. The use of scripts
enables you to, for example:

« Gradually change the
background color of your
Web page

« Display the current time in
your Web page

Script files are small, which
makes them handy and
convenient. However,
because they are processed
only on the client side, you
cannot exchange data with
the provider's server.

(1)Note

Knowledge of script
language is necessary to
create scripts. Refer to
other books on JavaScript
or VBScript.
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Opening the script editor

To open the editor for editing script:

@ Position the cursor on the location where you want
to insert a script, and select Script from the Insert
menu to open the script editor:

o) [

Editing a script

To write a script program using the editor and then insert
it into the Web page:

@ Select a script language, JavaScript or VBScript ,
from the Language box.

@ Write a script program between <!-- and //->. Ob-
jects and libraries that you can use freely are
provided on the left side. (Click the Help button to
learn how to use them.)



(¢ Tip ]

JavasScript is conventionally
surrounded by "<!--" and "/
-->"and VBScript is
surrounded by "<!--" and "'--
>" which enables Web
browsers that support
scripts to run the script, and
which enables Web
browsers that do not
support script to ignore
them.

The following example shows how you can write a
script program:

€l Click the OK button to insert the script at the cursor
position. A script program is indicated by the mark 4 .

s

For Your Dream Weddinga

d
o) Tip

To insert a script program into the header section (the
section surrounded by the <HEAD> tag and the </[HEAD>
tag in HTML) of your Web page, select Document
Properties from the Edit menu, click the Others tab, and
click the Edit Script button to open the script editor. Write
your script with the editor, and click the OK button to insert
the script into the header section.

() Tip___________________________]

If you have your own JavaScript file (*.js), you can insert it
simply by selecting the file on the Contents tab, dragging it,
and dropping it onto your Web page.

If you have installed TopPage materials, you can insert
sample JavaScripts. To display sample JavaScripts, click
the Contents tab and select JavaScript from the upper left
box. To insert one of them, select one, drag it, and drop it
onto your Web page.
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You can insert such plug-in objects as sound data and multimedia data. This section
introduces how to insert the sample sound data offered by TopPage.

@ Click the Contents tab.

<EMBED SRC= ></EMBED> @ Select Sound from the upper left box (Sound is
one of the sample materials) to display several
sample sound files.

@ Vo ca b 2 I a ry 1 TopPage - sub2_htm - Wedding Services

File Edit “iew Fomat |nseit Table Frame

plug-in object DS HS( 4R e

Such objects as the sound
data (*.wav; *.mid; *.au) and
multimedia data
(Shockwave, VRML) that
you can play back on a
Web browser. They are || B0 Urineed iomsion [

Ca"ed plug'ln Objects Sound Files [.mid:.wav] =
because you must add the =
plug-in applications to your % % T

Web browser to play them.

(1)Note ]

You cannot create sound or
multimedia data using
TopPage. To create it, use

acal.mid aca.mid

= =l

act.mid claz.mid

other applications. o) o)
carn. mid e mid LI
w_ |C:\F‘mgram Files\T opPagesampletsound
Link_| File  Contents |
If you have not installed [ [BODY [Wedding Services

sample materials, you
cannot display the sample
sound data.
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@ € Using the right mouse button, drag a sound file.

Drop it on the Web page you are currently editing.

If you drag and drop a file The following pop-up menu is displayed.

with the right mouse button, g Pop _ p il
a pop-up menu is displayed Create a Link to Thiz File

Pazte az a Flug-in

Ihzert as Background Sound

at the dropping location.

If you select Insert as
Background Sound from
the preceding pop-up
menu, the file becomes the

@ Select Paste as a Plug-in to insert the sound data
at the position where you dropped the file as an

background sound for your plug-in object. The sound data is indicated by the
Web page. (This function is Q. mark.

Supported Only by Netscape Fi sub2.htm - Wedding Services o] =]

Navigator 3.0 or later, and f—_l

Internet Explorer 4.0 or : .

later.) P

iﬂ:or Your Dream Weddinga
W

n

h B

:We specialize in wedding services. Qur designers and :l

Q Vbtidal consultants will make your special day a i
I "

' '

To play back the inserted
plug-in objects on your Web
browser, the plug-in
applications must have
been added to your Web
browser. Not all Web
browsers have the plug-in
applications. Decide
whether to use plug-in ob-
jects, after considering the
purpose or target readers of
your Web pages.
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Though you cannot create Java applets with TopPage, you can modify (customize)
the size and movement of existing Java applets. This section describes how to insert

and customize a sample Java applet that TopPage offers.

@ Inserting one of the sample Java applets

<APPLET CODE= CODEBASE=
WIDTH= HEIGHT= ></APPLET>

<PARAM NAME= VALUE= > @ Click the Contents tab.

To insert one of sample Java applets TopPage offers:

@ Select Java Applet from the upper left box (Java

@ LR Applet is one of the sample materials) to display

sample Java applets.

Java applet
. . 44 TopPage - sub2 htm - Wedding Services
A program written in Java Fie Edt View Fomat lnsen Table Frame
language. By changing its O ESdEas =
parameters, you can | | |==|==
change such things as the i s et open 1l
background, movement, e Aple =12 A
and text. 5
ImgBlink 4

] ImgFade
] ImgPlay

4

(1)Note ]

You cannot create Java

Jawva applet Filez

(0 [

applets with TopPage. To E @
create them, you need a - =
knOWIedge Of ‘Java AirShow ImaBlink

language and
programming. m
You can display Java

applets only on Web ImeFade ImgPlay

browsers that support them.

5]
w_ Img5 crol Img5plit LI

IE “Program FilesTopPage'zample’java

If you have not installed Lk JFie  Contents |
sample materials, you [ [BODY [Weddng Services
cannot display sample Java

applets.
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(¢ Tip ]

You cannot run Java apples
in the TopPage editor. (In
the editor, an alternative
image is displayed instead
of the actual Java applet.)
Applets run only on a Web
browser.

€@ For checking the Java applet movements, click a
Java applet using the right mouse button, and
select Preview from the pop-up menu to start your
Web browser in which the Java applet you have
selected is displayed.

@ Select the Java applet you like, drag it, and drop it
onto the Web page you are editing.

The Java applet is inserted into the position where
you dropped the file. The Java applet is indicated
by the alternative image.

IC:/sitetopfwaveT extwaveT ext_c
1 |

(¢)Tip______________________________]
A single Java applet is composed of several files. If a Java applet
has been inserted as described in this section, a subfolder for the

Java applet is automatically created when you save the Web page
you are editing, and all the required files are copied into it.

When you upload your files to the provider's server, you must also
upload the subfolder for the Java applet and the files in it.
However, if your provider does not permit the use of subfolders,
move the entire content of the Java applet subfolder to the top
folder and erase the CODEBASE attribute of the <APPLET> tag.

o) Tip

If you inserted one of the sample Java applets, sometimes you
cannot check the movement of the Java applet with the Preview
tab. However, you can save the Web page in which you inserted
the Java applet. The files composing the Java applet are then
copied from the folder of sample materials into the Web page
subfolder. You can then check the movement with the Preview tab.
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Changing the size of a Java applet

To change the size of a Java applet you inserted, click it,
and drag one of eight black square marks around it.

Drag like this...

to change the size to this:

Changing the movement of a Java applet

You can easily change the movement, color, displayed
text, or displayed image of a Java applet by changing its
parameters. Change them according to your own
personal taste.

@ Click the Java applet using the right mouse button,
select Attributes from the pop-up menu to display
the Attribute dialog box.



@ Click the Parameters tab, which has a list of Java
applet parameters.

@ Click one of parameters. The parameter name is
displayed in Name, and the parameter value in

Value. You can change the value as you like. Type
the new value, and click the Replace button.

@ Click the OK button to save the changes. You
cannot check the changes on the Normal pane, but
you can on a Web browser.

You can change this Java applet ...

Me ||

4

to this.

Wedding <
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Inserting your own Java applet

To insert your own Java applet, which is not one of
sample Java applets provided by TopPage:

da

Create a subfolder for the Java applet in your site
folder.

Copy all the files composing the Java applet to the
subfolder you created. Copy the following files, for
example:
e Class files (*.class)
e Image files and other files specified in the class
files

Select Java applet from the Insert menu to display
the Attribute dialog box for a Java applet. Check
that Applet is displayed in the Tag list box.

Type the class file name in Code, the Java applet
subfolder name in Code Base, the explanation of
the Java applet in Alternate Text , and the size of
the Java applet in Width and Height .

Click the Parameters tab, which has a list of Java
applet parameters.

Enter the parameter name in Name and the corre-
sponding value in Value, and click the Add button.
Repeat this step for all the parameters.

Click the OK button to insert the Java applet. The
mark ¢ is then displayed. (You can view the
actual Java applet on a Web browser or the Pre-
view tab, not on the Normal tab. Before you view it
on the Preview tab, save the Web page where you
inserted the Java applet to view it correctly.)



Using dynamic HTML

You can use dynamic HTML by using the samples provided by TopPage. You can
create a new Web page that contains dynamic HTML. Or you can insert an element
for dynamic HTML into the Web page you are currently editing.

@ Related HTML tags

<SCRIPT></SCRIPT>
<DIV ID= STYLE= ></DIV>

@ Vocabulary

dynamic HTML

The latest technology for
creating animated Web
pages. Inthe past, to
create animated Web
pages, you had to either
create an animation GIF
image or write a program in
another file. However,
dynamic HTML requires
only an HTML file.

(1)Note

Netscape Navigator 4.0,
Microsoft Internet Explorer
4.0, or a later version of
these browsers can display
dynamic HTML. Decide
whether to use dynamic
HTML, considering the
purpose or target readers of
your Web pages.

Creating a new Web page that contains dynamic HTML

This method uses templates provided by TopPage. You
can view a new Web page with Netscape Navigator 4.0,
Microsoft Internet Explorer 4.0, or a later version of them.

@ Select New from the File menu to open the New
dialog box.

@ Click the Application tab, which contains Web
page templates using the latest technology. The
Web page titles that begin with <S> use style sheet
technology, and those that begin with <D> use
dynamic HTML technology.

€@l Select a template beginning with <D>, and click the
OK button.

Hew x|

Page | Frame Application IMuItipIe Pagesl

<D Cury
<D»Dalphin W orld
«D>Honeybee Garden
<D»0val Racing
<D>Pizza House
<D»Plane

<DsRoll Screen
<D>Satelite

<D» Tram
<5>Boutiqus
<5>Catalogue (Blue|
<5»Catalogue [Pink|
«5»Film Library
<5>Flower [Green)
«5>Flower [Pink]

<5 Laptop Computer |

izual effects: Dynamic html page:
zample, uzsing "'Bounce” effect.
The basketball iz bauncing up and
davin on the page.

oK I Cancel Help
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(¢)Tip ]

Another way to check the
movement of the dynamic
HTML is to select Save As
from the File menu to save
all the files composing the
Web page and view the
page on your Web browser.
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The Web page you selected opens in the TopPage

editor.

baseball

tennis

volleyball
football
soccer
golf

{ Store Front

9 Noms [HTML Sacce Previen]

@ Click the Preview tab to check the movement.

baseball

tennis
volleyball
football
soccer
golf

# Nomal] HTML Souce preview

@ To edit the page, click the Normal or HTML Source

tab, and edit it, as you do with other Web pages.



@ Vocabulary

layout frame

The area where you apply
the dynamic HTML effect.
Some Web browsers refer
to this as a layer.

@ Vocabulary

effect

Such movements as:
o Fade-in

« Fade-out

o Jump

« Bounce

» Float

These effects are described
in JavaScript.

Inserting an element for dynamic HTML into the
Web page

In this method, you create a layout frame in any position
you like, select an effect of dynamic HTML, and enter text
within the layout frame, to make animated text. You can
also make an animated image in the same way.

@ Click the E icon to display the dialog box for
creating dynamic HTML.

@ If necessary, change the position (Left and Top)
and size (Width and Height) of the layout frame.

€@ Select the background color from the Color list box.
(You can select the background image by clicking
the Browse button next to Image.)

Layout Frame
Layout Frame IEffact |
i}
’7 Laver! |
Explanation
- Position———————————————
Lelt: 50 3. pirels ] e
Top: 50 32 piels
- Minimum Sige —————————————————— Left HLi
widhe  [100 =] piels [ &
Height: 100 32 pirels —
Wwidth
Digplayed Size: Adjust

i Background

Image: I

Browse... |

 Stack Level

[Baody]

=l
=l

(u] 4 I Cancel | Help |

@ Click the Effect tab, which contains a list of effects
of dynamic HTML.
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(¢)Tip

If you select an effect on
the Effect tab, and if you
click the Sample preview
button, you can view the
sample image as animated.

If you select the Repeat
check box, you can set it to
repeat the same animation.
You can also change the
speed using the Speed
slider.
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@ Select one of effects under Effect, and select one
of patterns under Pattern :

Layout Frame

[:_] Credi

“ibration

@ Click the OK button to close the Layout Frame
dialog box and to create a layout frame.

B newpagel_htm - Unkitled =




(¢)Tip

Have fun and challenge
your creativity!

The advantage of dynamic
HTML is that it is flexible.
For example, you can
create complex movements
by creating multiple layout
frames and entering
different text or images into
them. In particular, if you
insert an animation GIF
image, you can combine
both the animation of the
image and the effect of
dynamic HTML.

“Creating on animation
GIF” on page 10-20

Click the layout frame, and enter text inside it. (Or
insert an image instead of text.)

newpagel_htm - Untitled =

€@ Click the Preview tab to check the movement.

€l To display the Layout Frame dialog box again for
reediting, click the layout frame using the right
mouse button, and select Layout Frame Attributes
from the pop-up menu.

(¢)Tip____________________________]

If you create multiple layout frames, or if it is difficult to select
a layout frame that has a color similar to the background,
select Layout Frames List from the View menu to display
the following dialog box:

! Laout Frames List

Edit
Delete

Select the target layout frame from this list, and click the Edit
button to display the Layout Frame dialog box of the target
layout frame.

To delete a layout frame, select a layout frame from this list,
and click the Delete button. If you delete all the layout
frames within a Web page, all the script code for the
dynamic HTML is automatically deleted.
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Chapter

Uploading Web pa 19

This chapter explains how to upload your Web pages to your
provider’s server to make them accessible on the Internet.

Before doing the tasks in this chapter

1. Start TopPage.
“Starting and ending TopPage” on page 2-7

e, (e e Wl — %% Before uploading ...........c........... 12-2
Next, read “Uploading the en- —— %% Uploading the entire site .............. 12-9
tire site,” “Uploading a Web .

et op L el e, fe . %% Uploading a Web page .............. 12-12
cording to what you want to do. ** Uploading files........................ 12-14

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 12-1



Before uploading the entire site, you must specify the destination server. Also, you
can find and correct errors in your site with the Site Check function.

Pl Note

You must create a site be-
fore doing this task.

@ “Creating a site” on
page 4-4
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Registering the destination server

To register such server information as the destination
server name, user ID, password, and destination folder,
all of which are necessary for uploading:

@ Select Site Wizard from the Site menu to start the
site wizard, which is the same as the one you used
to create the site.

@ Select Change the Existing Site Settings , and
select a site name.

@ Click the Next button. The Set Site Items dialog
box appears, displaying the items you have already
specified.



@ Vocabulary

server profile

A set of such server infor-
mation as the destination
server name, user ID, pass-
word, and destination
folder. Its default name is
the corresponding site
name, but you can change
it.

O
Enter the values in these
boxes that your provider in-
structs. For example, if you
are instructed to “place data
in the public_html folder,”
enter “public_html” in the
Destination Folder box.
Do not place a slash “/” at
the beginning. If you are in-
structed to “place data in
the /home/username
folder,” place a slash “/" at
the beginning and enter it
as “/lhome/username.” Con-
tact your provider on any-
thing that is unclear.

Server Profile Name box:

Setup Destination Server

@ Click the Next button. The Setup Destination
Server dialog box appears, in which the same
name as the site is automatically entered in the

- Destination Server Seting;
= Server Profile Name:
My Site] |

Specily a name for the server settings. Choose the
same name as the site name,

# Destination Server Name:

= User 1D * Password:

Specily the destination folder{directory] guided by vour
b
[for example, public_htrl)

Specify a server name, a user |D, and a password, The settings in this
page is are required
for transtering pages.
* Destination Folder Browse. “fou can skip the:
stings, and reda
them after using this
Site Wizard

Detail Setings |

<Back [ MWew> |  Camcel |

Help

Enter the address of your provider’s server in the

Destination Server Name box.

Enter your user ID in the User ID box, your pass-
word in the Password box, and the server’s folder

name in which you upload your files in the Destina-
tion Folder box. (The values in the following figure

are examples.)

Setup Destination Server

~ Destination Server Setting:
= Server Profile Name
s et

My Site: =l

Specify a name for the server sattings. Chaoss the

SaMe hame as the site name,

* Destination Server Name:

|np.mm.ne i

= User ID: * Password:

[rouseid [

Specily a server name, 2 user |D), and & password The seltings in this
page is are required
for ransfering pages.

* Destination Folder Browse... *f'ou can skip the
settings. and 1edo

public:_htrl them after uging this

Specily the destination folder(directory) guided by your | Site Wizard

provider

[for example,, public_htmi)

Detal Setings |
<Back Carcel | Help
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)T
If you are uploading files from a LAN-connected personal
computer through a firewall, click the Detail Settings button
and set the firewall. Only the “SITE hostname” type firewall

is available. If you do not know your firewall format, contact
your system administrator.

@ Click the Next button to display the final dialog box.

DOperation after Setting Completion

@ @ Click the Finish button to complete the settings.

If you want to cancel a
server registration, select
Destination Server Setup
from the Site menu, select
a profile name from the
Registered Server list,
click the Delete Server but-
ton, and click the OK but-
ton.
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Before doing this task, save

all the Web pages you are
currently editing.

Correcting errors

The Site Check function enables you to find the following
errors in the entire site:
e Images without alternate text

e Spelling errors
@ Select Site Check from the Site menu to display

the Site Check dialog box.

@ Select a site name from the Site to Check list box.
(If you open a site, you can select only that site. If
you do not open a site, you can select any one from
all the registered sites.)

€@ You can select either the Alternate Text check box
or the Spelling check box, or you can select both of
them.

Site Check

Site to Check:

Wy Site:
[V &kemnate Test ¥ Speling Cancel |

@ Click the Start button to start searching for errors.
When the search is complete, the Find Result
dialog box is displayed. The file names of the Web
pages with errors and the types of errors are dis-

played.

File Mame | Mo Alternate Text | Misspelled |
C:hmysitetsub3 htm ®

C:Amwsitemap. htm

C:hmpsitetsubl.htm

C:hmpsitetsubZ htm

Cohmusitetw ave T exthiw/ave Text htm

P

Stop Bt Close Help
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@ Select a file name, and click the Open File button
to open the corresponding Web page.

@ Correct the errors as follows:

e To add alternate text, select URL Editor from
the Tool menu, select the Image or Linked
Image button on the URL Editor, and enter
alternate text.

e To fix spelling errors, select Spelling from the
Edit menu. Enter the correct spelling using the
Spelling dialog box.

(For details, click the Help button on the URL Editor
or the Spelling dialog box.



(1)Note ]

Before doing this task,
place the target files into the
site folder.

Registering a file as the one to be uploaded

TopPage categorizes files in the site folder as either

“unused files” or “files to be transferred. ” Remember that

if you upload the entire site, only the “files to be trans-

ferred” are uploaded. This section explains how to

change an “unused file” into a “file to be transferred.”

@ Open a site.
“Opening a site and a Web page” on page 4-11

@ Click the File tab, and click Unused Files to display
the list of files that TopPage regards as unused
files, in the lower half of the File pane.

- My Site
E@ Top Falder[C: mysite’)
i WaveTent

% Files to Be Transfered

3] readme him
[™ index bak
[ map.bak
& map.gif

a map.htm ABC Flarist
[ subl bak

[ subZ bak

[™ sub3.bak

D frame. bak,

@ Frame. htm ABC Flarist

Readme First
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OUCE———

If you find an unnecessary
file among the Unused
Files list, delete it by click-
ing the file name using the
right mouse button, and se-
lecting Delete from the pop-
up menu.

12-8  TopPage User’s Guide

@ Click the target file using the right mouse button,
and select Add to transferred list  from the pop-up
menu.

ek My Site
E& Top Folder(C: \mysitel)
H 0 WaveTest

% Files to Be Transfered

D index. b,

D map.bak

a map.gif

ﬂ map.htm

[ subl.bak el

[ sub2bak —
[ sub3.biak

B frame.bak.

ﬁ frame.htm

@ To check that the file has been moved, click Files
to Be Transferred in the upper half of the File
pane.

gl My Site
=3 Top Folder(C:\mysitsh)
LB wWaveTest

% Unused Files

a garde_fr.gif
a garde_bg.gif
readme. him Readme First
a indes htm
( popl.mid
ﬂ subl.htm
a sub2.htm
i‘ ActChar.class
r‘ Fontlnto.class




You can connect to your provider’s server, and upload the entire site—that is, all the
files and subfolders that compose a site—to make your Web pages accessible on the

Internet.

Pl Note

You can do this task only
when you open a site.

OUI——

The first upload enables
you to upload all the files
and subfolders that com-
pose a site. The second
and later upload enables
you to upload only files
newly created or changed
since the previous upload.

@ Register the destination server.
“Registering the destination server” on page 12-2
@ Open a site.
“Opening a site and a Web page” on page 4-11

€@ Select File Transfer from the Site menu, and then
select Site Upload to start the upload wizard.

@ On the first dialog box of the wizard, select Select
the Existing Profile , and select a profile name
(normally the same as the site).

‘a € Create & Profie

Specify a profis name.

ML) & Selectthe Esistng Profie

— Delete Prafile

e Hewt> Concel | Hep |

@ Click the Next button. The Transfer Mode Set-
tings dialog box is displayed.
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(¢) Tips 1

In the upper left field on the
Select Source Files dialog
box, Files Updated since
Previous Transfer is auto-
matically selected. Nor-
mally, do not change this.

You can view a list of files
stored in the site folder by
clicking the Files List but-
ton. The selected files in
the list are to be trans-
ferred. (If necessary, you
can select files that are not
selected, or you can dese-
lect files that are selected.)

You do not need to enter a
number in the Estimated
Download Time field.
However, if you want to es-
timate the time required for
uploading, enter your
computer’'s modem speed.
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@ Click the Next button to display the Select Source
Files dialog box:

~Server Settings
Server Name:

[obmreie
UserID
Fies List | [
Total e size 124 K bytes ( 23 fles | Password
Dowrload Time————————— | [
26K Faec | | Destination Folder,

8K [ Zlee | | [publicim

Bk 18sec Source Folder

®00 | amn| | [t

cBack [ Fish | Cancel | Hep |

Click the Finish button.

If your computer is not connected to the Internet, a
dialog box is displayed prompting you to connect.
After connection, the upload begins, and the follow-
ing dialog box that indicates the upload status is
displayed:

Mow Transferring

Source
C:\mysite\garde_tp.gif

Destination
homedtoppage/public_html/grade_tp. gif

Nurnber of files left: 17

Transferring [Binary Made]

When the upload is complete, the message “Trans-
fer complete” is displayed.



@l Click the OK button.

() Note ]

TopPage regards files called by a script program, a Java
applet, an external CSS file, or a CGI program other than the
TopPage samples as “unused files.” To prevent this, you
must, in advance, mark them as “files to be transferred.” Af-
ter upload, if you notice that some files were not uploaded,
mark them as “files to be transferred,” and upload the entire
site again.

@ “Registering a file as the one to be uploaded” on page
12-7
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You can upload a single Web page with the files pasted in it at the same time. For
example, if images are pasted in your Web page, you can upload both an HTML file
and image files at once.

(1)Note

You cannot upload the link
destination pages in this
method, however.

e Fone Sio Toe il =lsix
FERERERE -

B R SN PN S PN T PN I Py

[ [BO0DY___[ABCFim

N
ot [TV S i ]
v

@ Select File Transfer from the Site menu, and then
select Page Upload to start the upload wizard.

@ €@ On the first dialog box of the wizard, select Select

the Existing Profile , and select a profile name
If you want to create a new (normally the same as the site).

server profile, click the Cre-
ate a Profile button on the

Select Server Profile dia- G2 e

log box, enter a new profile fai
name, and click the Next
button to dlsplay a dlalog QD & Select the Existing Profile

i Delete Profile
box for entering the server
information.

cisor [ Hews | Cancel Help
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(¢) Tips 1

You can view a list of files
that make up your Web
page by clicking the Files
List button. The selected
files in the list are to be
transferred. (If necessary,
you can select files that are
not selected, or you can
deselect files that are se-
lected.)

You do not need to enter a
number in the Estimated
Download Time field.
However, if you want to esti-
mate the time required for
uploading, enter your
computer’s modem speed.

(1)Note

Files called by a script pro-
gram, a Java applet, an
external CSS file, or a CGl
program other than the
TopPage samples are not
uploaded. After uploading
your Web page, upload
only the files that were not
uploaded.

“Uploading files” on
page 12-14

@ Click the Next button. The Select Source Files

dialog box is displayed:

Select Source Files

4l Files | Server Name:
ftp.ibm.ne.jp
Lser I
Total fle size 55 K bytes [ 9 fies ) Password
~Estimated Dawrload Tine—————————— [ |
X 16sec | | Destination Falder
o 10 sec | | [public_him
6K @sec | | Source Folder
00| e || [Tt

|- Senver Settings

cBack | Frsh | Cancel | Hep |

@ Click the Finish button.

If your computer is not connected to the Internet, a
dialog box is displayed, prompting you to connect.
After connection, the upload begins, and the follow-

ing dialog box that indicates the upload status is

displayed:

Saurce
C:hysiteflowr_id. gif

Destination

/home/toppage/public_html/flovr_i3. gif

Number of files left: 4

Transferring [Binary Mode]

When the upload is complete, the message “Trans-
fer complete” is displayed.

@ Click the OK button.
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You can upload individual files from your computer, or delete individual files on the
provider’s server, using the File Transfer tool.

O L

You can use TopPage’s File
Transfer tool as an FTP cli-
ent program. Click the 2|
icon on the File Transfer
main window to learn more
how to use this tool.
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Start the File Transfer tool in one of the following
ways.

e Select the Windows Start menu, Programs ,
TopPage, and then File Transfer .

or:

e Select File Transfer from TopPage’s Tool
menu.

The File Transfer main window is displayed.

" File Transfer - C:\Program Files\TopPageibin (Local]

] | oo B 2]
g My Computer % ftp.bmreip
= (€] [C:\Program Files'TapP agetbin' | [ |
Narme | Type | Mad + Narme: TSz Type | Madiiee
(] serint File Folder 199%
] animator.cnt 4KB CNT Fie 193¢ f
|35, nimator.eve 4528 Appication 1931
[a] ANMATOR G 18KB e
@ ANMATORH.. 538KB 3
Composevcnt BB
Composereve 1103
€ COMPOSER...  405KB
[] ditioz.di 1346
(%] efinZ5i.dil 1043
fufercnt 168
| frfer o 202K8
€} FXFER HLP 48K
51 hedn.brp. 139 K8
] hed0.ent 16KE
& hed0 exe 2803
bl g | 3]
7

@ Open a folder where files that you want to upload
are stored.

sitel [Local
My S 5 | oo B ﬂﬂ
@
g My Computer 2 tpbmnein
g (] [Cmysitet =] &l =]
[[iame [ sie Type [ Mod < Nane [ siee [ Type [ Modiiec
il Folder 1955
468 GIFImage 199E
3K8 GIFImage. 135
568 GIF Image 193¢
168 BAKFle 193¢
KB Microsolt HTML .. 195
28 GIF Image 193¢
768 GIFImage 135
768 GIFImage 199E
1£8 GFImage 133 FR-F2
25K8 GIF Image 193¢
28 GIFImage 199
248 BAKFle 199
268 Micosolt HTML .. 195
168 BAKFle 193¢
ke GIFlmage 199y
I LI_I < I i
2




@ Click the E|icon.

@ From the list under Registered Profile , select the
name of a server profile you created for the site
upload, and click the OK button. (It you have not
created a server profile, register it. For details, click
the Help button of this dialog box.)

. o

@ On the right side, files and folders on the server is
displayed. Select the destination folder.

html [HE'“FI_ ___J FF

e/ toppags/puble_htl
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)T

To delete a file on the
server, on the right side of
the window, click a file us-
ing the right mouse button,
and select Delete from the
pop-up menu.
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On the left side, click to select a file you want to
upload. (To select all the files in a folder, click the
list of files using the right mouse button, and select
Select All from the pop-up menu.)

@ Click the icon to upload the selected file or
files. (files appear to be copied from the left side to
the right side.)



Chapter

Other functions 13

This chapter explains convenient functions that have not been
explained in the preceding chapters.

Before doing the tasks in this chapter

1. Start TopPage.
“Starting and ending TopPage” on page 2-7
2. Open a Web page to be edited.

“Opening a site and a Web page” on page 4-11
[ J

*  Editing HTML directly ..........c.cocoiiine. 13-2
*  Downloading a Web page ...........c........ 13-5
*  Other functions: Intermediate ............... 13-6
*  Other functions: Advanced ................... 13-8

Note: The stars (& to *%%) indicate the importance of the task. The most important tasks are marked by ***. 13-1



If you know HTML tags well, or if you wish to enter HTML tags other than those
TopPage supports, edit HTML directly. Appendix B, “HTML tags”

(¢ Tip ]

To edit your Web page both
on the Normal pane and on
the HTML source pane
simultaneously, click your
Web page using the right
mouse button, and select
Open in New Window to
open the same Web page
in another window. If you
click the Normal tab on one
window, and the HTML
source tab on the other
window, you can edit while
comparing the two.
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Editing the HTML source

To edit the HTML source directly, click the HTML Source
tab. The content of the HTML source is then displayed.
You can rewrite it as you like. Click the Normal tab to
return to the WYSIWYG editor.

[ index.htm - ABC Florist

< ED>
|Bopy garde_bg.gif' bycolor=" = = vlink

|<cereR-
<G src='garde hr.git' alt='Green Flover Strip" width='560" height='34" align='middl,

de_nl.gif' alt='lail Tcon' width='d5' height='45
1< /EONT< /3

<>
<4 _'j
1 | 3

‘
7 Nomal HTML Sowce Preview

Entering an HTML tag

You can directly enter an HTML tag, even on the Normal
pane.

@ Position the cursor on the location where you want
to insert an HTML tag.

@ Select HTML Tag from the Insert menu to display a
dialog box for entering an HTML tag.



(¢) Tips

While you are editing your
Web page on the Normal
pane, the HTML tag name
at the cursor position is
displayed on the status bar.
To quickly display the
Attribute dialog box for the
target HTML tag, click the
button in the lower right
corner, and select the target
HTML tag name from the
pop-up menu that indicates
the HTML structure. Note
that some HTML tags have

no attributes to be changed.

Attributes of IMG
Afributes of TD
Attibutes of TR
Attributes of TABLE
Attibutes of BODY

€ Enter an HTML tag, and click the OK button to
insert the tag at the cursor position.
HTHML Tag

Ok I Cancel Help

Entering HTML tag attributes

If you know attribute keywords such as “align” and “src,”
you can directly enter the attribute values, even on the
Normal pane, using the Universal Attribute Editor.

@ Click the target element.

index_htm - ABC FI{

v Flotal )
rArrangements i
: o |

@ Select Universal Attribute Editor  from the Tool
menu to open the Universal Attribute Editor.
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(1)Note ]

By using the Universal
Attribute Editor, you can
edit even some attributes
that TopPage cannot
display.
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€ On the left side of the editor, all the HTML tags
within the Web page you are currently editing are
displayed. Click an HTML tag to display its attribute
keywords on the right side. Click one of keywords,
and enter its value in the Attribute Value box.

Universal Attribute E ditor <IMG>

= HTHL = [ Atrbute Mame AttibuteVal.. | =
1 HEAD ONMOUSEUP
= BODY ONMOUSEDVER
ONMOUSEMOVE
= CENTER ONMOUSEOUT
ONKEYPRESS
8A ONKEYDOWN
BA ONKEYUP
TABLE SAC low_il gif
Flower

ALT
& 1R LONGDESC
FA HEIGHT 8
: WIDTH 80
(= | =Y
I8 | ismep
BR ALIGN middle
*ron | | BorpER 0
BR HSPACE
. .pn —|vseare
o HAME

DA MAPFILE =

-~ BR
[, Attrbuts Mame: [PLIGN
< L. _,'LI Aiibute Value: [riddd]

@ Click the Apply button.



Downloading a Web page

You can open a Web page on the Internet that begins with “http://” and save its files to
your computer. This is referred to as downloading.

(¢)Tip

To enter the same URL as
the Web page you are
currently displaying on your
Web browser, click the Get
URL from Browser button.

@ Select Open URL from the File menu to display a
dialog box for opening a Web page on the Internet.

@ “http:/I" is already entered, so enter the rest of the
URL.

Open URL x|
Ihllp. //prodinfo.japan.ibm. co.jp/toppage/sample/ j
Get URL from Browser |
ak I Cancel | Help |

€@ Click the OK button to download and open the Web
page.

Ta[|
SEIE]

007

@ To save the downloaded Web page, select Save As
from the File menu, specify the location for saving
it, and click the Save button to save all the files that
make up the Web page.
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The following functions are convenient for intermediate users:
e Registering frequently used folders as bookmarks
e Entering your comments

fo)Tip

To edit the registered
bookmarks, click the # icon
to display the dialog box for
editing bookmarks. This
dialog box enables you to
rename the bookmark titles
or to delete unneeded
bookmarks. For details,
click the Help button of this
dialog box.
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Registering frequently used folders as bookmarks

After registering folders you frequently use as bookmarks
of the Contents tab, you can easily open them.
Click the Contents tab.

@ Click a folder using the right mouse button, and
select Add Bookmark to register the folder as a

bookmark.
[Site is not apen. 2=l
[oteroser =] £ 4
o ]

Explore

-] Prog Q_pa"‘
] Rea  Find. J

44 Rers

y Send To 3
1 =
1 Tem Cut
-] Wint Copp

Create Shortout
Delete

===

Froperties

NeﬂiFo\der..
flewr_i2. gif

flowr_i3.gif j
IE'\myimage
Link | File  Contents
€@ To open a registered folder, select the folder name
from the uppermost box of the Contents pane.

‘S\te is not open. ==l
* Site Folder - ﬁ@;‘

=S ample Materials
Image
Sound
Java Applet
JavaSeipt
=Template Materials
Image
=Bockmarks

~History
C:/myimage
C/mysie

== Waderk (T1-1 ﬂl




Entering your comments

A comment element (the <!-- --> tag) is never displayed
on Web browsers. You can use it as your memorandum.

@ Select Comment from the Insert menu.

@ Enter your comments, and click the OK button to

insert them.
Edit Commenl t
This is the comment] =
il _’lﬂ
o | Cancel | Heln |

The i mark is displayed at the cursor position.
This mark is not displayed on Web browsers.

€ To read or edit your comments, click the { mark
using the right mouse button, and select Attributes
from the pop-up menu.
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Other functions: Advanced

The following functions are convenient for advanced users:
e Creating a channel file
e Changing heading levels

e Creating an index

e Creating a site map

@ Vocabulary

channel

A Web site that is delivered
to the readers periodically
according to the schedule
the Web site creator
determines.

(1)Note

Some Web browsers do not
have the channel function.
Internet Explorer 4.0,
Netscape Navigator 4.0,
later version of these have
the channel function.

(1)Note ]

You can reedit a CDF file
for Internet Explorer, but
you cannot reedit a channel
file for Netscape Navigator.
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Creating a channel file

You can create a channel file and set a link to it. Readers
can then register your Web site as a channel.

@ Select Create Channel from the Tool menu, and
then select Netscape Channel or Internet
Explorer Channel . (If you select Netscape
Channel, you can create a channel file for
Netscape Navigator, whereas if you select Internet
Explorer Channel , you can create a CDF file
(*.cdf) for Internet Explorer.)

@ Click the Help button of the displayed dialog box,
refer to the displayed explanation, and create a
channel file.

@ Create a button image with text such as “Register
Channel,” paste it into your Web page, and set a
link from the button image to the channel file.

@ Upload the channel file and your Web page that
includes the button image to your provider's server.
Readers can then register your Web site as a
channel, just by clicking the button image.

(I)Note ]

Because TopPage regards files called by your channel file
as “unused files,” register them as “files to be transferred”
before uploading.

“Register a file as the one to be uploaded” on page 12-7



Changing heading levels

If you are editing a long Web page, and if you want to
change the levels of several headings at once, use the
Heading Editor.

@ Select Heading Editor from the Tool menu to
display the Heading Editor.

@ Click a heading, and click the << button to raise the
level or the >> button to lower the level. Repeat
this to adjust the levels of all the headings within
the Web page.

Heading Editor
—Heading Editor
Lewel Text
“wieh pages and TopPage
H4 Wwhat are “Web pages?
H4 Sample \Web pages
H4 “Web pages on the Internet
H2 Starting TopPage
H4 Sygtem requirements
HA Starting and ending TopPage
H4 Referring to the online help

1] 4 | Cancel | Help

€@l Click the OK button.

Creating an index

You can create an index from the headings of your Web
page.

@ Select Index from the Insert menu to display a
dialog box for creating an index.
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(¢)Tip

Under Labels, select one of
the following:

e Add Labels and Links to
the table of contents to
This Document , to
enable a visitor to jump
from the index to the
headings, and vice versa.

e Add Labels to This
Document , to enable a
visitor to jump from the
index to the headings.

e Do not add Any Labels
to permit no jumps.

13-10  TopPage User’s Guide

@ Under Headings , select the heading levels you
want to include in the index. Under Output , select
the location to transfer the index. (If you select
Another File , specify the file name, too.) Under
List Type , select the list type. (An index is created
in the list format. ) Under Label, select how to
attach labels.

Create Table of Contents x|
—Heading
W W Heading2 I Heading 3

[~ Headingd [~ Heading5 I Heading &

— Output
& Top of This Document
" Cursor Position Browse... |
" Another File
 List Type
& Bullsted List " Ordered List
 Lawel

o Add Labels and Links to the table of contents ta
This Document

" add Labels to This Document
" Do Mot Add sny Labels

QK I Cancel | Help |
€@ Click the OK button to create the index as you
specified.

o Web pages and TopPage
s Starting TopPage

Web pages and TopPage

What are Web pages?

Vou probably have seen Web pages using a Web browser. See
the following sample Web page to examine the structure of a

general Weh page
| _'IJ

|
A Womal [HTHL Source | Preview | [ eoor




Creating a site map

You can create a site map, which contains links to all the
Web pages in your site. To create it, open a site, and
select Create Site Map from the Site menu. The
following figure is an example of a site map.

Site Map

o ABC Florist
o Floral Arrangements 13

o Wedding Services
m Wave Text

o OrderForm
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Appendix A. TopPage functions

The following tables explain the TopPage functions:

Page-editing functions

Page editing
(You can check the layout
in WYSIWYG.)

e Support of such views as
"Normal" (WYSIWYG), "HTML
Source," and "Preview." (For the
frame-using pages, the "Frame
HTML Source" view and "No
Frame" view are also available)

e Creating pages using the wizard

e Editing multiple pages simulta-
neously

e Checking the display on multiple
Web browsers

e Background colors for table, row,
and cell

e Background image for cell

e Creating a table and rows, and
specifying the table title

e Converting the CSV format table
to the HTML format table (with a
drag-and-drop operation; through
the clipboard; from a file)

Partial support of HTML 4. 0

Support of style sheets

o Partial support of CSS Level 1
(based on W3C)
e Support of CSS-P (positioning)

Form

e Such input fields as check boxes,
radio buttons, send buttons, reset
buttons, option menus, list boxes,
and text entry fields

Offering and customization o

dynamic HTML

Text format

e Support of such paragraph types
as heading, preformatted,
address, and block quote

e Lists

e Superscript and subscript

e Alignment

e Indent

e Font color, size, and face

Frame

® WYSIWYG editing within frames

e Converting a normal page into a
frame page

e Creating frames with the mouse
operation

e Specifying frame size (pixels, %,
or automatic)

e Specifying frame-border width

e Specifying scroll-bar format

Document format

e Text color

e Link color

e Background color

e Background image

e Document title

e Editing meta-information

Text flow around a table or an image

Script editing

e Editing and inserting JavaScript
and VBScript

e Samples of objects, properties,
and methods

Editing of comments

Insertion of plug-in objects

e Inserting Shockwave, VRML, and
sound files

Insertion of dates and
times

e Inserting the document-created
date and time

Link

e Links to external Web pages,
other documents, and FTP

o Links within a document

e E-mail (mailto:)

e Setting a link by dragging and
dropping a file from the Link view

e Reading the link destination page
(remote and local)

Table

e Creating a table, specifying
numbers of rows and columns

e Resizing a table with the mouse
operation

e Inserting or deleting columns and
rows

e Merging and splitting cells

e Setting cell size, ruled line width,
and padding

e Setting multiple cells at once, by
selecting multiple cells

e Hiding table borders

Editing of HTML source

e Editing HTML tags directly

e Colored display of HTML tags for
easy editing

e Finding and replacing text

e Jumping to a field that has a
syntax error

Pasting of images

e Moving and copying images with
drag-and-drop operations

e Changing the image display size

e Pasting an image from another
program through the clipboard

e Fetching images from TWAIN 32-
compatible digital cameras and
scanners

Index creation

e Creating an index from headings
in a Web page

e Creating links between the index
items and headings
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A-2

Page-editing functions

Image-processing functions

URL Editor

e Displaying all the links and
alternate text in a Web page
e Editing links and alternate text

Universal Attribute Editor

o Displaying all the attributes for an
HTML tag
e Setting attribute values

Displaying the document
size and the estimated
download time

e Displaying the size of the
document and files that make up
the document

e Displaying the estimated
download time at each
transmission speed

Spelling check

e Detecting and correcting spelling
errors

e Dictionaries for the U.S. and the
U.K.

Support of many image
formats

e GIF, JPEG, PNG, BMP, WMF,
TIFF, FlashPix, and Photo CD

Image conversion

e Converting from the preceding
image formats to the GIF or JPEG
format.

e GIF transparent coloring

o GIF interlacing

e JPEG progression

e JPEG compression rate change
(enabling you to preview it)

e Converting between GIF and
JPEG

e Trimming

Changing of image file size

e Not only can the screen display
size be changed, but also the file
size can be changed in line with it

TopPage User’s Guide

Color reduction and
adjusting quality

e Enabling the reduction of the
amount of image data, by
reducing the number of colors
used in GIF images and adjusting
the JPEG quality

Image map creation

e Support of three types of image
maps: client side image map and
two types of server side image
maps (CERN and NCSA)

e Specifying areas in circles,
rectangles, and polygons on
images and set link destinations

Creating animation GIFs

e Creating animated images using
Web Animator.

e Enabling image movement, size
change, cutting and pasting,
rotation and up-down inversion

e Thumbnail display of all frames

e Animation effects such as "wipe"
and "fade-in"

Logo creation

e Text decoration (anti-alias,
bordering, spacing, alignment,
layout, transforming, and so on)

o 2D effects (blur, shadow,
embossment, flame, and so on)

Lettering on buttons

e Entering lettering onto buttons
with such shapes as squares,
ellipses, arrows, or with such
textures as marble, aluminum,
grain

Decoration of photos with

e Pasting such frames as

photo frames negativelike and decorative
frames
Retouching of digital photos | e Adjusting brightness and contrast
e Applying effects

Paint




Site-management functions

Samples

Structuring of site by linking
with page editing

e Renewing links along with file
operations

Templates

e Such template genres as
business, hobby, nature, science,
school, texture series, and
conceptual series

Sample materials

Link view e Tree display of site configuration
e Displaying to-and-from links
e Detecting link setting errors
o Displaying unnecessary files
File view e Displaying files to be transferred

e Such materials as images,
animation GIFs, sounds (MIDI),
and Java applets

e Displaying unused files

Detection of errors for the
entire site at once
(site check)

o Spelling check
e 'Alternate text' check

Finding text within the entire site

Site upload

e Preparing upload using the wizard

e Automatically detecting all files
that make up the site

e Automatically detecting updates

e Uploading only updated or new
files

e Displaying estimated uploading
time

Page upload

e Detecting all files that make up a
Web page and uploading them
(link destination pages are not
uploaded)

Management of multiple
sites

e Setting a profile (the destination
server, user ID, and password) for
each site

e Managing the file-transferring log
for each site

Detection and deletion of
unused files

e Automatically detecting unused
files within a site folder and
deleting them (on local machine
only)

File Transfer tool

o Transferring only individual files,
regardless of the concept of Web
pages

e Registering multiple FTP servers

Contents view

e Displaying files such as images,
HTML files, and Java applets

e Previewing images

e Pasting images into Web pages
with a drag-and-drop operation

Creating a channel file

e Creating the Microsoft CDF file or
Netcaster Script file

Creating a site map using HT

ML
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Appendix B. HTML tags

HTML tags and attributes available

The following table lists all the HTML tags and their attributes available with TopPage.
Asterisks (*) are attached to tags and attributes that are not defined in HTML 4.0.

(I)Note |

If you open a Web page in which tags or attributes other than the following are
embedded, TopPage issues either of the following error messages: “Unknown tag”
or “The attribute is invalid.”

Editing on Displaying on
i § the Normal | the Normal
Generic attribute group (Note 1) pane pane(Note 3)
o F=Full o F=Full
Tag Description support support
® P = Partial | ® P = Partial
support support
Attribute Attribute value ® N =No ® N =No
support support
(Note 2)
A core, internationalization, event anchor F F
charset char encoding of linked resource N N/A
type content type N N/A
name label F N/A
href URL for linked resource F F
href langlanguage code N N/A
target target F N/A
rel link destination type N N/A
rev link source type N N/A
accesskey accessibility key character N N/A
shape rect type of drawing N N/A
coords for use with client-side image maps N N/A
tabindex tab index N N/A
onfocus action when the element gets the focus F N/A
onblur action when focus lost F N/A
ABBR core, internationalization, event abbreviated form N F
ACRONYM | core, internationalization, event acronym N F
ADDRESS | core, internationalization, event information on author F F
APPLET core Java applet F F
codebase optional base URL for applet F N/A
archive archive list N N/A
code applet class file F N/A
object serialized applet file N N/A
alt short description F N/A
name name N N/A

Note 1 Generic attribute group refers to the three attribute groups: core, internationalization, and event. “Generic attributes group” on page B-9

Note 2 You cannot edit N-marked tags and attributes on the Normal pane , but you can directly edit them on the HTML Source pane or other text editors.
“Editing HTML directly” on page 13-2

Note 3 Some tags and attributes change the Web page appearance. Normally you can see the changes on the Normal pane, but sometimes you cannot. The
marks F, P, and N indicate the support for displaying the appearance changes on the Normal pane . N/A indicates that the tag or attribute does not
change the Web page appearance.
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width width F F
height height F F
align top, middle, bottom,left, | vertical or horizontal alignment F F
right
hspace horizontal gutter F F
vspace vertical space F F
AREA core, internationalization, event client-side image map area F N/A
shape rect, circle, poly type of drawing F N/A
coords comma-separated list of lengths F N/A
href URL for linked resource F N/A
target target F N/A
nohref no URL N N/A
alt short description F N/A
tabindex tab index N N/A
accesskey accessibility key character N N/A
onfocus action when the element gets the focus N N/A
onblur action when focus lost N N/A
B core, internationalization, event bold text style F F
BASE document base URL F N/A
href base URL F N/A
target predetermined value of target F N/A
BASEFONT base font size N N
id style ID N N
size size N N
color text color N N
face comma-separated list of font names N N
BDO core, internationalization directionality N N
BIG core, internationalization, event large text style N F
BLINK * core, internationalization, event blinking F F (Note 4)
BLOCKQUOTE| core, internationalization, event long quotation F F
cite \ quotation source N N/A
BODY core, internationalization, event document body F F
onload action when the document has been loaded F N/A
onunload action when the document has been removed F N/A
background background image F F
bgcolor background color F F
text text color F F
link color of links F F
vlink previously read link color F N/A
alink color of selected links F N/A
BR core forced line break F F
clear \ left, all, right, none control of text flow F F
BUTTON core, internationalization, event push button F F
name name F N/A
value value F N/A
type button, submit, reset type F N/A
disabled disabled unavailable in this context F F
tabindex tab index N N/A
accesskey accessibility key character N N/A
onfocus action when the element gets the focus F N/A
onblur action when focus lost F N/A
CAPTION core, internationalization, event table caption F F
align \ top, bottom, left, right alignment F F
CENTER core, internationalization, event center F F
CITE core, internationalization, event citation F F
CODE core, internationalization, event computer code fragment F F
COL core, internationalization, event table column N N
span number of columns N N
width width N N
align left, center, right, justify, | horizontal alignment N N
char

Note 4 This tag is indicated by its red color. (It does not flash.)
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char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment N N
baseline
COLGROUP | core, internationalization, event table column group N N
span number of columns N N
width width N N
align left, center, right, justify, | horizontal alignment N N
char
char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment N N
baseline
DD core, internationalization, event definition description F F
DEL core, internationalization, event deleted text N N
cite [ comment N N/A
datetime ‘ date and time of change N N/A
DFN core, internationalization, event definition description F F
DIR core, internationalization, event directory list N F
compact \ compact compact N N
DIV core, internationalization, event layout container F F
align ‘ left, center, right, justify | alignment P (Note 5) P (Note 5)
DL core, internationalization, event definition list F F
compact \ compact reduced interitem spacing N N
DT core, internationalization, event definition term F F
EM core, internationalization, event emphasis F F
EMBED * core, event plug-in F F
src object F N/A
height height F F
width width F F
align alignment F F
hspace horizontal gutter F F
vspace vertical space F F
loop loop N N/A
hidden hidden N N
volume volume N N/A
autost artauto-start N N/A
repeat repeat N N/A
panel panel N N
text title N N
palette palette N N
textfocus focus N N/A
FIELDSET core, internationalization, event input field group N N
FONT core, internationalization font F F
size ‘ size F F
color text color F F
face comma-separated list of font names F F
FORM core, internationalization, event interactive form F F
action server-side form handler F N/A
method GET, POST HTTP method used to submit the form F N/A
enctype type of encoding F N/A
onsubmit action when the form is submitted F N/A
onreset action when the form is reset F N/A
target target F N/A
accept-charset list of supported character sets N N/A
FRAME core subwindow F F
longdesc link to long description N N/A
name frame name F N/A
src URL such as file name F F
frameborder 1,0 border N N/A
marginwidth margin width in pixels F N

Note 5 Except for “justify,” both editing and displaying are supported.
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marginheight margin height in pixels F N
noresize noresize does not allow users to resize frames F N
scrolling yes, no, auto scroll bar F N
FRAMESET | core window subdivision F F
rows number of up-down divisions F F
cols number of left-right divisions F F
onload action when all the frames have been loaded N N/A
onunload action when all the frames have been removed N N/A
frameborder * display of borders F P (Note 6)
border * border width F P (Note 6)
H1 core, internationalization, event heading 1 F F
align \ left, center, right, justify | alignment P (Note 5) P (Note 5)
H2 core, internationalization, event heading 2 F F
align \ left, center, right, justify | alignment P (Note 5) P (Note 5)
H3 core, internationalization, event heading 3 F F
align ‘ left, center, right, justify | alignment P (Note 5) P (Note 5)
H4 core, internationalization, event heading 4 F F
align \ left, center, right, justify | alignment P (Note 5) P (Note 5)
H5 core, internationalization, event heading 5 F F
align \ left, center, right, justify | alignment P (Note 5) P (Note 5)
H6 core, internationalization, event heading 6 F F
align \ left, center, right, justify | alignment P (Note 5) P (Note 5)
HEAD internationalization document head F N/A
profile \ named dictionary of meta-information N N/A
HR core, event horizontal rule F F
align left, center, right alignment F F
noshade noshade no shading F F
size thickness F F
width width F F
HTML internationalization HTML document F N/A
version \ version N N/A
| core, internationalization, event italic text style F F
IFRAME core inline subwindow N N
longdesc detailed explanation N N
name frame name N N
src URL such as file name N N
frameborder 1,0 border N N
marginwidth margin width in pixels N N
marginheight margin height in pixels N N
scrolling yes, not, auto scroll bar N N
align top, middle, bottom, left, | vertical or horizontal alignment N N
right
height height N N
width width N N
IMG core, internationalization, event image F F
src file name F F
alt short description F N/A
longdesc detailed explanation N N/A
height height F F
width width F F
usemap CSIM map name F N/A
ismap ismap use of server-side image map F N/A
align top, middle, bottom, left, | vertical or horizontal alignment F F
right
border border width F F
hspace horizontal gutter F F
vspace vertical space F F
name * name N N/A
INPUT core, internationalization, event input field F F

Note 5 Except for “justify,” both editing and displaying are supported.
Note 6 Attribute values other than 0 can be displayed.
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type text, password, checkbox, type P (Note 7) P (Note 7)
radio, submit, reset, file,
hidden, image, button
name name F N/A
value value F F
checked checkeds elected radio buttons and check boxes F F
disabled disabled unavailable in this context F N
readonly readonly no entry possible F N/A
size number of columns F F
maxlength maximum characters for text fields F F
src image file name F F
alt short description F N/A
usemap CSIM map name N N/A
tabindex tab index N N/A
accesskey accessibility key character N N/A
onfocus action when the element gets the focus F N/A
onblur action when focus lost F N/A
onselect action when some text is selected F N/A
onchange action when the element value is changed F N/A
accept list of MIME types for file upload N N/A
align top, middle, bottom, left, | vertical or horizontal alignment N N
right
INS core, internationalization, event inserted text N N
cite \ comment N N
datetime \ date and time N N
ISINDEX core, internationalization index search N N
prompt \ prompt message N N
KBD core, internationalization, event text to be entered by the user F F
LABEL core, internationalization, event label of input field N N
for ID for input field N N
accesskey accessibility key character N N
onfocus action when the element gets the focus N N
onblur action when focus lost N N
LEGEND core, internationalization, event fieldset legend N N
accesskey ‘ accessibility key character N N
align \ top, bottom, left, right alignment N N
LI core, internationalization, event list item F F
type 1,a,A, il disc, square, |type F F
circle
value number F F
LINK core, internationalization, event a media-independent link F N/A
charset encoding of link destination text N N/A
href URL for linked resource F N/A
hreflang language code N N/A
type content type N N/A
rel link destination type N N/A
rev link source type N N/A
media media N N/A
target target N N/A
MAP core, internationalization, event client-side image map F N/A
name [ map name F N/A
MENU core, internationalization, event menu list N F
compact ‘ compact compact N N
META internationalization generic meta-information F N/A
http-equiv HTTP response header name F N/A
name NAME item F N/A
content associated information F N/A
scheme scheme N N/A
NOFRAMES | core, internationalization, event alternate content container for non-frame-based rendering F F
NOSCRIPT | core, internationalization, event alternate content container for non-script-based rendering N N
OBJECT core, internationalization, event generic embedded object F F

Note 7 Except for “type=file,” displaying is supported.
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declare declare declaration N N/A
classid object F N/A
codebase base URL for classid, data, archive F N/A
data reference to object's data F N/A
type data type F N/A
codetype content type for code F N/A
archive archive list F N/A
standby standby character F N/A
height height F F
width width F F
usemap CSIM map name N N/A
name name N N/A
tabindex tab index N N/A
align top, middle, bottom, left, | vertical or horizontal alignment F F
right
border border width F F
hspace horizontal gutter F F
vspace vertical space F F
oL core, internationalization, event ordered list F F
type 1,aA il item type F F
compact compact reduced interitem spacing N N
start starting number F F
OPTGROUP | core, internationalization, event option group N N
disabled \ disabled unavailable in this context N N
label \ label N N
OPTION core, internationalization, event selectable choice F F
selected selected selected F F
disabled disabled unavailable in this context N F
label label N N/A
value value F F
P core, internationalization, event paragraph F F
align left, center, right, justify | alignment P (Note 5) P (Note 5)
PARAM named property value F N/A
id ID N N/A
name name F N/A
value value F N/A
valuetype DATA, REF, OBJECT type of value N N/A
type content type N N/A
PRE core, internationalization, event preformatted text F F
width ‘ maximum number of characters in a line N N
Q core, internationalization, event short inline quotation N N
cite \ quotation source N N
S core, internationalization, event strike-through text style F F
SAMP core, internationalization, event sample program output, scripts, and so on F F
SCRIPT script statements F F
charset character encoding for external file N N/A
type content type N N/A
language language F N/A
src external file name F N/A
defer defer defer N N/A
event (unused) N N/A
for (unused) N N/A
SELECT core, internationalization, event option selector F F
name name F N/A
size number of rows F F
multiple multiple multiple selection permitted (default is single selection) F F
disabled disabled unavailable in this context F F
tabindex tab index N N/A
onfocus action when the element gets the focus F N/A
onblur action when focus lost F N/A
onchange action when the element value is changed F N/A

Note 5 Except for “justify,” both editing and displaying are supported.
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SMALL core, internationalization, event small text style N F
SPAN core, internationalization, event style container N F
STRIKE core, internationalization, event strike-through text N F
STRONG core, internationalization, event strong emphasis F F
STYLE internationalization style info F F
type content type N N/A
media media N N/A
title title N N/A
SuB core, internationalization, event subscript F F
SUP core, internationalization, event superscript F F
TABLE core, internationalization, event table F F
summary summary N N
width width F F
border border width F F
frame void, above, below, type of border N N
hsides, Ihs, rhs, vsides,
box, border
rules none, groups, rows, cols, all| type of ruled line N N
cellspacing spacing between cells F F
cellpadding spacing within cells F F
align left, center, right table position relative to window F F
bgcolor background color F F
datapagesize (unused) N N
height * height F F
background * background image F F
TBODY core, internationalization, event table body F F
align left, center, right, justify, | horizontal alignment N P (Note 5)
char
char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment N P (Note 8)
baseline
D core, internationalization, event table data cell F F
abbr abbreviation for header cell N N/A
axis names groups of related headers N N/A
headers header cell ID N N/A
scope header cell scope N N/A
rowspan number of rows spanned by cell F F
colspan number of columns spanned by cell F F
align left, center, right, justify, | horizontal alignment P (Note 9) P(Note 9)
char
char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment P (Note 8) P (Note 8)
baseline
nowrap nowrap no automatic word wrap F F
bgcolor background color F F
width width F F
height height F F
background * texture tile for document background F F
TEXTAREA | core, internationalization, event multi-line text field F F
name name F N/A
rows number of rows F F
cols number of columns F F
disabled disabled unavailable in this context F N
readonly readonly no entry possible F N/A
tabindex tab index N N/A
accesskey accessibility key character N N/A

Note 5 Except for “justify,” both editing and displaying are supported.
Note 8 Except for “baseline,” both editing and displaying are supported.
Note 9 Except for “justify" and “char,” both editing and displaying are supported.
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onfocus action when the element gets the focus F N/A
onblur action when focus lost F N/A
onselect action when some text is selected F N/A
onchange action when the element value is changed F N/A
TFOOT core, internationalization, event table footer N F
align left, center, right, justify, | horizontal alignment N P (Note 9)
char
char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment N F
baseline
TH core, internationalization, event table header cell F F
abbr abbreviation for header cell N N/A
axis header cell group N N/A
headers header cell ID N N/A
scope header cell scope N N/A
rowspan number of rows spanned by cell F F
colspan number of columns spanned by cell F F
align left, center, right, justify, | horizontal alignment P (Note 9) P (Note 9)
char
char alignment character N N/A
charoff offset for alignment character N N/A
valign top, middle, bottom, Vertical position alignment P (Note 8) P (Note 8)
baseline
nowrap nowrap no automatic word wrap F F
bgcolor background color F F
width width F F
height height F F
background * background image F F
THEA Dcore, internationalization, event table header N F
align left, center, right, justify, | horizontal alignment N P (Note 9)
char
char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment N P (Note 8)
baseline
TITLE internationalization document title F F
TR core, internationalization, event table row F F
align left, center, right, justify, | horizontal alignment P (Note 9) P (Note 9)
char
char alignment character N N
charoff offset for alignment character N N
valign top, middle, bottom, vertical alignment P (Note 8) P (Note 8)
baseline
bgcolor background color F F
background * background image F F
TT core, internationalization, event teletype or monospaced text style F F
U core, internationalization, event underlined text style F F
UL core, internationalization, event unordered list F F
type \ disk, square, circle item type F F
compact ‘ compact reduced interitem spacing N N
VAR core, internationalization, event instance of a variable or program argument F F

Note 8 Except for “baseline,” both editing and displaying are supported.
Note 9 Except for “justify” and “char,” both editing and displaying are supported.
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Generic attributes group

The following table lists the attributes included in the three attribute groups core,

internationalization, and event.

Editing on Displaying on
the Normal | the Normal
pane pane
Attribute group Attribute Description
e F=Full e F=Full
support support
® No
support
core id document-wide unique ID F F
class space-separated list of classes F F
style style information F F
title advisory title or amplification N N/A
internationalization lang language code N N/A
dir direction for weak or neutral text N N/A
event onclick action when a mouse button is clicked F N/A
ondbilclick action when a mouse button is double-clicked F N/A
onmousedown action when a mouse button is pressed down F N/A
onmouseup action when a mouse button is released F N/A
onmouseover action when a mouse pointer is moved onto F N/A
onmousemove action when a mouse pointer is moved within F N/A
onmouseout action when a mouse pointer is moved away F N/A
onkeypress action when a key is pressed and released F N/A
onkeydown action when a key is pressed down F N/A
onkeyup action when a key is released F N/A
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Appendix C. Image file formats

You can paste such image files as photos taken with digital cameras and illustrations
created with other applications into the TopPage editor. They are automatically
converted into GIF or JPEG format. “Inserting an image” on page 7-2

You can also handle image files using the TopPage's accessory tools WebArt
Designer and Web Animator.

Image file formats available

The following table explains how you can handle each image file format using TopPage
and its accessory tools. F means full support; P partial support; N no support. The file
extensions are in parentheses ().

Image file format TopPage WebArt Designer Web Animator
Pasting Saving Reading Saving Reading Saving

GIF (*.gif) F F F F F F
JPEG (*jpg) F F F F F N
PNG (*.png) F P (Note) F F F N
BMP (*.bmp) F N F F F N
WMF (*.wmf) F N F N F N
TIFF (*.tif) F N F N F N
FlashPix (*.fpx) F N F N F N
Photo CD (*.pcd) F N F N F N
DCM (*.dcm) F N F N F N
MIF (*.mif) F N F F F N

Note  You can save an image as a PNG file only if you paste a PNG file on the TopPage editor.
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Explanation of image file formats

Image File _
Format Explanation
GIF (*.gif) GIF stands for Graphics Interchange Format. It can handle only a maximum of

256 colors, but because of its advantage in reducing the size of files, it is
generally used on the Internet to the same extent as JPEG. It is recommended
that you save images that do not require many colors as a GIF file.

GIF files include not only static image but also animated image, which is called
animation GIF. Animation GIF is a combination of multiple images. Both static
GIF and animation GIF can be pasted in the same way on the editor of TopPage.

JPEG (*.jpg)

JPEG stands for Joint Photographic Experts Group. Itis in general use on the
Internet because of its small file size and inconspicuous image degradation. It is
recommended that you save full-color images such as photos taken with a digital
camera as JPEG.

PNG (*.png) PNG stands for Portable Network Graphics. It is a new image file format that is
similar to GIF, but it can handle more colors than GIF and it does not lose data
even when compressed. There are still few Web browsers compatible with it, but
it is expected to come into general use on the Internet.

BMP (*.bmp) BMP stands for bitmap. It has been adopted as the standard graphics format for
Windows, and can be created with such Windows applications as Paint, one of
the Windows accessories. It is able to handle up to a maximum of 16 million
colors, and there is no image degradation, because it cannot be compressed.
However, its file sizes are large.

WMF (*.wmf) WMF stands for Windows Metafile. It is used to save such Windows clip art as
graphics and pictures. It is much smaller than BMP.

TIFF (*.tif) TIFF stands for Tagged Image File Format. It is compatible with a number of DTP
applications because it can be handled among different types of equipment and
operating systems and it can be fully restored following compression. However,
sometimes opening it is difficult because there are various types of TIFFs.

FlashPix FlashPix are image files for digital processing. It supports image data in multiple

(*.fpx) resolutions.

Photo CD Photo CD is an image file format stored in a photo CD that can be created from

(*.pcd) such things as photographic negatives and prints. It supports image data in
multiple resolutions.

DCM (*.dcm) DCM is an image file format for the retouching application PerfectPhoto.

MIF (*.mif) MIF is an image file format for WebArt Designer. You can reedit logos, buttons,

or photo frames only if you save them in this format.

C-2
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Appendix D. Cascading style sheets

TopPage supports the following cascading style sheets and classes:
“Advanced style-sheet techniques” on page 9-7

CSS1 (cascading style sheet level 1)

TopPage supports the following CSS1 attributes:

Attribute group

Attribute

Setting in the Style Definition
dialog box

® F = Full support

® N = No support

Displaying on the Normal pane
® F = Full support

® P = Partial support

o N = No support

Font

font-family

-

font-size

font-weight

font-style

font-variant

Color and background

color

background-color

background-image

background-repeat

background-attachment

background-position

Text

word-spacing

letter-spacing

text-decoration

mZ|ZmZmmmmZmmmm

vertical-align

P (Note 1)

text-transform

N

text-align

E

text-indent

N

line-height

P (Note 2)

margin-top

F

margin-left

margin-bottom

margin-right

padding-top

padding-left

padding-bottom

padding-right

border-top-width

border-left-width

border-bottom-width

border-right-width

border-width

border-top-color

border-left-color

border-bottom-color

border-right-color

border-color

border-top-style

border-left-style

border-bottom-style

border-right-style

border-style

border-top

MMM TTTTTTTTTTTTTMTTTTTTTTTTITTTTTTTT M7 mT

MMM TTTTTTTTT T T T 7T T 7T

Notel Some values can be partially displayed.

Note2 A value that is smaller than the font height cannot be displayed.
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border-left

border-bottom

border-right

width

height

float

clear

Classification display

white-space

list-style-type

list-style-image

list-style-position

MM mZ|Zmmmmmmm

ZmmnZ|ZIZ/ZTnmmnm

CSS2 (cascading style sheet level 2)

TopPage supports the following CSS2 attributes:

Attribute

Setting on the Style Definition dialog
box

® F = Full support

o N = No support

Displaying on the Normal pane
® F = Full support

® P = Partial support

o N = No support

position

P (Note)

top

F

left

z-index

visibility

cursor

MM mmmmm

page-break-before

page-break-after

zZ|z|z|Zz|mmn

Note Only the position of the absolute coordinate (ABSOLUTE specification) can be displayed.

Pseudo classes

TopPage supports the following pseudo classes:

Pseudo class

Setting on the Style Definition dialog
box

® F = Full support

o N = No support

Displaying on the Normal pane
® F = Full support

® P = Partial support

o N = No support

a:link

a:visited

a:hover

a:active

mmmm

zZ|z|Zzm
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Appendix E. Frequently asked questions

The followings are frequently asked questions (FAQ) about TopPage and their
answers.

@ Does using the TopPage sample materials and templates for my Web
pages have any copyright problem?

A There is no problem. Use them as you like.

0 0000000000000 000000000000 0000000000000 O°O°OC”KDOSYOSOCOOYOSOO®POONVPOINO
@ Why doesn't my Web browser display an image?

A The following three causes are conceivable:

1. You specified the URL of the image file in the document route format.
If you view a locally-saved HTML document on a Web browser, you cannot view an image
with its path that is specified in the document route format.

2. You specified an incorrect value for the Base URL.
Select Document Properties  from the Edit menu, click the Document Info tab, and erase
the Base URL value.

3. You pasted the image, but you specified the Base URL value.
Erase the Base URL value, and paste the image again.

@ Why does nothing happen when | click an image map on my Web
browser?

A You can check the operation of a client-side image map before uploading it, but you
cannot check the operation of a server-side image map until you upload it to the server.
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® 0

1.

Why doesn't my Web browser display a Java applet?

The following five causes are conceivable:

There is no class file (*.class), whose name is specified in the CODE attribute of the
APPLET tag, whereas the location is specified in the CODEBASE attribute of the
APPLET tag.

The applet calls another file as the parameter, but its path is incorrect.

An animation GIF is specified as the parameter.
Some Web browsers end abnormally if an animation GIF is specified as the parameter.

An image file in a format other than GIF and JPEG is specified for a Java applet that
supports only GIF and JPEG image files.
Some Java applets limit the image file formats.

Your Web browser does not support Java applets.

@ Why doesn't Web browser display a plug-in object?

Q The following three causes are conceivable:

1.

The width and height of the plug-in object is not specified.
Specify the width and height using the Attribute dialog box for the plug-in object.

. Aplug-in program for your Web browser is not installed.

Your Web browser does not support the EMBED tag.

@ Why doesn't my Web browser (Netscape Navigator 3.0) display an image |
pasted as the table background?

Q Netscape Navigator 3.0 does not display images pasted as the table background.
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Why can't | upload my Web pages? (Why can't | connect to the server?)

The following two causes are conceivable. (Contact your provider on anything that is
unclear.)

1. You specified an incorrect server name, user ID, or password.
You might have specified information of another server--for example, that of the Web
browser connection server or that of the e-mail server--instead of that of the Web page ad-
ministration server. Check the guide furnished by your provider, and specify the correct
server name, user ID, and password.

2. You specified an incorrect destination folder.
Enter a folder name in the Destination Folder field of the Setup Destination Server dialog
box as your provider instructs. For example, if you are instructed to “place data in the
public_html folder,” enter “public_html” in the Destination Folder field. Do not place a slash
“/" at the beginning. If you are instructed to “place data in the /home/username folder,” place
a slash “/” at the beginning, and enter it as “/home/username.”

Q,

A

Why doesn't my Web browser display an image after | uploaded it to the
server?

The following two causes are conceivable:

1. You did not correctly specify uppercase and lowercase letters for the image file
names.
Though you can handle uppercase and lowercase letters indiscriminately on your local com-
puter, they are differentiated on the server. This is because operating systems of your local
computer and that of the server are different. Thus, for example, if you specified a lowercase
file name within the IMG tag, and if the actual image file has an uppercase name, the server
computer does not regard them as the same, and therefore your Web browser cannot dis-
play the image.

2. You stored your images in a subfolder on your computer, but your provider prohibits
the use of subfolders.
Some providers prohibit the use of subfolders.
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Why doesn't my Web browser display a Java applet after | uploaded it to
the server?

The following four causes are conceivable:

1. You have not uploaded all the files that are required for running the Java applet.

Check that you have uploaded all the files that make up the Java applet, including the class
files (*.class), image files, and sound files.

. You did not correctly specify uppercase and lowercase letters for the class file name.

The server discriminates between uppercase and lowercase letters. If your provider says
that you must make all the file names uppercase or lowercase, and if you want to use the
sample Java applets provided by TopPage, you must change their file names.

. You store your Java applet in a subfolder on your computer, but your provider prohib-

its the use of subfolders.
If you collect the files that make up a Java applet in a subfolder, you must upload that folder
to run the Java applet. However, some providers prohibit the use of subfolders.

. You specified the location of the image and sound files for the Java applet parameters

with an absolute path.
Specify the location with the relative path, which starts from the class file (*.class).

Q
A

How do | make a frame-using page the top page of a site?

Create a Web page that uses the frame function in advance. Select the Create Site
from Existing Pages radio button from the Create a Site tab of the Welcome to
TopPage dialog box, which is displayed when you start TopPage, and click the OK
button. The wizard for creating a site then starts. Then specify the frame-using page
as the top page of the new site.
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What should | watch out for when dividing the top page of a site?

® 0

If you divide an existing page into multiple sections using TopPage, a frame-using page
is newly created, and the original page is assigned to the left side or top side section.
Unfortunately, if you divide the top page of a site, the file name of the top page
changes. Some providers specify the top page name, such as “index.html.” Therefore,
you must first rename your original top page, and then rename the new top page
(frame-using top page) “index.htm” (or whatever your provider instructs). “Dividing
a Web browser window (1)” on page 11-3.
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Glossary

animation GIF

An animated GIF image, which is a combination of
multiple images. As you view an animation GIF on
your Web browser, it repeats the animation. You
can create an animation GIF using the Web
Animator tool.

attribute

A property attached to a certain element, such as
size and color. When editing your Web pages
using TopPage, you first create (or insert)
something; then you change its attributes.

CGl program

A program for exchanging data between a client
and a server. A CGlI program is written in Perl or C
language. It is often used when a server receives
information--for example, questionnaires or orders--
entered in a Web browser and then processes it.

channel

A Web site that is automatically delivered according
to the schedule determined by the Web site creator.

client-side image map

An image map that is processed on the client (Web
browser) side. Because HTML tags for this image
map are embedded in an HTML file, you can easily
use and manage this type of image map.

= image map

dynamic HTML

The latest technology for creating animated Web
pages. Netscape Navigator 4.0, Microsoft Internet
Explorer 4.0, or later version of these browsers can
display dynamic HTML.

form

An interactive form, such as a questionnaire or an
order form. Visitors to your Web site fill in blanks
and enter responses to multiple choices within the
form.

frame function

A function to divide a Web browser window into
several sections.

HTML (Hyper Text Markup

Language)

A special language for creating Web pages, which
contains such HTML tags as <P> <H1> <IMG>.
HTML tags consists of alphabetic letters and
symbols. The latest version is HTML 4.0.

image

Digital data such as photographs, illustrations, and
animations. Images in GIF and JPEG formats are
often used for Web pages. Recently, the new PNG
format is also being used. When images in BMP or
TIFF formats are pasted into TopPage, they are
automatically converted into GIF or JPEG formats.

image map
An image that has multiple links.
= client-side image map, server-side image map

installation

The insertion of a program into a personal
computer to make it available for use.

Glossary
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Internet

The world's largest network. It can connect
computers throughout the world using the TCP/IP
protocol.

Java applet

A program written in the Java language. By
changing its parameters, you can change such
things as the background, movement, and text.

link

A function to jump. If you click text or an image to
which a link is set, you jump another page or
another place in the same page.

pixel

A small, square, colored dot, frequently used as a
unit defining the display resolution or the image
size. HTML uses it as unit defining the size of each
element.

plug-in object

An object as the sound data (*.wav; *.mid; *.au) or
multimedia data (Shockwave, VRML) that you can
play back on a Web browser. lItis called a plug-in

object, because you must add a plug-in application
to your Web browser to play it back.

provider

An agent that provides a connection to the Internet.
Many providers offer a service for registering Web
sites.
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script

A program written in the script language,
JavaScript, or VBScript (Visual Basic Script). You
can write this program directly in your HTML file.

server

A computer that stores many Web sites on the
Internet.

server-side image map

An image map that is processed on the server (your
provider's server) side. To use this image map, you
must create an image map file in addition to an
HTML file. There are two types of the server side
image maps, NCSA and CERN, depending on the
application that the server uses. # image map

site

The server location where the Web pages are
placed. Using TopPage, you can create a virtual
site on your own computer and match it with the
server site.

style sheet

A file for controlling appearance. Style sheets have
been adopted in HTML 4.0, so that you can
segregate appearance issues from the document-
element issues that are the proper concern of
HTML. TopPage is compatible with CSS
(Cascading Style Sheet).

tag

Descriptions surrounded by < > that specify
document elements in HTML. For example, the tag
<P> indicates a paragraph, <H1> indicates a
heading, and <IMG> indicates an image. Aslash'/'
is added to the tag indicating the end. The end of a
heading, for example, is described as </H1>.



target
One of the link attributes that indicates where the
link destination page is to be displayed.

top page
A page that is initially displayed when you access a
Web site.

URL

An address of a Web page. It usually begins with
http://www.... Because each URL is unique, you can
access the target URL from anywhere in the world.

Web browser

An application for viewing Web pages. Netscape
Navigator and Microsoft Internet Explorer are well-
known Web browsers.

Web page
An HTML file on the Internet.

wizard

A user interface that enables you to do tasks step
by step. You just need to select something or
answer the question and then click the Next button.
Wizards are often used in the Windows world,
because they allow you to do tasks accurately.

Glossary
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